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This guide provides information about hardware setup for the following  products:

 l QXS Hybrid

 o QXS-312, QXS-324

 o QXS-412, QXS-424, QXS-448, QXS-456

 o QXS-648, QXS-656

 l StorNext QXS (FC host attach only)

 o QXS-1200

 o QXS-2400

 o QXS-5600

 l StorNext QX (FC host attach only)

 o QX-1200

 o QX-2400

Product Safety Statements
Quantum will not be held liable for damage arising from unauthorized use of the product. The user assumes 
all risk in this aspect.

This unit is engineered and manufactured to meet all safety and regulatory requirements. Be aware that 
improper use may result in bodily injury, damage to the equipment, or interference with other equipment.

QX and QXS Setup Guide x
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For the most up to date information on QX and QXS, see:

http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support

Contacts
For information about contacting Quantum, including Quantum office locations, go to:

http://www.quantum.com/aboutus/contactus/index.aspx

http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support
http://www.quantum.com/aboutus/contactus/index.aspx
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Comments
To provide comments or feedback about this document, or about other Quantum technical publications, 
send e-mail to:

doc-comments@quantum.com

Getting More Information or Help
StorageCare™, Quantum’s comprehensive service approach, leverages advanced data access and 
diagnostics technologies with cross-environment, multi-vendor expertise to resolve backup issues faster 
and at lower cost.

Accelerate service issue resolution with these exclusive Quantum StorageCare services:

 l Service and Support Website - Register products, license software, browse Quantum Learning 
courses, check backup software and operating system support, and locate manuals, FAQs, firmware 
downloads, product updates and more in one convenient location. Get started at:

http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support

 l eSupport - Submit online service requests, update contact information, add attachments, and receive 
status updates via email. Online Service accounts are free from Quantum. That account can also be used 
to access Quantum’s Knowledge Base, a comprehensive repository of product support information. Get 
started at:

http://www.quantum.com/customercenter/

For further assistance,  or for training opportunities, contact the Quantum Customer Support Center:

Region Support Contact

North America 1-800-284-5101 (toll free)
+1-720-249-5700

EMEA +800-7826-8888 (toll free)

+49 6131 324 185

Asia Pacific +800-7826-8887 (toll free)
+603-7953-3010

For worldwide support:

http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support

mailto:doc-comments@quantum.com
http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support
http://www.quantum.com/customercenter/
http://www.quantum.com/serviceandsupport/get-help/index.aspx#contact-support
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Worldwide End-User Product Warranty
For more information on the Quantum Worldwide End-User Standard Limited Product Warranty:

http://www.quantum.com/serviceandsupport/warrantyinformation/index.aspx

About QXS Storage Chassis
The QXS Storage chassis are NEBS Level 3, MIL-STD-810G (storage requirements), and European Telco 
compliant. The QXS Storage chassis use either AC or DC power supplies. See the Quantum web site for 
more information about specific models and uses: http://www.quantum.com.

Audience
This guide is intended for storage system administrators and installers.

Prerequisites
Prerequisites for installing and using this product include knowledge of:

 l Servers and computer networks

 l Network administration

 l Storage system installation and configuration

 l SAN management and DAS

 l FC and Ethernet protocols

 l Accessing QXS-5600 HDD drawers

User Interfaces
The base systems support two versions of the web-based application for configuring, monitoring, and 
managing the storage system. Both web-based application GUI versions (v3 and v2), and the command-line 
interface, are briefly described:

 l The Disk Management Utility (V3) is the new primary web interface for the chassis, providing access to 
all common management functions for both linear and virtual storage.

http://www.quantum.com/serviceandsupport/warrantyinformation/index.aspx
http://www.quantum.com/
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 l The Disk Management Utility (V2) is a secondary web interface for the chassis, providing access to 
traditional linear storage functions. This legacy interface (V2) provides certain functionality that is not 
available in the primary interface (V3).

 l The command-line interface (CLI) enables you to interact with the storage system using command 
syntax entered using the keyboard or scripting. You can set a CLI preference to use V3 or V2 
terminology in command output and system messages.

Related Documentation
For information about See

Web links to download Quantum QX and QXS Storage guides listed 
below, but not shipped with the product

QX and QXS Documentation Sheet*

Enhancements, known issues, and late-breaking information not 
included in product documentation

QX or QXS Release Notes

Product overview and overview of setup tasks QX and QXS Getting Started Guide

Regulatory compliance and safety and disposal information QX and QXS Series Product Regulatory 
Compliance and Safety *

Using a 12- and 24-drive rackmount bracket kit to install a chassis 
into a rack

QX/QXS 12- and 24-Drive Rackmount 
Bracket Kit Installation Guide

Using a 48-drive rackmount bracket kit to install a chassis into a 
rack

QXS 48-Drive Rackmount Bracket Kit 
Installation Guide

Using a 56-drive rackmount bracket kit to install a chassis into a 
rack

QXS 56-Drive Rackmount Bracket Kit 
Installation Guide

Installing the front bezel on a QX and QXS system QX and QXS Bezel Installation Guide

Product hardware setup and related troubleshooting QX and QXS Setup Guide 

Using the CLI to configure and manage the product QX and QXS CLI Reference Guide

Identifying and installing or replacing CRUs QX & QXS CRU Installation and 
Replacement Guide

Events that the QX and QXS Series may report, and recommended 
actions to take in response to those events

QX and QXS Event Descriptions 
Reference Guide 

Managing a QXS system by using its primary web interface (V3), the 
Disk Management Utility

QXS Disk Management Utility User 
Guide V3

Managing a QX and QXS system by using its secondary web 
interface (V2), the Disk Management Utility

QX and QXS Disk Management Utility 
User Guide V2
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* Printed document included with product

For additional information, go to Quantum’s website.

Document Conventions and Symbols

Convention Element

Blue text Cross-reference links and e-mail addresses

Blue, underlined text Web site addresses

Bold text  l Key names
 l Text typed into a GUI element, such as into a box
 l GUI elements that are clicked or selected, such as menu and list items, buttons, 

and check boxes

Italic text Text emphasis

Monospace text  l File and directory names
 l System output
 l Code
 l Text typed at the command line

Monospace, italic 
text

 l Code variables
 l Command-line variables

Monospace, bold 
text

Emphasis of file and directory names, system output, code, and text typed at the 
command line

Table 1: Document Conventions

Note: Note emphasizes important information related to the main topic.

Caution: Caution indicates potential hazards to equipment or data.

WARNING: Warning indicates potential hazards to personal safety.

http://www.quantum.com/
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QXS-3 Series Storage
The QXS-3 Series Storage includes the following systems:

 l QXS-312: 2U12-drive chassis with LFF drives (3.5 inch) 

 l QXS-324: 2U24-drive chassis with SFF drives (2.5 inch) 

 l Drives not installed (must be installed on site)

Note: The 2U12-drive chassis and the 2U24-drive chassis support installation of hard-disk drives 
(HDDs) and solid-state disks (SSDs). The drive chassis can have all HDDs or SSDs installed or a 
mixture of HDDs and SSDs.

The QXS Storage drive chassis (2U) include a bezel sub-assembly that attaches to the front panel of the 
chassis. The bezel, comprised of a vented cover attached to an EMI shield, is pre-assembled and packed 
within a box contained in the master shipping container. Instructions for attaching/removing the bezel are 
provided in the QXS Storage Bezel Installation Guide.

2U12-Drive Chassis
Figure 1: 2U12 Drive Chassis (Bezel Installed)

Figure 2: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED
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4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault
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Figure 3: 2U12 Drive Chassis (Bezel Removed)
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1. Chassis ID LED

2. Drive status LED: Power/Activity

3. Drive status LED: Fault

4. 3.5" drive blank (typical 12 slots)

2U24-Drive Chassis 
Figure 4: 2U24 Drive Chassis (Bezel Installed)

Figure 5: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

Note: LEDs for drive chassis are described in LEDs for 56-Drive RAID Chassis (4U56) on page 175.
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Figure 6: 2U24 Drive Chassis (Bezel Removed)
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1. Chassis ID LED

2. Drive Status LED: Power/Activity

3. Drive Status LED: Fault
Not Shown - 2.5" Drive Blank

QXS-3 Series RAID Chassis : Rear Panel Layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of the QXS-3 Series RAID Chassis. 

Figure 7: QXS-3 Series RAID Chassis: Rear Panel Layout
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1. AC power supplies

2. Controller I/O module A

3. Controller I/O module B

4. DC power supply (2) - (DC model only)

5. DC power switch
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A RAID chassis accommodates two power supply FRUs of the same type — either both AC or both DC — 
within the two power supply slots (see two instances of callout No.1 above). The RAID chassis 
accommodates two controller I/O modules of the same type in the chassis (see callouts No.2 and No.3 
above).

Caution: Dual controller configurations are supported. Single configurations are supported only when 
a controller fails over to its partner . A controller must be installed in each IOM slot to ensure sufficient 
airflow through the chassis during operation. 

Note: The QXS-3 Series chassis support hot-plug replacement of redundant I/O controller modules, 
fans, power supplies, and expansion I/O modules. Hot-add replacement of drive chassis is also 
supported.

Controller I/O Module – Rear Panel Components
The I/O Controller Module has two model types, with converged network controller (CNC) ports or HD mini-
SAS. The models can be configured as follows:

 l Host CNC ports configured with SFPs supporting the following:

 o 4/8/16 Gb FC

 o 10GbE iSCSI

 o 1 Gb RJ-45

 l Host interface ports configured with 12 Gbit/s HD mini-SAS (SFF-8644) connectors.

Host CNC Ports Configured with SFPs (FC or iSCSI)
Figure 8 on the next page shows a  Controller I/O Module with CNC ports configured with SFPs supporting 
either 4/8/16 Gb FC or 10GbE iSCSI. The SFPs look identical. Refer to the CNC LEDs that apply to the 
specific configuration of your CNC ports.
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Figure 8: CNC Ports Configured with SFPs (FC or iSCSI)
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1. CNC ports used for host connection or replication

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for future use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled button (used by engineering only)
(Sticker shown covering the opening)

8. mini-SAS expansion port

Host CNC Ports Configured with SFPs (1 Gb RJ-45)
 Figure 9 below shows a  Controller I/O Module with CNC ports configured with SFPs supporting 1 Gb RJ-
45.

Figure 9: Controller I/O Module with CNC Ports
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1. CNC ports used for host connection or replication

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for future use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS expansion port
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Host Ports Configured with 12 Gbit/s HD Mini-SAS
Figure 10 below shows a  Controller I/O Module with host interface ports configured with 12 Gbit/s HD mini-
SAS (SFF-8644) connectors.

Figure 10: Controller I/O Module with Host Interface Ports

CACHE

CLI

CLI

LINKACT

6Gb/s
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1. HD mini-SAS ports used for host connection

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for future use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled button (used by engineering only)
(Sticker shown covering the opening)

8. mini-SAS expansion port

Expansion Chassis- Rear Panel Components
The 12-drive Expansion Chassis support 12 x 3.5" Large Form Factor (LFF) drives for expansion of storage 
capacity. The 24-drive Expansion Chassis support 24 x 2.5" Small Form Factor (SFF) drives for expansion 
of storage capacity. These chassis use mini-SAS (SFF-8088) connectors to facilitate attachment to the 
RAID Chassis and allow for additional backend SAS expansion attachment(s).

Note: Refer to the Release Notes for the number of drives and Expansion Chassis supported with 
each RAID Chassis.
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Figure 11: 12- and 24-Drive Expansion Chassis - Rear Panel Components

LINKLINK

SERVICE

IN OUT

LINKLINK

SERVICE

IN OUT

1 1

2

3

1. Power Supplies (AC shown)

2. Expansion I/O Module A

3. Expansion I/O Module B

Figure 12: Closeup of Expansion I/O Module
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QXS-4 Series and StorNext Storage

QXS-4 Series Storage
The QXS-4 Series Storage includes the following systems:

 l QXS-412 System

 o 2U12-drive chassis

 o LFF drives (3.5 inch) 

 o Drives not installed (must be installed on site)

 l QXS-424 System

 o 2U24-drive chassis

 o SFF drives (2.5 inch) 

 o Drives not installed (must be installed on site)

 l QXS-448 System

 o 2U48-drive chassis

 o SFF drives (2.5 inch)

 o Drives not installed (must be installed on site)

 l QXS-456 System

 o 4U56-drive chassis

 o LFF drives (3.5 inch)

 o Drives not installed (must be installed on site)

StorNext Storage
The StorNext Storage (FC host attach only) includes the following systems:

 l QXS-1200 System

 o 2U12-drive chassis

 o LFF drives (3.5 inch) 
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 l QXS-2400 System

 o 2U24-drive chassis

 o SFF drives (2.5 inch) 

 l QXS-5600 System

 o 4U56-drive chassis

 o LFF drives (3.5 inch)

 o Drives not installed (must be installed on site)

Note: Quantum no longer ships the following StorNext QX systems.

 l QX-1200 System

 o 2U12-drive chassis

 o LFF drives (3.5 inch) 

 l QX-2400 System

 o 2U24-drive chassis

 o SFF drives (2.5 inch) 

 

Note: The 2U12, 2U24, 2U48, and 4U56 drive chassis support installation of hard-disk drives (HDDs) 
and solid-state disks (SSDs). The drive chassis can have all HDDs or SSDs installed, or a mixture of 
HDDs and SSDs.

Bezel Sub-Assembly

The  drive chassis include a bezel sub-assembly that attaches to the front panel of the chassis. The bezel, 
comprised of a vented cover attached to an EMI shield, is pre-assembled and packed within a box contained 
in the chassis master shipping container.  Instructions for attaching/removing the bezel are provided in the 
QXS Storage Bezel Installation Guide.

LED Descriptions

LEDs for drive chassis are described here:

LEDs for 12-, 24-, 48-Drive Systems on page 158

12-, 24-, 48-Drive Expansion Chassis Rear Panel LEDs on page 174

LEDs for 56-Drive RAID Chassis (4U56) on page 175
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2U12-Drive Chassis
Figure 13: 2U Drive Chassis (Bezel Installed)
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4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

Figure 14: 2U12 Drive Chassis (Bezel Removed)
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1. Chassis  ID LED

2. Drive Status LED: Fault

3. Drive Status LED: Power/Activity

Not Shown - 3.5" Drive Blank
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2U24-Drive Chassis
Figure 15: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

Figure 16: 2U24 Drive Chassis (bezel removed)
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2. Drive Status LED: Power/Activity

3. Drive Status LED: Fault
Not Shown - 2.5" Drive Blank

2U48-Drive chassis
The 2U48 drive chassis is used in QXS-448.
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Figure 17: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

Figure 18: 2U48 Drive chassis (Bezel Removed)

Note: Integers atop drawers indicate drawer numbering sequence.

1. Chassis ear LEDs

2. Thumbscrew (for securing or accessing drawers)

3. Disabled Button (used by engineering only)

4. Drawer Handle (shown in stowed position)

5. Drawer Status LED: FRU OK

6. Drawer Status LED: Fault/Service Required

7. Drawer Status LED: OK to Remove

8. Drawer Status LED: Unit Locator
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2U48 Drive Chassis Drawers
Open the chassis drawers to access the drives. Drawers 0 and 1 provide access to drive bays from the right 
side of the drawer; whereas drawer 2 provides access to drive bays from the left side of the drawer. These 
respective side views—or profiles—are shown in 2U48 Drive Chassis: Drive Slot Numbering below.

Figure 19: 2U48 Drive Chassis: Drive Slot Numbering
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Disk bays with sequentially−numbered disk slots

Right side view
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(Revolved Y +90°)
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Note: Drive slot numbering is also provided on the label that is laminated to the sheet metal housing 
(top face) on each drawer. Refer to the drawer label when installing drives into the drawer.

The 2U48 drive chassis is shipped with the drawers installed, but they are not populated with drives. 
Depending on your product configuration, drive bay blanks, also known as Air Management Solution (AMS) 
inserts, must be installed in all empty drive slots. Locate the box containing your sledded drives and AMS 
inserts in preparation for populating the drive slots.

Note: Refer to the Enclosure Installation Checklist on page 51 for information on installing drives and 
AMS inserts.

2U48 Drive chassis Drawers Partially Populated
Figure 20 on the next page shows drawer 0 with drives installed within slots 0-11 (callouts 2, 4, and 5). Slots 
12-15 contain four AMS inserts (callout 6) to manage air flow within the chassis to maintain optimal 
operating temperature.
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Figure 20: 2U48 Drive chassis: Sample Drawer Population

1 432 5 6

1. Drawer 0

2. 2.5" Sledded drives 0-31, 2

3. Drive Status LED

4. 2.5" Sledded Drives 4-71, 2  

5. 2.5" Sledded Drives 8-111, 2

6. AMS Insert (slots 12-15)3

1The drive is oriented in the sled such that its PCBA faces upward on the top side of the drive module as shown.
2Electromagnetic interference protection is provided by the EMI shield within the chassis bezel.
3The AMS insert spans only one drive slot. Slots 12-15 have AMS inserts (4 each) installed.

Caution: Empty bays will cause overheating. To avoid overheating, install an AMS insert in drive slots 
that do not contain drive modules.

2U12, 2U24, and 2U48 RAID Chassis: Rear 
Panel Layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of a 2U12, 2U24, and 2U48 RAID chassis. The following image shows a representative example of 
RAID chassis models included in the product series. The rear panel layout is the same for the 2U12, 2U24, 
and 2U48 RAID chassis.

Note: The 4U56 Series RAID chassis (4U) is significantly different from the 2U12, 2U24, and 2U48 
RAID chassis (2U). The 4U56 RAID chassis is twice as high and has separate power supplies and 
fans.
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Figure 21: 2U12, 2U24, and 2U48 RAID Chassis: Rear Panel Layout
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1. AC Power Supplies (qty. 2)

2. Controller A

3. Controller B

A RAID chassis accommodates two power supply FRUs of the same type — either both AC or both DC — 
within the two power supply slots (see two instances of callout No.1 above). The RAID chassis 
accommodates two controller  I/O modules (IOMs)of the same type within the IOM slots (see callouts No.2 
and No.3 above).

Caution: Dual controller configurations are supported. Single configurations are supported  only when 
a controller fails over to its partner . A  controller must be installed in each IOM slot to ensure sufficient 
airflow through the chassis during operation.

Note: The  chassis support hot-plug replacement of redundant controller IOMs, fans, power supplies, 
and expansion modules. Hot-add replacement of drive chassis is also supported.

2U12, 2U24, and 2U48 Controller I/O  Module – Rear 
Panel Components
The Controller I/O  Module has two model types, converged network  (CNC) ports or HD mini-SAS. The 
models can be configured as follows:

 l Host CNC ports configured with SFPs supporting the following:

 o 4/8/16 Gb FC

 o 10GbE iSCSI

 o 1 Gb RJ-45

 l Host interface ports configured with 12 Gbit/s HD mini-SAS (SFF-8644) connectors.

Note: Xcellis, StorNext, and QX controller IOMs support FC host attach only.

Host CNC Ports Configured with SFPs (FC or iSCSI)
The following figure shows CNC ports configured with SFP+ transceivers that support 4, 8, or 16 Gb FC, or 
10 GbE iSCSI connections. The SFPs look identical. Refer to the CNC LEDs that apply to the specific 
configuration of your CNC ports.
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Figure 22: Controller I/O Module with FC or iSCSI Host CNC Ports
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2 3 4 5 6 7 8

1. CNC FC or iSCSI with SFP+ Ports (used for host 
connection or replication; supports SFP+ FC 
transceivers)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

1. iSCSI with SFP+ Ports (used for host connection or 
replication; supports SFP+ FC transceivers)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

Host CNC Ports Configured with SFPs (1-Gb RJ-45)
Figure 23 on the next page shows a controller IOM with CNC ports configured with SFPs supporting 1-Gb 
RJ-45.
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Figure 23: CNC Ports Configured with SFPs (RJ-45)

CACHE

CLI

CLI

LINKACT

6Gb/s

SERVICE−1SERVICE−2

PORT 0 PORT 1 PORT 2 PORT 3

2 3 4 5 6 7 8

1

1. CNC Ports (used for host connection or replication)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

Host Ports Configured with 12 Gbit/s HD mini-SAS
Figure 24 below shows a controller IOM with host interface ports configured with 12 Gbit/s HD mini-SAS 
(SFF-8644) connectors.

Figure 24: Host Ports Configured with HD mini-SAS

CACHE

CLI

CLI

LINKACT

6Gb/s

SERVICE−1SERVICE−2

ACT

LINK 12Gb/s

S

S

A

ACT

LINK

SAS 0 SAS 1

ACT

LINK 12Gb/s

S

S

A

ACT

LINK

SAS 2 SAS 3

2 3 4 5 6 7 8

1



Chapter 1: Components
2U12, 2U24, and 2U48 RAID Chassis: Rear Panel Layout

QX and QXS Setup Guide 19

1. HD Mini-SAS Ports (used for host connection)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

2U12, 2U24, and 2U48 Expansion Chassis – Rear Panel 
Components
The 2U12, 2U24, and 2U48 RAID Chassis support attachment to the 2U12, 2U24, and 2U48 Expansion 
chassis. The rear of the Q2U12, 2U24, and 2U48 Expansion chassis all look the same. The expansion 
chassis uses mini-SAS (SFF-8088) connectors to facilitate backend SAS expansion.

Note: The rear panel view is common to all three expansion chassis, with the exception that 2U48 
PSUs are configured with a power switch;  the 2U12 and 2U24 PSUs have no power switch.

Figure 25: 2U12, 2U24, and 2U48 Expansion Chassis – Rear Panel Components
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Figure 26: Expansion I/O Module
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1. Disabled Button (used by engineering/test only) 2.Service Port (used by service personnel only)

3. Mini-SAS In Port 4. Mini-SAS Out Port

Note: The 2U12, 2U24, and 2U48 RAID chassis support a number of expansion chassis. Refer to the 
Release Notes for the number of expansion chassis and number of drives supported.

4U56 Drive System
The bezel, comprised of a vented cover attached to an electro-magnetic interference (EMI) shield, is pre-
assembled and packed within a box contained in the master shipping container. Instructions for 
attaching/removing the bezel are provided in the QX and QXS Bezel Installation Guide.

 

The 4U56 drive chassis is used in the QXS-456 system.

Figure 27: 4U56 Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis Status LED: Unit Locator

3. Chassis Status LED: Fault/Service Required

4. Chassis Status LED: FRU OK

5. Chassis Status LED: Temperature Fault

Figure 28: 4U56 Drive Chassis (Bezel Removed)

Note: Drawer 0 is on the left of the chassis and Drawer 1 is on the right.
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1. Chassis ID LED

2. Thumbscrew (for securing or accessing drawer)

3. Drawer Handle (shown in stowed position)

4. Drawer Status LED: Unit Locator

5. Drawer Status LED: OK to Remove

6. Drawer Status LED: Fault/Service Required

7. Drawer Status LED: FRU OK

8. Chassis Status LED: Unit Locator

9. Chassis Status LED: Fault/Service Required

10. Chassis Status LED: FRU OK

11. Chassis Status LED: Temperature Fault

4U56 Drive Chassis Drawers
You can open the chassis drawers to access the drives (see Figure 29 on the next page). Drawers 0 and 1 
provide access to drives that are oriented vertically, such that the back face of the drive faces down, and is 
inserted into the drawer drive slots from above. A single drawer diagram is used to describe the numbering 
scheme.

The 4U56 drive chassis is shipped with the drawers installed, but they are not populated with drives.  Air 
Management Solution (AMS) inserts are not installed within the chassis. Locate the box containing your 
sledded drives  in preparation for populating the drive slots. 

Caution: The 4U56 drive chassis must be populated with a minimum of 14 drives. Populate slots 0-6 in 
Drawer 0; and, populate slots 28-34 in Drawer 1.

Note: Drive slot numbering is also provided on the label that is laminated to the sheet metal housing 
(side face) on each drawer. Refer to the drawer label when installing drives into the drawer.
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Figure 29: 4U56 Drive Chassis (front, top, and side views)
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Figure 30 below provides two different view orientations of the drive module used in 4U56 drive chassis.

Figure 30: 4U56 Drive

1
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3

1. 3.5" Sledded Drive Module Assembly (front view)

2. Drive LEDs

3. 3.5" Drive Module Aligned for Insertion into Drawer

The chassis support LFF Midline SAS and LFF Enterprise self-encrypting drives that work with the Full Disk 
Encryption (FDE) feature.
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4U56 RAID Chassis: Rear Panel Layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of a 4U56 RAID chassis. The following image (Figure 31 below) shows a representative example of 
RAID chassis models included in the product series. 

Note: The 4U56 Series RAID chassis (4U) is considerably different from the 2U12, 2U24, and 2U48 
RAID chassis (2U) systems.

Figure 31: 4U56 RAID Chassis: Rear Panel Layout
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1. Controller I/O Module A

2. Controller I/O Module B

3. AC Power Switch (qty. 2)

4. AC Power Supply (PSU, qty. 2)

5. Fan Control Module (FCM, qty. 2)

The RAID chassis accommodates two Controller  I/O modules within the chassis (see callouts No.1 and 
No.2 above). A RAID chassis accommodates two power supply units of the same type — either both AC or 
both DC — within the two power supply slots (see two instances of callout No.4 above). Beneath each 
power supply is a power supply switch (see two instances of callout No.3 above). The RAID chassis 
accommodates two fan control modules (see two instances of callout No.5 above).

Caution: The QXS storage configurations are dual-controller. Single-controller support is provided 
only when a controller fails over to its partner controller. A controller I/O module must be installed in 
each slot to ensure sufficient airflow through the chassis during operation.

Note: The  chassis support hot-plug replacement of redundant controller I/O  modules, fans, power 
supplies, and expansion modules. Hot-add replacement of expansion chassis is also supported.
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4U56 Controller I/O  Module – Rear Panel Components
The Controller I/O  Module has two model types, converged network  (CNC) ports or HD mini-SAS. The 
models can be configured as follows:

 l Host CNC ports configured with SFPs supporting the following:

 o 4/8/16 Gb FC

 o 10GbE iSCSI

 o 1 Gb RJ-45

 l Host interface ports configured with 12 Gbit/s HD mini-SAS (SFF-8644) connectors.

Host CNC Ports Configured with SFPs (FC or iSCSI)
The following figure shows CNC ports configured with SFP+ transceivers that support 4, 8, or 16 Gb FC, or 
10 GbE iSCSI connections. The SFPs look identical. Refer to the CNC LEDs that apply to the specific 
configuration of your CNC ports.

Figure 32: Controller I/O Module with FC or iSCSI Host CNC Ports

LINK SERVICE–1

CACHE

DIRTY

CLEAN

LINK

ACTSERVICE–2 CLI

CLI

PORT 0 PORT 1 PORT 2 PORT 3

1

2 3 4 5 6 7 8



Chapter 1: Components
4U56 Drive System

QX and QXS Setup Guide 25

1. CNC FC or iSCSI with SFP+ Ports (used for host 
connection or replication; supports SFP+ FC 
transceivers)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

1. iSCSI with SFP+ Ports (used for host connection or 
replication; supports SFP+ FC transceivers)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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Host CNC Ports Configured with SFPs (1 Gb RJ-45)
Figure 33 below shows a controller I/O  Module with CNC ports configured with SFPs supporting 1 Gb RJ-
45.

Figure 33: CNC Ports Configured with SFPs (RJ-45)
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5. Network Port
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7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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Host Ports Configured with 12 Gbit/s HD mini-SAS
Figure 34 below shows a controller I/O  Module with host interface ports configured with 12 Gbit/s HD mini-
SAS (SFF-8644) connectors.

Figure 34: Host Ports Configured with HD mini-SAS

CACHE

CLI

CLI

LINKACT

6Gb/s

SERVICE−1SERVICE−2

ACT

LINK 12Gb/s

S

S

A

ACT

LINK

SAS 0 SAS 1

ACT

LINK 12Gb/s

S

S

A

ACT

LINK

SAS 2 SAS 3

2 3 4 5 6 7 8

1

1. HD Mini-SAS Ports (used for host connection)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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56 Drive Expansion chassis: Rear Panel Components
Figure 35 below and table display and identify important components that comprise the rear panel layout of 
a 56-Drive Expansion chassis. 

Figure 35: 56 Drive Expansion Chassis: Rear Panel Layout
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1. Expansion I/O Module A

2. Expansion I/O Module B

3. AC Power Supply Switch

4. Power Supply Module

5. Fan Module

An expansion chassis accommodates the following: 

 l Two expansion I/O modules of the same type within the Expansion I/O Module slots (see callouts 1 and 
2 above) 

 l Two power supplies (CRU) of the same type either both AC or both DC— within the two power supply 
slots (see two instances of callout 4)

 l Separate power supply switches (see two instances of callout 3)

 l Two fan control modules (see two instances of callout 5)

Caution: An expansion I/O module must be installed in each Expansion I/O Module slot to ensure 
sufficient airflow through the chassis during operation.
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Note: The 56-drive Expansion chassis support hot-plug replacement of redundant I/O modules, fans, 
and power supplies. Hot-add replacement of entire Drive chassis is also supported.

Expansion I/O Module Connections

The expansion I/O module connections are show in the following figure.

Figure 36: Expansion I/O Module
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1. Disabled Button (used by engineering/test only) 2.Service Port (used by service personnel only)

3. Mini-SAS In Port 4. Mini-SAS Out Port

QXS-6 Series Storage
The QXS-6 Series Storage includes the following systems:

 l QXS-648 System

 o 2U48-drive chassis

 o SFF drives (2.5 inch)

 o Drives not installed (must be installed on site)

 l QXS-656 System

 o 4U56-drive chassis

 o LFF drives (3.5 inch)

 o Drives not installed (must be installed on site)
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Note: The  2U48 and 4U56 drive chassis support installation of hard-disk drives (HDDs) and solid-state 
disks (SSDs). The drive chassis can have all HDDs or SSDs installed or a mixture of HDDs and SSDs.

QXS-648 System
The  drive chassis include a bezel sub-assembly that attaches to the front panel of the chassis. The bezel, 
comprised of a vented cover attached to an EMI shield, is pre-assembled and packed within a box contained 
in the master shipping container.  Instructions for attaching/removing the bezel are provided in the QX and 
QXS Bezel Installation Guide.

2U48-Drive Chassis
The 2U48 drive chassis is used in QXS-648.

Figure 37: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault
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Figure 38: 2U48 Drive Chassis (Bezel Removed)

Note: Integers atop drawers indicate the drawer numbering sequence.

1. Chassis ear LEDs

2. Thumbscrew (for securing or accessing drawers)

3. Disabled Button (used by engineering only)

4. Drawer Handle (shown in stowed position)

5. Drawer Status LED: FRU OK

6. Drawer Status LED: Fault/Service Required

7. Drawer Status LED: OK to Remove

8. Drawer Status LED: Unit Locator

2U48 Drive Chassis Drawers
Open the Chassis drawers to access the drives. Drawers 0 and 1 provide access to drive bays from the right 
side of the drawer; drawer 2 provides access to drive bays from the left side of the drawer. These respective 
side views—or profiles—are shown in the following figure.
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Figure 39: 2U48 Drive Chassis: Drive Slot Numbering
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Note: Drive slot numbering is also provided on the label that is laminated to the sheet metal housing 
(top face) on each drawer. Refer to the drawer label when installing drives into the drawer.

The 2U48 drive chassis is shipped with the drawers installed, but they are not populated with drives. 
Depending on your product configuration, drive bay blanks, also known as Air Management Solution (AMS) 
inserts, must be installed in all empty drive slots. Locate the box containing your sledded drives and AMS 
inserts in preparation for populating the drive slots.

Note: Refer to Enclosure Installation Checklist on page 51 for information on installing drives and AMS 
inserts.

2U48 Drive Chassis Drawers Partially Populated
Figure 40 on the next page shows drawer 0 with drives installed within slots 0-11 (callouts 2, 4, and 5). Slots 
12-15 contain four AMS inserts (callout 6) to manage air flow within the chassis to maintain optimal 
operating temperature.
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Figure 40: 2U48 Drive Chassis: Sample Drawer Population

1 432 5 6

1. Drawer 0

2. 2.5" Sledded Drives 0-31, 2

3. Drive Status LED

4. 2.5" Sledded Drives 4-71, 2  

5. 2.5" Sledded Drives 8-111, 2

6. AMS Insert (slots 12-15)3

1The drive is oriented in the sled such that its PCBA faces upward on the top side of the drive module, as shown.
2Electromagnetic interference protection is provided by the EMI shield within the chassis bezel.
3The AMS insert spans only one drive slot. Slots 12-15 have AMS inserts (4 each) installed.

Caution: Empty bays will cause overheating. To avoid overheating, install an AMS insert in drive slots 
that do not contain drive modules.

QXS-648 RAID Chassis: Rear panel layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of a QXS-648 RAID chassis (2U48). The following image (Figure 41 below) shows a representative 
example of RAID chassis models included in the product series. 

Note: The 4U56 Series RAID chassis (4U) is considerably different from the  2U48 RAID chassis (2U).

Figure 41: QXS-648 RAID Chassis: Rear Panel Layout
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1. AC Power Supplies (qty. 2)

2. AC Power Switch (qty. 2)

3. Controller I/O Module A

4. Controller I/O Module B

A RAID chassis accommodates two power supply FRUs of the same type, either both AC or both DC, 
within the two power supply slots (see two instances of callout No.1 above). The RAID chassis 
accommodates two controller I/O modules within the chasis (see callouts No.3 and No.4 above).

Caution: The  configurations are dual-controller. Single-controller support is provided only when a 
controller fails over to its partner controller. A controller I/O module must be installed in each slot to 
ensure sufficient airflow through the chassis during operation.

Note: The  chassis support hot-plug replacement of redundant I/O controller modules, fans, power 
supplies, and expansion modules. Hot-add replacement of expansion chassis is also supported.

QXS-648 I/O Controller Module – Rear Panel 
Components
The I/O Controller Module has two model types, converged network controller (CNC) or HD mini-SAS. The 
models can be configured as follows:

 l Host CNC ports configured with SFPs supporting the following:

 o 4/8/16 Gb FC

 o 10GbE iSCSI

 o 1 Gb RJ-45

 l Host interface ports configured with 12 Gbit/s HD mini-SAS (SFF-8644) connectors.

Note: Xcellis, Stornext, and QX I/O controllers support FC host attach only.
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Host CNC Ports Configured with SFPs (FC or iSCSI)
The following figure shows CNC ports configured with SFP+ transceivers that support 4, 8, or 16 Gb FC, or 
10 GbE iSCSI connections. The SFPs look identical. Refer to the CNC LEDs that apply to the specific 
configuration of your CNC ports.

Figure 42: Controller I/O Module with FC or iSCSI Host CNC Ports
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1. CNC FC or iSCSI SFP+ (ports used for host 

connection or replication)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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Host CNC Ports Configured with SFPs (1 Gb RJ-45/iSCSI)
The following figure shows a Controller I/O Module with CNC ports configured with SFPs supporting 1 Gb 
RJ-45.

Figure 43: CNC Ports Configured with SFPs (RJ-45)
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1. CNC Ports (used for host connection or replication)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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Host Ports Configured with 12 Gbit/s HD mini-SAS
The following figure shows an I/O Controller Module with host interface ports configured with 12 Gbit/s HD 
mini-SAS (SFF-8644) connectors.

Figure 44: Host Ports Configured with HD mini-SAS
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1. HD Mini-SAS Ports (used for host connection)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. HD Mini-SAS Expansion Port

QXS-648 Expansion Chassis – Rear Panel Components
The QXS-648 RAID chassis (2U48) support attachment to the expansion chassis (2U48).  The expansion 
chassis uses HD mini-SAS (SFF-8644) connectors to facilitate backend SAS expansion.

Figure 45: QXS-648 Expansion Chassis (2U48) – Rear Panel Components
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Figure 46: Closeup of Expansion I/O Module
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1. HD Mini-SAS Ports–SAS In

2. Service Port (used by service 
personnel only)

3. HD Mini-SAS Ports–SAS Out

Note: The 2U48 RAID chassis support a number of expansion chassis. Refer to the Release Notes for 
the number of expansion chassis and number of drives supported.

QXS-656 System
The bezel, comprised of a vented cover attached to an electro-magnetic interference (EMI) shield, is pre-
assembled and packed within a box contained in the master shipping container. Instructions for 
attaching/removing the bezel are provided in the QX and QXS Bezel Installation Guide.

The 4U56 drive chassis is used in QXS-656 system.
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Figure 47: 4U56 Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis Status LED: Unit Locator

3. Chassis Status LED: Fault/Service Required

4. Chassis Status LED: FRU OK

5. Chassis Status LED: Temperature Fault

Figure 48: 4U56 Drive Chassis (Bezel Removed)

Note: Drawer 0 is on the left of the chassis and Drawer 1 is on the right.
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1. Chassis ID LED

2. Thumbscrew (for securing or accessing drawer)

3. Drawer Handle (shown in stowed position)

4. Drawer Status LED: Unit Locator

5. Drawer Status LED: OK to Remove

6. Drawer Status LED: Fault/Service Required

7. Drawer Status LED: FRU OK

8. Chassis Status LED: Unit Locator

9. Chassis Status LED: Fault/Service Required

10. Chassis Status LED: FRU OK

11. Chassis Status LED: Temperature Fault
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4U56 Drive Chassis Drawers
You can open the chassis drawers to access the drives (see Figure 49 below). Drawers 0 and 1 provide 
access to drives that are oriented vertically, such that the back face of the drive faces down, and is inserted 
into the drawer drive slots from above. A single drawer diagram is used to describe the numbering scheme.

The 4U56 drive chassis is shipped with the drawers installed, but they are not populated with drives. 
Depending on your product configuration, drive module blanks, also known as Air Management Solution 
(AMS) inserts, might be installed. Locate the box containing your sledded drives and AMS inserts (if 
applicable) in preparation for populating the drive slots. 

Caution: Empty drive slots will cause overheating. To avoid overheating, install an AMS insert in each 
empty drive slot.

Note: Drive slot numbering is also provided on the label that is laminated to the sheet metal housing 
(side face) on each drawer. Refer to the drawer label when installing drives into the drawer.

Figure 49: 4U56 Drive Chassis (Front, Top, and Side Views)
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Figure 50 below provides two different view orientations of the drive module used in 4U56 drive chassis.

Figure 50: 4U56 Drive or AMS Insert

1

2

3

1. 3.5" Sledded Drive Module Assembly (front view)

2. Drive LEDs

3. 3.5" Drive Module Aligned for Insertion into Drawer
(AMS insert looks like drive module)

The chassis support LFF Midline SAS and LFF Enterprise self-encrypting drives that work with the Full Disk 
Encryption (FDE) feature.

QXS-656 RAID Chassis: Rear Panel Layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of a QXS-656 RAID chassis (4U56). The following image shows a representative example of RAID 
chassis models included in the product series. 

Note: The 4U56 Series RAID chassis (4U) is completely different from the  2U48 RAID chassis (2U).
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Figure 51: QXS-656 RAID Chassis: Rear Panel Layout
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1. Controller I/O module A

2. Controller I/O module B

3. AC Power switch (qty. 2)

4. AC power supply (PSU, qty. 2)

5. Fan control module (FCM, qty. 2)

The RAID chassis accommodates two controller I/O modules within the chassis (see callouts No.1 and No.2 
above). A RAID chassis accommodates two power supply units of the same type, either both AC or both 
DC, within the two power supply slots (see two instances of callout No.4 above). Beneath each power 
supply is a power supply switch (see two instances of callout No.3 above). The RAID chassis 
accommodates two fan control modules (see two instances of callout No.5 above).

Caution: The  configurations are dual-controller. Single-controller support is provided only when a 
controller fails over to its partner controller. A controller I/O module must be installed in each slot to 
ensure sufficient airflow through the chassis during operation.

Note: The  chassis support hot-plug replacement of redundant I/O controller modules, fans, power 
supplies, and expansion modules. Hot-add replacement of expansion chassis is also supported.
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QXS-656 I/O Controller Module – Rear Panel 
Components
The I/O Controller Module has two model types, converged network controller (CNC) or HD mini-SAS. The 
models can be configured as follows:

 l Host CNC ports configured with SFPs supporting the following:

 o 4/8/16 Gb FC

 o 10GbE iSCSI

 o 1 Gb RJ-45

 l Host interface ports configured with 12 Gbit/s HD mini-SAS (SFF-8644) connectors.

Host CNC Ports Configured with SFPs (FC or iSCSI)
The following figure shows CNC ports configured with SFP+ transceivers that support 4, 8, or 16 Gb FC, or 
10 GbE iSCSI connections. The SFPs look identical. Refer to the CNC LEDs that apply to the specific 
configuration of your CNC ports.

Figure 52: Controller I/O Module with FC or iSCSI Host CNC Ports
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1. CNC FC or iSCSI SFP+ (ports used for host 

connection or replication)

2. CLI Port (USB - Type B)

3. Service Port 2 (Service Personnel Use Only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (Service Personnel Use Only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port
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Host CNC Ports Configured with SFPs (1 Gb RJ-45/iSCSI)
The following figure shows a Controller I/O Module with CNC ports configured with SFPs supporting 1 Gb 
RJ-45.

Figure 53: CNC Ports Configured with SFPs (RJ-45)
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1. CNC Ports (used for host connection or replication)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. Mini-SAS Expansion Port

 

Host Ports Configured with 12 Gbit/s HD mini-SAS
The following figure shows an I/O Controller Module with host interface ports configured with 12 Gbit/s HD 
mini-SAS (SFF-8644) connectors.
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Figure 54: Host Ports Configured with HD mini-SAS
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1. HD Mini-SAS Ports (used for host connection)

2. CLI Port (USB - Type B)

3. Service Port 2 (used by service personnel only)

4. Reserved for Future Use

5. Network Port

6. Service Port 1 (used by service personnel only)

7. Disabled Button (used by engineering only)
(Sticker shown covering the opening)

8. HD Mini-SAS Expansion Port

QXS-656 Expansion Chassis – Rear Panel Components
The QXS-656 RAID chassis (4U56) support attachment to the expansion chassis (4U56).  The expansion 
chassis uses HD mini-SAS (SFF-8644) connectors to facilitate backend SAS expansion.
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Figure 55: QXS-656 Expansion Chassis (4U56) – Rear Panel Components
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1. Expansion module A

2. Expansion module B

3. AC power supply switch

4. AC power supply module

5. Fan control module

Figure 56: Closeup of Expansion I/O Module
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1. HD Mini-SAS Ports–SAS In

2. Service Port (used by service 
personnel only)

3. HD Mini-SAS Ports–SAS Out

Note: The 4U56 RAID chassis support a number of expansion chassis. Refer to the QXS Release 
Notes for the number of expansion chassis and number of drives supported.
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Component Installation and Replacement
Installation and replacement of QXS Storage components is addressed in the QXS Storage CRU 
Installation and Replacement. 

CRU procedures facilitate replacement of a damaged chassis or chassis components:

 l Controller or expansion module

 l Drive module

 l Drawer (QXS-456)

 l Power supply unit

 l Fan control unit

 l Ear bezels

 l FC transceiver

 l RAID chassis

Cache
To enable faster data access from storage, the following types of caching are performed:

 l Write-back or write-through caching. 

 l Write-back. The controller receives the data to be written to drives, stores it in the memory buffer, 
and immediately sends the host operating system a signal that the write operation is complete, 
without waiting until the data is actually written to the drive. Write-back cache mirrors all of the data 
from one controller module cache to the other. Write-back cache improves the performance of write 
operations and the throughput of the controller.

 l Write-through. The controller writes the data to the drives before signaling the host operating 
system that the process is complete. Write-through cache has lower write operation and throughput 
performance than write-back, but it is the safer strategy, with minimum risk of data loss on power 
failure. However, write-through cache does not mirror the write data, because the data is written to 
the drive before command completion is posted and mirroring is not required.

 l Read-ahead caching. The controller detects sequential data access, reads ahead into the next 
sequence of data (based upon settings) and stores the data in the read-ahead cache. Then, if the next 
read access is for cached data, the controller immediately loads the data into the system memory, 
avoiding the latency of a drive access.

Note: See the “About volume cache options” and “Changing system cache settings” topics in the 
Quantum Disk Storage Management Utility Users Guide for setting options.
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CompactFlash
During a power loss or controller failure, data stored in cache is saved to non-volatile memory 
(CompactFlash). After the issue is corrected, the data is restored to cache, and then written to the drives. 
CompactFlash provides unlimited cache memory backup time. To protect against writing incomplete data to 
drives, the image stored on the CompactFlash is verified before it is written to the drives.

The CompactFlash card is located at the midplane-facing end of the controller module, as shown below 
(representative location on the 2U and 4U chassis). Do not remove the card; it is used for cache recovery 
only.

Figure 57: CompactFlash

Do not remove

Used for cache recovery only

1

1. CompactFlash card

Caution: Customer removal of CompactFlash will void the product warranty.

Note: In dual-controller configurations featuring one healthy partner controller, there is no need to 
transport failed controller cache to a replacement controller because the cache is duplicated between 
the controllers (subject to volume write optimization settings).

Caution: The QXS-456 chassis support dual-controller environments only. Do not transport the 
CompactFlash, since data corruption might occur. Single-controller support is provided only when a 
controller fails over to its partner controller.



Chapter 1: Components
Supercapacitor Pack

QX and QXS Setup Guide 49

Supercapacitor Pack
To protect controller module cache in case of power failure, each controller module is equipped with 
supercapacitor technology. Along with CompactFlash memory, within each controller module, allows the 
cache memory to be written to the drives at any time. 

The supercapacitor pack provides energy for backing up unwritten data in the write cache to the 
CompactFlash, in the event of a power failure. 

Unwritten data in CompactFlash memory is automatically committed to drive media when power is restored. 
In the event of power failure, while cache is maintained by the supercapacitor pack, the Cache Status LED 
flashes at a rate of 1/10 second on and 9/10 second off.
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Enclosure Installation Checklist
Table 2 below outlines the steps required to install the RAID and expansion chassis, and initially configure 
and provision the storage system. To ensure successful installation, perform the tasks in the order 
presented.

Step Task Where to find procedure

1. Install the RAID chassis and optional 
expansion chassis  in the rack.1

Do not install bezel until assembly is 
complete.

See the rack-mount bracket kit installation instructions 
pertaining to your applicable chassis. If your product uses a 
bezel, see its bezel kit installation instructions.

2.  Install the drive modules and any air 
management solution inserts (if 
required) into the drive slots or 
drawers.

For QXS-448 drawers see Populate QXS 48-Drive Drawers 
on page 55.
For QXS-456 drawers see Install Drives Into the QXS-456 
Drive Chassis on page 62.

3.  Connect RAID chassis and optional 
expansion chassis.

See Connect the RAID Chassis and Expansion Chassis  
on page 69.

4. Connect power cords. See DC  Power Supplies with Power Switch on page 89.

5.  Test chassis connectivity. See Testing Chassis Connections on page 85.

6.  Install required host software. See Host System Requirements on page 94.

7.  If required, change the CNC port. See iSCSI Considerations.

8.  Connect hosts.2 See Connect the Chassis to Hosts on page 95.

9.  Connect management hosts.2 See Connect a Management Host on the Network on 
page 108.

10.  Obtain IP values and set network port 
IP properties on the RAID chassis. 

See Obtaining IP Values on page 118.
For USB CLI port and cable use, see  on page 198.

11.  Perform initial configuration tasks:3

Sign-in to the Disk Storage 
Management Utility.
Verify firmware revisions and update if 
necessary.
Initially configure and provision the 
system using the Disk Storage 
Management Utility

Topics below correspond to bullets at left:
See “Getting Started” in the QXS Storage Disk Storage 
Management Utility Users Guide (V2 or V3).
See “Updating Firmware” in the QXS Storage Disk Storage 
Management Utility Users Guide (V2 or V3).
See “Configuring the System” and “Provisioning the 
System” topics in the QXS Storage Disk Storage 
Management Utility Users Guide (V2 or V3).

Table 2: Installation checklist 

1See the Bezel Installation Guide for the 12-, 24-, 48-, and 56-drive chassis for additional information.
2For more about hosts, see the “About hosts” topic in the QXS Storage Disk Storage Management Utility Users Guide..
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3For additional information on the Disk Storage Management Utility, see the Disk Storage Management Utility Users Guide.

Note: Additional installation notes: 

 l Controller modules within the same chassis must be of the same type.

 l For optimal performance, do not mix 6 GB and 3 GB HDDs within the same chassis.

Network Equipment-Building System (NEBS) 
Level 3 Compliance

Generic Requirements (GRs)
Meets the NEBS requirement of GR-1089-CORE Issue 5, port types 2, 7 & 8.
Meets the NEBS requirements of GR-63-CORE Issue 3, for the product’s intended use. 

Note:  on page 69 shows NEBS-compliance for individual storage chassis.

Exceptions to GRs
Exceptions to the overall NEBS GR-63-CORE Issue 3 requirements include:

 l Heat Dissipation: Environmental Criteria Section 4.1.6, Operational Requirement O4-20. This product 
exceeds the Optional Requirements shown in Table 4-5 for Forced-Air Fan Shelf equipment.

 l Airborne Contaminants: This product is designed for indoor use only, and has not been tested for 
Outdoor Contaminant Levels (Table 4-11); per Requirement R4-86 (Environmental Criteria section 
4.5.2.2).

 l Equipment — Fan Filters: Environmental Criteria Section 4.5.4. This product does not have a fan filter, 
and has not been tested by any requirements in section 4.5.4. The following requirements have not been 
tested: R4-87 [138]; R4-88 [139]; R4-89 [176]; R4-90 [140]; R4-91 [141]; R4-92 [142]; 
R4-93 [143]; O4-94 [144] and O4-95 [145].

 l This product does not meet the requirements of Spatial Requirements, Section 2.

Exceptions to the overall NEBS GR-1089-CORE Issue 5 requirements include:

 l None reported

Product Documentation Requirements
NEBS product documentation requirements applying to Quantum QXS Storage RAID and expansion 
chassis are listed beneath “NEBS (Level 3)” in the Index — under either GR-1089-CORE Issue 5 or GR-63-
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CORE Issue 3 — together with adjacent page locations. NEBS topics are integrated within the overall 
content of this setup guide. The requirement designators in the Index have been codified for use within index 
marker tags according to the following example:

NEBS generic requirement number “R1-3 [155]” appears as “R1-3.155” within the Index.

Each codified string (e.g., R1-3.155) is followed by a hyphen and brief description of the requirement. Within 
the Index, click on the blue page number link to navigate to the corresponding NEBS topic.

Install Drives Into the QXS 12-Drive and 24-
Drive Chassis
This section covers the following systems:

 l QXS-312 and QXS-412 (2U12 chassis)

 l QXS-324 and QXS-424 (2U24 chassis)

 l QXS-1200  (2U12 chassis)

 l QXS-2400 (2U24 chassis)

 l QX-1200  (2U12 chassis)

 l QX-2400 (2U24 chassis)

Prerequisites
Review the following information before populating the 12-drive or 24-drive chassis.

 l Full Disk Encryption (FDE) firmware feature. See FDE Considerations in the QX and QXS Setup 
Guide.

 l Preventing electrostatic discharge. See Take ESD Precautions.
Installation Steps
 l You will use the same processes for removing and installing the bezel for the 12- and 24-drive 

chassis:

 o Step 3: Install the Bezel (2U12 or 2U24 Chassis) on page 55

 l To install the drives, use the appropriate installation task for your chassis type. 

 o Step 2a: Install the LFF Drives into the  2U12 Chassis on the next page

 o Step 2b: Install the Drives into the  2U24 Chassis on the next page

For both chassis types, the drives are located behind the bezel. The difference between the two is that 
the drives are installed horizontally in the 12-drive chassis but vertically in the 24-drive chassis.

http://www.quantum.com/serviceandsupport/softwareanddocumentationdownloads/qxshybriddisk/index.aspx?whattab=Third
http://www.quantum.com/serviceandsupport/softwareanddocumentationdownloads/qxshybriddisk/index.aspx?whattab=Third
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Important Considerations

 l For the 2U12 chassis, always install the first drive into slot 0, and then populate slots 1-11 sequentially 
with any additional drives. 

 l For the 2U24 chassis, always install the first drive into slot 0, and then populate slots 1-23 sequentially 
with any additional drives. 

 l For proper cooling of the chassis, populate any empty drive slots with an AMS insert.

Step 2a: Install the LFF Drives into the  2U12 Chassis
 1. With the LEDs oriented to the left, slide the drive module into the drive slot as far as it will go. When the 

drive is inserted all the way, you should hear a "click." 

Figure 58: Installing a drive module

 2. Verify that you have inserted the drive module into the slot as far as it will go.

This step is important to ensure that the  module is firmly seated in the chassis midplane.

Step 2b: Install the Drives into the  2U24 Chassis
 1. Squeeze the latch release flanges together, and pull the latch while rotating it upward until it is fully 

open.

 2. With the LEDs oriented to the bottom, slide the drive module into the drive slot as far as it will go.

Figure 59: Installing a drive module

 3. Rotate the latch downward until it clicks closed to firmly seat the drive module in the chassis midplane.
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Step 3: Install the Bezel (2U12 or 2U24 Chassis)
 1. Orient the bezel to align its back side with the front face of the chassis as shown in the figure below.

 2. Face the front of the chassis, and while supporting the base of the bezel, position it so that the mounting 
sleeves within the integrated ear caps align with the ball studs.

 3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the chassis.

Figure 60: Installing the Bezel (2U 12-drive  chassis shown in this example)

Populate QXS 48-Drive Drawers
Although the 2U48 chassis provides pre-assembled and pre-installed drawers, drives must be installed into 
the drawers at the customer site. In addition to locating your drives—and any Air Management Solution 
(AMS) inserts, you should become familiar with the following concepts before populating the drawers:

 l Full Disk Encryption (FDE) firmware feature (see FDE Considerations on page 68).

 l Preventing electrostatic discharge (see About Electrostatic Discharge on page 196).

Opening and Closing a Drawer
You can open a drawer for visual inspection of drive bays. Before accessing the drawer via its handle, you 
must first remove the chassis bezel (see the QX and QXS Bezel Installation Guide). Given that the chassis 
bezel is required to provide EMI protection, you should re-attach the bezel to the chassis after examining the 
drawer (see the QX and QXS Bezel Installation Guide).
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 1. Using a Torx T15 or straight blade screwdriver, loosen the drawer stop screw on the front face of the 
drawer. 

 l Once the screw is loosened, turn the outer thumbwheel counter-clockwise to unlock the drawer. 
Take care not to remove the screw.

 l Figure 61 below provides a 2U48 drive chassis front panel with bezel removed and showing drawer 
0 (left), drawer 1 (middle), and drawer 2 (right).

Figure 61: Opening a drawer: loosen the drawer stop screw

1 20

Note: Loosen the screw on the target drawer.

 2. Revolve the drawer handle upwards by 90 degrees to enable pulling the drawer outward for viewing 
drives.

The drawer handle functions identically on all drawers.

Figure 62: Opening a drawer: revolve the handle

90°
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 3. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide.

Figure 63: Opening and closing drawer

90°

 4. Pull the drawer outward until it meets the drawer stop.

To close the drawer, simply slide the drawer into the chassis  along the drawer slide until it properly 
seats in the drawer bay.

 l Take care to ensure there are no loose cable wires protruding beyond the limits of the igus chainflex 
cable.

 l After closing the drawer, revolve the handle downwards such that it is flush with the drawer front 
panel—in its stowed position—and re-attach the bezel to the front of the chassis.

Aligning an AMS or Drive Into a drawer
Note: These are important notes when installing drives within a 2U48 chassis.

 l You must populate the 2U48 chassis in four (4 each) drive increments and populate a vertical slot group 
in the drawer.

 l Always install drives in the 2U48 chassis in slot 0-3 first (drawer 0). 

 l Quantum recommends that you distribute additional drives among the three drawers to mitigate potential 
performance bottlenecks.

 l Populate any empty drive slots with an AMS insert to allow proper cooling of the chassis.

 

Once you have opened the drawer, you can access the drive bays.

 l The chassis  uses an SFF sledded drive positioned to lay on its side—with the drive PCBA facing up—for 
insertion into the drive slot within the drawer.
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 l Each drive is mated to a connector on the drawer PCBA.

 l In the absence of quantity-four drives, the chassis  uses an AMS insert within drive bays to manage air 
flow within the chassis, to help maintain optimal operating temperature.

Figure 64: Aligning/Installing an AMS or Drive into Drawer

1

2

1. AMS

2. Disk

 

Each drawer has four drive bays. Each drive bay must be populated with either four (4 each) AMS inserts or 
a full complement of four drives.

Installing an AMS Into a drawer
Refer to Figure 65 on the next page when orienting the AMS for insertion into the target drawer.

 l If you are installing into the left drawer or middle drawer, refer to the illustration on the left when 
performing this step-procedure.



Chapter 2: Installing the Chassis
Populate QXS 48-Drive Drawers

QX and QXS Setup Guide 59

 l If you are installing into the right drawer, refer to the illustration on the right when performing this step-
procedure.

Figure 65: Installing an AMS into a Drawer

 1. Squeeze the latch release flanges together—so that the locking-nib will clear the sheet metal bay 
wall—and insert the AMS into the target drive slot.

 2. Verify that the AMS insert is firmly seated in place.

Install the remaining AMS inserts into the applicable empty drive slots.

The installed AMS inserts should now appear as shown  in Figure 66 below

Figure 66: Securing AMS into a Drawer

1 432 5 6

1. Drawer 0

2. 2.5" sledded drives 0-31, 2

3. Drive status LED

4. 2.5" sledded drives 4-71, 2  

5. 2.5" sledded drives 8-111, 2

6. AMS insert (slots 12-15)3

1The drive is oriented in the sled such that its PCBA faces upward on the top side of the drive module as shown.
2Electromagnetic interference protection is provided by the EMI shield within the chassis bezel.
3The AMS insert spans only one drive slot. Slots 12-15 have AMS inserts (4 each) installed.
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Caution: Empty bays will cause overheating. To avoid overheating, install an AMS insert in drive slots 
that do not contain drive modules.

Installing a Drive Into a drawer
Refer to Figure 67 below when orienting the drive for insertion into the target drawer.

 l If you are installing a drive in the left drawer or middle drawer, refer to the illustration on the left when 
performing the step-procedure.

 l If you are installing a drive in the right drawer, refer to the illustration on the right when performing this 
step-procedure.

Also see the admonition—following this procedure—concerning the installation of drives into an operating 
chassis  (not powered-off).

Figure 67: Aligning Drive for Installation in Drive Bay

1. While supporting the bottom of the drive with one hand (disk PCBA should be facing up and latch 
release flanges should be facing out)—align the drive for insertion into the target disk slot.

Figure 68: Securing Drive in Drive Bay

2. Using your other hand, squeeze the latch release flanges together—so that the locking-nib will clear the 
sheet metal bay wall—and insert the drive into the target slot.
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3. Firmly push the drive module into the slot until the locking nib, on the drive, latches into the drive chassis. 

Note: You will hear a distinct click when the locking nib engages into its chassis drive slot.

Caution: Verify that the drive module locks securely within the chassis. If the drive module is not locked 
securely within the chassis, the drive module might not power on and might not be assessable by the 
controller and/or host.

Figure 69: Drive module and locking nib

1. Chassis drawer 2. Drive module
3. Locking nib 4. Latch release flanges

Note: Refer to the following link (Training tab) for a video on drive installation: 
http://www.quantum.com/qxshybriddocs

 

The installed drive module should now appear as shown in the sectioned cutaway views of the respective 
drawers.

http://www.quantum.com/qxshybriddocs
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Figure 70: Securing Drive in Drive Bay

Caution: When replacing drives in an operating chassis, only one drive can be replaced at a time (see 
“Replacing a drive” within the CRU Installation and Replacement Guide).

Install Drives Into the QXS-456 Drive Chassis
The 4U56 chassis — RAID chassis and / or expansion chassis — are shipped pre-assembled with pre-
installed drawers. You must manually install the drives into the drawers. 

To install drives into a 4U56 chassis, you must first open the drawer to access the drive bays. The chassis 
uses a sledded drive positioned to stand on end, allowing for insertion into the drawer. Each LFF drive is 
mated to its connector on the drawer PCBA.

Important Considerations

 l You must populate the 4U56 chassis with a minimum of 14 drives.

 o Install 7 drives in drawer 0, slots 0-6.

 o Install 7 drives in drawer 1, slots 28-34.

 l Distribute additional drives between the two drawers to mitigate potential performance bottlenecks.

 l Due to weight and / or lifting constraints, ensure the 4U56 chassis is installed within the applicable 
rack before populating the chassis with drives.

 l Before the initial installation of drives, ensure that the rack is stabilized — that the leveling screws 
down and locked. This stabilization will prevent the possibility of the rack tipping over when populating 
the QXS-456.
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 l If you are going to fully populate the entire drawer(s), install the drives starting from the back row and 
moving towards the front row. Make sure to provide adequate support for the weight of the extended 
drawer as you install the drives.

Drawer Diagrams
 

Diagram 1: Drive Locations
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The above image illustrates the location of the drives and drive numbers (0-55). 

 l Drawer 0 contains drives 0-27. 

 l Drawer 1 contains drives 28-55. 

 l Populate the drawer from the front to the back with drives (0-27 for Drawer 0 and 28-55 for Drawer 1).

 
Diagram  2: Installing Drives
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The above image illustrates the installation of drives into a drawer. When orienting the drive module for 
insertion into the target drawer, note the following:

 l The drive installation procedure applies to the left drawer (Drawer 0) and the right drawer (Drawer 1). 

 l Drive row and slot numbering for each drawer is provided on the sticker laminated to the exterior wall of 
each drawer.

 
Diagram  3: Drawer 0 Fully Populated

The above image illustrates Drawer 0 fully populated with drives. Note the following:

 l Staggered elevation of slide rails

 l Locations of laminated drawer row/slot-numbering reference diagrams

 l Orientation of installed drives
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Diagram  4: Drawer 1 Fully Populated

The above image illustrates Drawer 1 fully populated with drives. Note the following:

 l Staggered elevation of slide rails

 l Locations of laminated drawer row/slot-numbering reference diagrams

 l Orientation of installed drives

 

Open a Drawer
Caution: Before opening and/or accessing either of the drawers via its handle, you must first remove 
the front bezel. The chassis bezel is required to provide EMI protection for the product, you must re-
attach the bezel to the chassis after examining the drawer.

 1. Using a No.2 phillips screwdriver, loosen the two screws securing the handle to the front face of the 
drawer.

 2. Turn the thumbwheel counter-clockwise to disengage the handle from it’s upright stowed position.

Figure 71: QXS-456 with bezel removed
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 3. Move the drawer stop-latch so that the target drawer can travel along the slide.

 l Move the stop-latch to the right to open Drawer 0 (left drawer).

 l Move the stop-latch to the left to open Drawer 1 (right drawer).

 4. Revolve the drawer handle downwards by 90° so that the drawer can be pulled outward for viewing 
drive slots.

Figure 72: QXS-456 opening drawer

The drawer handle is in the pull and stow positions.

 5. Face the front of the drawer, and using the handle, pull the drawer outward along the drawer slide until 
it meets the drawer stop.

Make sure that there are not any loose cable wires protruding beyond the limits of the chain-flex cable.

Install a Drive Into a Drawer
 1. With the drive module standing on end, and the LEDs oriented to the left, insert the drive module into 

the vertically-aligned drive slot to seat it into the connector on the drawer PCBA.
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Figure 73: Installing a drive

 2. Verify that you have inserted the drive module into the slot as far as it will go, to ensure that the module if 
firmly seated in the drawer PCBA

Remove a Drive From a Drawer
 1. Using your index finger, slide the release latch, located in the right pocket on the face of the drive 

module, to the left to disengage the drive module.

Moving the latch to the left will provide a clicking sound and cause the spring to move its position inside 
the drawer cage, partially ejecting the drive from its installed position within the drive slot.

 2. Wait 20 seconds for the internal drive to stop spinning (HDDs).

Do not remove the drive from the drawer until the internal drive has stopped spinning.
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Figure 74: Removing a drive

 3. When the drive module partially ejects from the slot, grasp the module firmly, and carefully pull it straight 
out of the drawer slot.

Take care not to drop the module.

Close a Drawer
 1. Slide the drawer into the chassis along the drawer slide until it properly seats in the drawer bay.

 2. Verify that there are not any loose cable wires protruding beyond the limits of the chain-flex cable. 

 3. Revolve the handle upwards such that it is flush with the drawer front panel in the stowed position.

 4. Using a No. 2 Phillips screwdriver, tighten the two screws securing the handle to the front face of the 
drawer.

 5. Re-attach the bezel to the front of the chassis.

FDE Considerations
The Full Disk Encryption (FDE) feature available via the management interfaces requires use of self-
encrypting drives (SED) which are also referred to as FDE-capable drive modules. When installing FDE-
capable drive modules, follow the same procedures for installing drives that do not support FDE. The 
exception occurs when you move FDE-capable drive modules for one or more drive groups to a different 
system, which requires additional steps.
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The procedures for using the FDE feature, such as securing the system, viewing drive FDE status, and 
clearing and importing keys are performed using the web-based application or CLI commands (see the 
Storage Management Guide or CLI Reference Guide for more information).

Note: When moving FDE-capable drive modules for a drive group, stop I/O to any drive groups before 
removing the drive modules. 

While replacing or installing FDE-capable drive modules, consider the following:

 l If you are installing FDE-capable drive modules that do not have keys into a secure system, the system 
will automatically secure the drives after installation. Your system will associate its existing key with the 
drives, and you can transparently use the newly-secured drives.

 l If the FDE-capable drive modules originate from another secure system, and contain that system’s key, 
the new drives will have the Secure, Locked status. The data will be unavailable until you enter the 
passphrase for the other system to import its key. Your system will then recognize the metadata of the 
drive groups and incorporate it. The drives will have the status of Secure, Unlocked and their contents 
will be available:

 l To view the FDE status of drives, use the Storage Management GUI or the show fde-state CLI 
command.

 l To import a key and incorporate the foreign drives, use the Storage Management GUI or the set 
fde-import-key CLI command.

Note: If the FDE-capable drives contain multiple keys, you will need to perform the key importing 
process for each key to make the content associated with each key become available.

 l If you do not want to retain the drives’ data, you can repurpose the drives. Repurposing drives deletes all 
drive data, including lock keys, and associates the current system’s lock key with the drives. To 
repurpose drives, use the Storage Management GUI or the set disk CLI command.

 l You need not secure your system to use FDE-capable drives. If you install all FDE-capable drives into a 
system that is not secure, they will function exactly like drives that do not support FDE. As such, the data 
they contain will not be encrypted. If you decide later that you want to secure the system, all of the drives 
must be FDE-capable.

 l If you install a drive module that does not support FDE into a secure system, the drive will have the 
Unusable status and will be unavailable for use.

 l If you are re-installing your FDE-capable drive modules as part of the process to replace the chassis-
and-midplane FRU, you must insert the original drives and re-enter their FDE passprhase.

Connect the RAID Chassis and Expansion 
Chassis 
Table 3 on the next page provides the available QX and QXS systems supported.
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Model  Host Interface Drives Form Factor Number of 
Controllers

QXS-312/QXS-412 CNC* or SAS 3.5” LFF (12 
drives) 

2U12 2

QXS-324/QXS-424 CNC* or SAS 2.5” SFF (24 
drives)

2U24 2

QXS-448/QXS-648  CNC* or SAS 2.5” SFF (48 
drives)

2U48 2

QXS-456/QXS-656 CNC* or SAS 3.5” LFF (56 
drives) 

4U56 2

StorNext QXS-1200 
or QX-1200 

FC only 3.5” LFF (12 
drives) 

2U12 2

StorNext QXS-2400 
or QX-2400  

FC only 2.5” SFF (24 
drives) 

2U24 2

StorNext QXS-5600  FC only 3.5” LFF (56 
drives) 

4U56 2

*CNC (converged network controller) allows for FC, iSCSI (10GbE), iSCSI (1 Gb) host interface connections 
using SFPs.

Note 1: Air management solution (AMS) inserts  must be installed within the QXS-448 and QXS-648 chassis in the 
unpopulated drive slots to ensure system cooling.

Note 2: The QXS-312/QXS-412 and QXS-456/QXS-656 systems can use hybrid sleds with the SFF drives for placement 
into the LFF chassis.

Note 3: When addressing drives within a  system, the word drive(s) indicates HDDs or SSDs.

Table 3: Available QXS Systems 

 

 

 

Supported/Unsupported Configurations
This section provides the supported and unsupported configurations as follows:

 l Supported QXS Hybrid Configurations on the next page

 l Unsupported QXS Hybrid Configurations on the next page
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 l Supported QXS StorNext Configurations below

 l Unsupported QXS StorNext Configurations below

Supported QXS Hybrid Configurations
Table 3 on the previous page provides the available Hybrid QXS Supported Configurations.

Product Chassis Max Chassis Max Drives

QXS-312 2U12 4 48

QXS-324 2U24 4 96

QXS-412 2U12 8 96

QXS-424 2U24 8 192

QXS-448 2U48 4 192

QXS-456 4U56 (4) & 2U12 (2) 6 248

QXS-648 2U48 4 192

QXS-656 4U56 (4) & 2U12 (2) 8 248

Note 1: Always consider the max drive number when mixing different chassis combinations.

Note 2: It is impossible to identify all possible chassis combinations within the hybrid QXS supported 
configurations.

Table 4: Available QXS Systems 

Unsupported QXS Hybrid Configurations
Currently, with the G222 FW release, there are no unsupported configurations.

Supported QXS StorNext Configurations
The supported configurations are:

 l QXS-1200/QXS-2400 base supports QXS-1200/QXS-2400 expansions.

 l QXS-5600 base supports QXS-5600 expansions.

Unsupported QXS StorNext Configurations
The unsupported configurations are:

 l QXS-1200/QXS-2400 base does not support QXS-5600 expansions.
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 l QXS-5600 base does not support QXS-1200/QXS-2400 expansions.

Cabling
The QXS Storage supports both straight-through and reverse SAS cabling. Reverse cabling allows any 
drive chassis to fail or be removed while maintaining access to other chassis. Fault tolerance and 
performance requirements determine whether to optimize the configuration for high availability or high 
performance when cabling.

Caution: Some 6-Gbit/s drives might not consistently support a 6-Gbit/s transfer rate. If this happens, 
the system automatically adjusts transfers to those drives to 3-Gbit/s, increasing reliability and reducing 
error messages with little impact on system performance. This rate adjustment persists until the 
controller is restarted or power-cycled.

Cabling diagrams in this section show fault-tolerant cabling patterns. Controller and expansion modules are 
identified by <enclosure-ID><controller-ID>. When connecting multiple drive chassis, use reverse 
cabling to ensure the highest level of fault tolerance, enabling controllers to access remaining expansion 
chassis if a expansion chassis fails. 

For example, Figure 76 on page 77  shows reverse cabling wherein controller 0A (i.e., enclosure-ID = 0; 
controller-ID = Able) is connected to expansion module 1A, with a chain of connections cascading down 
(blue). Controller 0B is connected to the lower expansion module (B) of the last expansion chassis in the 
chain, with connections moving in the opposite direction (green). Several cabling examples are provided on 
the following pages.

Note: The QXS storage RAID chassis and expansion chassis support hot-plug replacement of 
redundant controller modules, fans, power supplies, and IOMs. Hot-add of expansion chassis is also 
supported.

Cable Requirements for Expansion Chassis
The expansion chassis support 6-Gbit/s or 3-Gbit/s expansion port data rates. Use only OEM-qualified 
cables, and observe the following guidelines:

 l When installing SAS cables to expansion I/O modules, use only supported mini-SAS x4 cables with 
SFF-8644 connectors.

 l Qualified mini-SAS to mini-SAS 0.5 m (1.64') cables are used to connect cascaded expansion chassis in 
the rack. The “HD mini-SAS to HD mini-SAS” cable designator connotes SFF-8644 to SFF-8644 
connectors.

 l The maximum expansion cable length allowed in any configuration is 2 m (6.56').

 l Cables required, if not included, must be separately purchased.

 l When adding more than two expansion chassis, you may need to purchase additional 1 m or 2 m cables, 
depending upon number of expansion chassis and cabling method used:

 l Spanning 3, 4, or 5 expansion chassis requires 1 m (3.28') cables.

 l Spanning 6 or 7 expansion chassis requires 2 m (6.56') cables.

 l You may need to order additional or longer cables when reverse-cabling a fault-tolerant configuration.
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 l Use only AssuredSAN or OEM-qualified cables for host connection:

 l Qualified Fibre Channel SFP and cable options

 l Qualified 10GbE iSCSI SFP and cable options

 l Qualified 1 Gb RJ-45 SFP and cable options

 l Qualified HD mini-SAS standard cable options supporting SFF-8644 and SFF-8088 host 
connection

 l A qualified SFF-8644 to SFF-8644 cable option is used for connecting to a 12 Gbit/s enabled 
host.

 l Where as a qualified SFF-8644 to SFF-8088 cable option is used for connecting to a 6 Gbit/s 
enabled host.

Note: The 4U56 chassis does not use the 0.5 m (1.64') length supported for 2U chassis.

Summary of Cabling Connections
This section cover the following: 

 l QXS-312 and QXS-324 Systems below

 l QXS and QXS-4 Series Systems on the next page

 l QXS-648 and QXS-656 Systems on page 75

QXS-312 and QXS-324 Systems

Model Host Connect LFF 12-Drive Chassis SFF 24-Drive Chassis

2U12 FC (8/16 Gb) SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 FC (8/16 Gb) SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U12 10 GbE iSCSI SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 10 GbE iSCSI SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U12 1 GbE iSCSI SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 1 GbE iSCSI SFP option mini-SAS to mini-SAS mini-SAS to mini-SAS

2U12 12 Gb HD mini-SAS mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 12 Gb HD mini-SAS mini-SAS to mini-SAS mini-SAS to mini-SAS

Table 5: Summary of Mini-SAS cable type requirements and related chassis characteristics
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Model Host Connect LFF 12-Drive Chassis SFF 24-Drive Chassis

2U12: Chassis measuring two rack units high, providing 12 LFF (3.5") sledded disk drive modules.

2U24: Chassis measuring two rack units high, providing 24 SFF (2.5") sledded disk drive modules.

QXS and QXS-4 Series Systems
Systems covered within this section include: 

 l QXS-412 (2U12)

 l QXS-424 (2U24)

 l QXS-448 (2U48)

 l QXS-456 (4U56)

 l QXS-1200 (2U12)

 l QXS-2400 (2U24)

 l QXS-5600 (4U56)

Model Host Connect SFF 24 or 48-Drive 
Chassis

LFF 12 or 56-Drive Chassis

2U12 FC (8/16 Gb) SFP option  10 
GbE iSCSI SFP option

1 GbE iSCSI SFP option 

mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U48 mini-SAS to mini-SAS mini-SAS to mini-SAS

4U56 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U12 HD mini-SAS mini-SAS to mini-SAS mini-SAS to mini-SAS

2U24 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U48 mini-SAS to mini-SAS mini-SAS to mini-SAS

4U56 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U12: Chassis measuring two rack units high, providing 12 LFF (3.5") sledded disk drive modules.

2U24: Chassis measuring two rack units high, providing 24 SFF (2.5") sledded disk drive modules.

2U48: Chassis measuring two rack units high, providing 48 SFF (2.5") sledded disk drive modules.

4U56: Chassis measuring four rack units high, providing 56 LFF (3.5") sledded disk drive modules.

The 2U12, 2U24, and 4U56 drive chassis are designed for NEBS compliance; however, the 2U48 drive chassis 
are not.

Table 6: Summary of Mini-SAS cable type requirements and related chassis characteristics
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QXS-648 and QXS-656 Systems

Model Host Connect SFF 48-Drive Chassis LFF 56-Drive Chassis

2U48 FC (8/16 Gb) SFP option  10 
GbE iSCSI SFP option

1 GbE iSCSI SFP option

mini-SAS to mini-SAS mini-SAS to mini-SAS

4U56 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U48 HD mini-SAS mini-SAS to mini-SAS mini-SAS to mini-SAS

4U56 mini-SAS to mini-SAS mini-SAS to mini-SAS

2U48: Chassis measuring two rack units high, providing 48 SFF (2.5") sledded disk drive modules.

4U56: Chassis measuring four rack units high, providing 56 LFF (3.5") sledded disk drive modules.

The 4U56 drive chassis are designed for NEBS compliance; however, the 2U48 drive chassis are not.

Table 7: Summary of Mini-SAS cable type requirements and related chassis characteristics

QXS, QXS-3, and QXS-4 Series Drive Chassis 
Reverse Cabling Illustrations
This section covers the following systems: 

 l QXS-312 (2U12) and QXS-324 (2U24)

 l QXS-412 (2U12), QXS-424 (2U24), QXS-448 (2U48), and QXS-456 (4U56)

 l QXS-1200 (2U12)

 l QXS-2400 (2U24)

 l QXS-5600 (4U56)

 

Note: For clarity, the images show only relevant details such as face-plate outlines and expansion 
ports.

Example: Dual-controller Chassis with 1 Drive Expansion Chassis
Cable the RAID Chassis to the Expansion Chassis as shown in the following image.

 l Use the reverse cabling method shown in the following image to ensure the highest level of fault 
tolerance.
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This cabling method enables the RAID Chassis to maintain access to other Expansion Chassis if any 
Expansion Chassis fails or is removed.

 l Note the following:

 o The upper RAID Controller I/O Module is connected to the upper Expansion Controller I/O Module.

 o For 12 and 24 drive chassis, Controller A and B are located as indicated in the following diagram.

 o For 56 drive chassis, Controller A is located on the right side of the RAID chassis, and Controller B is 
located of the left side of the RAID chassis, as viewed from the back of the chassis. 

 o Consult with Quantum technical support when mixing and matching the QXS-3 and QXS-4 Series 
expansion chassis.

Figure 75: SAS Cabe Connections Between a QXS RAID Chassis with Dual Controller I/O Modules and an Expansion 
Chassis
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Example: Dual-controller Chassis with 3 Drive Expansion Chassis
Cable the RAID Chassis to the Expansion Chassis as shown in the following image.

 l Use the reverse cabling method shown in the following image to ensure the highest level of fault 
tolerance.

This cabling method enables the RAID Chassis to maintain access to other Expansion Chassis if any 
Expansion Chassis fails or is removed.

 l Note the following: 

 o Controller I/O Module 0A is connected to expansion module 1A, with a chain of connections cascading 
down (blue). 

 o Controller I/O Module  0B is connected to the lowest expansion module of the last drive chassis, with 
connections returning to the RAID chassis, in the opposite direction (green).

 o Consult with Quantum technical support when mixing and matching the QXS-3 and QXS-4 Series 
expansion chassis.
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Figure 76: Reverse Cabling Connections Between a RAID Chassis with Dual Controller I/O Modules and 3 Expansion 
Chassis
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Example: Dual-controller RAID Chassis with 7 Expansion Chassis
Cable the RAID Chassis to the Expansion Chassis as shown in the following image.

 l Use the reverse cabling method shown in the following image to ensure the highest level of fault 
tolerance.

This cabling method enables the RAID Chassis to maintain access to other Expansion Chassis if any 
Expansion Chassis fails or is removed.

 l Note the following: 

 o Controller I/O Module 0A is connected to expansion module 1A, with a chain of connections cascading 
down (blue). 

 o Controller I/O Module  0B is connected to the lowest expansion module of the last drive chassis, with 
connections returning to the RAID chassis, in the opposite direction (green).

 o Consult with Quantum technical support when mixing and matching the QXS-3 and QXS-4 Series 
expansion chassis.
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Figure 77: Reverse cabling between a dual-controller RAID chassis and 7 expansion chassis 
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QXS, QXS-3, and QXS-4 Series Drive Chassis 
Straight Cabling Illustrations
This section covers the following systems: 

 l QXS-312 (2U12) and QXS-324 (2U24)

 l QXS-412 (2U12), QXS-424 (2U24), QXS-448 (2U48), and QXS-456 (4U56)

 l QXS-1200 (2U12)

 l QXS-2400 (2U24)

 l QXS-5600 (4U56)

Refer to the following images when cabling multiple compatible drive chassis together with the RAID 
chassis with dual-controller I/O modules connected using straight-through cabling. 

Caution: Using the straight-through cabling method, if a drive expansion chassis fails, the chassis that 
follow the failed chassis in the chain are no longer accessible until the failed chassis is repaired or 
replaced. Reverse cabling allows any drive expansion chassis to fail—or be removed—while 
maintaining access to other expansion chassis.

Note: For clarity, the images show only relevant details such as face-plate outlines and expansion 
ports.

Note: For 56 drive chassis, Controller A is located on the right, and Controller B is located of the left 
side of the RAID chassis, as viewed from the back.

Example Dual-controller RAID Chassis with 1 Expansion Chassis
The following figure shows a  dual-controller chassis cabled to an expansion chassis featuring dual-
expansion I/O modules. Controller I/O module 0A is connected to expansion module 1A (blue). Controller 
I/O module 0B is connected to expansion module 1B (green).
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Figure 78: Cabling connections between a dual-controller chassis and one drive expansion chassis
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Example: Dual-controller RAID Chassis with 3 Drive Expansion 
Chassis
The following figure shows straight-through cabling, of a dual-controller RAID chassis and 3 expansion 
chassis configured with dual-expansion I/O modules. Controller module 0A is connected to expansion I/O 
module 1A, with a chain of connections cascading down (blue). Controller I/O module 0B is connected to the 
lower expansion I/O module (4B), of the last drive chassis, with connections moving in the opposite direction 
(green).
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Figure 79: Straight cabling between a dual-controller RAID chassis and three drive chassis
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Example: Dual-controller RAID Chassis with 7 Expansion Chassis
The following figure shows a dual-controller RAID chassis cabled to 7 expansion chassis featuring dual-
expansion I/O modules. Controller I/O module 0A is connected to expansion I/O module 1A, with a chain of 
connections cascading down (blue). Controller I/O module 0B is connected to the lower expansion I/O 
module (7B), of the last drive expansion chassis, with connections moving in the opposite direction (green).

Note: Consult with Quantum technical support when mixing and matching the QXS-3 and QXS-4 
Series expansion chassis.
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Figure 80: Straight-through cabling between a dual-controller RAID chassis and 7 expansion chassis 
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QXS-6 Series Drive Chassis Cabling 
Illustrations
This section covers the following systems: 

 l QXS-648 (2U48)

 l QXS-656 (4U56)

 

Note: For clarity, the schematic diagrams show only relevant details such as face-plate outlines and 
expansion ports.

Note: For 56 drive chassis, Controller A is located on the right, and Controller B is located of the left 
side of the RAID chassis, as viewed from the back.

Dual-controller Chassis with 1 Drive Expansion Chassis
Figure 81 below shows a  dual-controller chassis cabled to an expansion chassis featuring dual-expansion 
I/O modules. Controller I/O module 0A is connected to expansion module 1A (blue). Controller I/O module 
0B is connected to expansion module 1B (green).

Figure 81: Cabling connections between a dual-controller chassis and one expansion chassis
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Reverse Cabling
Figure 82 on the next page shows reverse cabling (diagram on left) of a dual-controller RAID chassis and 3 
expansion chassis configured with dual-expansion I/O modules. Controller module 0A is connected to 
expansion I/O module 1A, with a chain of connections cascading down (blue). Controller I/O module 0B is 
connected to the lower expansion I/O module (4B), of the last expansion chassis, with connections moving 
in the opposite direction (green). Reverse cabling allows any expansion chassis to fail—or be removed—
while maintaining access to other expansion chassis. 
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Figure 82: Fault-tolerant cabling between a dual-controller RAID chassis and three expansion chassis
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Straight-through Cabling
Figure 82 above shows storage components connected using straight-through cabling. Using this method, if 
a drive expansion chassis fails, the chassis that follow the failed chassis in the chain are no longer accessible 
until the failed chassis is repaired or replaced.

Refer to these diagrams when cabling multiple compatible expansion chassis together with the RAID 
chassis with dual-controller I/O modules. Remember that reverse cabling allows any drive expansion 
chassis to fail—or be removed—while maintaining access to other expansion chassis.

Dual-controller RAID Chassis with 3 Expansion Chassis
Figure 83 on the next page shows a dual-controller RAID chassis cabled to 3 expansion chassis featuring 
dual-expansion I/O modules. Controller I/O module 0A is connected to expansion I/O module 1A, with a 
chain of connections cascading down (blue). Controller I/O module 0B is connected to the lower expansion 
I/O module (3B), of the last drive expansion chassis, with connections moving in the opposite direction 
(green).

Note: Consult with Quantum technical support when mixing and matching the QXS-3 and QXS-4 
Series expansion chassis.
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Figure 83: Straight-through cabling between a dual-controller RAID chassis and 3 drive expansion chassis
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Testing Chassis Connections
Note: For NEBS applications, verify that you are using compatible power supplies, RAID chassis, and 
expansion chassis.

Power cycling procedures vary according to the type of power supply provided with the chassis. Some 
chassis models are equipped with power supplies possessing power switches; whereas other chassis use 
power supplies that have no power switch. 

The 2U12 and 2U24 chassis use a common PSU model for AC and a common PSU model for DC. The 
4U56 chassis use a different PSU model for AC and a different PSU model for DC. The 2U48 chassis use 
an AC PSU model that is equipped with a power switch; the 2U48 chassis does not presently support a DC 
PSU.

Power On/Power Off below describes power cycling procedures relative to different types of power supplies 
installed within chassis . Once the power-on sequence succeeds, the storage system is ready to be 
connected to hosts as described in Connect the Chassis to Hosts on page 95.

Power On/Power Off

Powering On the Chassis/System
Before powering on the chassis for the first time:
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 l Install all drives in the RAID and/or expansion chassis so the controller can identify and configure them at 
power-up.

Note: For high-capacity 2U48 or 4U56 chassis, you must remove the chassis bezel and open the 
target drawer to access disk slots or view LEDs for disks.

 

 l Connect the cables and power cords to the RAID and/or expansion chassis as described in this 
document.

Note: Newer AC power supplies do not have power switches. Switchless power supplies power on 
when connected to a power source, and power off when disconnected.

 l Generally, when powering up, make sure to power up the RAID and/or expansion chassis and 
associated data host in the following order:

 l Expansion chassis first

This ensures that the drives in the expansion chassis have enough time to completely spin up 
(HDDs) before being scanned by the controller I/O modules within the RAID chassis.

While expansion chassis power up, their LEDs blink. After the LEDs stop blinking and no LEDs on 
the front and rear of the expansion chassis are amber, the power-on sequence is complete, and no 
faults have been detected. See LEDs for 56-Drive RAID Chassis (4U56) on page 175 for 
descriptions of LED behavior.

 l RAID chassis next

Depending upon the number and type of drives in the system, it may take several minutes for the 
system to become ready.

 l Data host last (if powered down for maintenance purposes).

Note: Generally, when powering off, you will reverse the order of steps used for powering on.

4U56 System
The 4U56 system uses two redundant AC power supplies (Figure 84 on the next page), each of which is 
controlled by a power switch mounted on the chassis (beneath the power supply). Figure 84 on the next 
page shows the face of an AC power supply module as it appears when viewing the rear panel of the 4U 
chassis. Connection of the power cable to the rack power source is also shown.
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Figure 84: QXS-5600 AC power supply with power switch

Power Cycling Procedures
Power cycling procedures vary according to the type of power supply included within the chassis. 

 l For RAID chassis and expansion chassis configured with switchless AC power supplies, refer to the 
procedure described in AC Power Supply below. 

 l For procedures pertaining to a) RAID chassis configured with DC power supplies, or b) previously 
installed expansion chassis featuring power switches, see DC  Power Supplies with Power Switch on 
page 89.

AC Power Supply
RAID chassis and expansion chassis configured with switchless power supplies rely on the power cord for 
power cycling. Power-on the chassis by connecting the cord from the power supply power cord connector to 
the appropriate power source; power-off the chassis by disconnecting the cord from the power source. 
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Figure 85: AC power supply

1

1. Power cord connect

Powering On/Off the System (Switchless Power Supplies)
To power on the system:

1. Plug the power cord into the power cord connector on the rear of the expansion chassis. Plug the other 
end of the power cord into the rack power source (see Figure 85 above and Figure 86 on the next page). 
Wait several seconds to allow the drives to spin up (HDDs).

Repeat this sequence for each switchless power supply within each expansion chassis.

2. Plug the power cord into the power cord connector on the rear of the RAID chassis. Plug the other end 
of the power cord into the rack power source (see Figure 85 above and Figure 86 on the next page). 

Repeat the sequence for the  other switchless power supply.



Chapter 2: Installing the Chassis
Power On/Power Off

QX and QXS Setup Guide 89

Figure 86: AC power cord

To power off the system:

1. Stop all I/O from hosts to the system (see Stopping I/O on page 132).

2. Shut down both controllers using either method described below:

 l Use the Disk Storage Management Utility to shut down both controllers, as described in the QXS 
StorageDisk Storage Management Utility Users Guide.

Proceed to Step 3.

 l Use the CLI to shut down both controllers, as described in the QXS StorageCLI Reference Guide.

3. Disconnect the power cord’s male plug from the power source.

4. Disconnect the power cord’s female plug from the power cord connector on the power supply.

DC  Power Supplies with Power Switch
Note: Refer to Figure 84 on page 87 to see an illustration of the 4U56 AC power supply (with a switch). 

A DC power supply equipped with a power switch is shown below.
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Figure 87: DC power supply with power switch

12

1. DC power switch

2. DC power cable connect

Note: See Electrical Requirements on page 195 for additional information.

DC Model
Figure 88: DC power cable featuring D-shell and lug connectors

1. Locate and use the provided DC power cables.

2. Verify that the chassis power switches are in the Off position.

3. Connect a DC power cable to each DC power supply using the D-shell connector. Use the UP> arrow 
on the connector shell to ensure proper positioning (see adjacent left side view of D-shell connector).



Chapter 2: Installing the Chassis
Power On/Power Off

QX and QXS Setup Guide 91

4. Tighten the screws at the top and bottom of the shell, applying a torque between 1.7 N-m (15 in-lb) and 
2.3 N-m (20 in-lb), to securely attach the cable to the DC power supply.

5. To complete the DC connection, secure the other end of each cable wire component of the DC power 
cable to the target DC power source.

Check the three individual DC cable wire labels before connecting each cable wire lug to its power 
source. One cable wire is labeled ground (GND), and the other two are labeled positive (+L) and 
negative (-L) (shown in Figure 88 on the previous page).

Caution: Connecting to a DC power source outside the designated -48VDC nominal range (-
36VDC to -72VDC) may damage the chassis.

AC Power Supplies with Power Switch
Note: Refer to Figure 84 on page 87 to see an illustration of the QXS-5600 AC power supply (with a 
switch). The QXS-5600 does not use a DC power supply.

An AC power supply equipped with a power switch is shown below.
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Figure 89: AC power supply with power switch

1

2

1. AC power switch

2. AC power cord connect

Note: See Electrical Requirements on page 195 for additional information.

AC Model
1. Verify that the chassis power switches are in the Off position.

2. Identify the power cord connector on the power supply, and locate the target power source.

3. Using the AC power cords provided, plug one end of the cord into the power cord connector on the 
power supply. Plug the other end of the power cord into the rack power source.

4. Verify connection of primary power cords from the rack to separate external power sources.

Power Cycle
To power on the system:

1. Power up the expansion chassis by pressing the power switches at the rear of each unit to the On 
position. Allow several seconds for drives to spin up (HDDs).

2. Power up the RAID chassis next by pressing the power switches at the rear of the unit to the On 
position.

To power off the system:

1. Stop all I/O from hosts to the system (see Stopping I/O on page 132).

2. Shut down both controllers using either method described below:
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 l Use the Disk Storage Management Utility to shut down both controllers, as described in the QXS 
StorageDisk Storage Management Utility Users Guide.

Proceed to Step 3.

 l Use the CLI to shut down both controllers, as described in the QXS StorageCLI Reference Guide.

3. Press the power switches at the rear of the RAID chassis to the Off position.

4. Press the power switches at the rear of each expansion chassis to the Off position.
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Host System Requirements
Depending on your system configuration, host operating systems may require that multipathing is 
supported. 

If fault tolerance is required, then multipathing software may be required. Host-based multipath software 
should be used in any configuration where two logical paths between the host and any storage volume may 
exist at the same time. This would include most configurations where there are multiple connections to the 
host or multiple connections between a switch and the storage.

Use native Microsoft MPIO DSM support with Windows Server 2008 and Windows Server 2012. Use either 
the Server Manager or the command-line interface (mpclaim CLI tool) to perform the installation.

QX and QXS Setup Guide 94
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Cabling Considerations
Common cabling configurations address hosts, RAID chassis, drive expansion chassis, and switches. Host 
interface ports on the RAID chassis (controllers) can connect to respective hosts via direct-attach or switch-
attach.

Cabling systems to enable use of the optional feature—to replicate volumes—is yet another important 
cabling consideration.

Connect the Chassis to Hosts
A host identifies an external port to which the storage system is attached. The external port may be a port in 
an I/O adapter (such as an FC HBA) in a server. Cable connections vary depending on configuration. This 
section describes host interface protocols supported by QXS Storage RAID chassis, while showing a few 
common cabling configurations.

Note: The QXS Storage controllers use Unified LUN Presentation (ULP), a controller feature enabling 
a host to access mapped volumes through any controller host port.

ULP can show all LUNs through all host ports on both controllers, and the interconnect information is 
managed by the controller firmware. ULP appears to the host as an active-active storage system, allowing 
the host to select any available path to access the LUN, regardless of disk group ownership.

Note: See “Configuring the system > Using the Configuration Wizard” in the QXS Storage Disk 
Storage Management Utility Users Guide (V2 or V3) to initially configure the system or change system 
configuration settings (for example, Configuring host ports).

CNC Technology
The QXS-3, QXS-4, and QXS-6 Series storage use Converged Network Controller technology, allowing 
you to select the desired host interface protocol(s) from the available FC or iSCSI host interface protocols 
supported by the system. The small form-factor pluggable (SFP transceiver or SFP) connectors used in 
CNC ports are further described in the subsections below.

Note: Controller modules are not shipped with pre-installed SFPs. Within your product kit, you will 
need to locate the qualified SFP options, and install them into the CNC ports.

Use the set host-port-mode CLI command to set the host interface protocol for CNC ports using 
qualified SFP options. The QXS-3, QXS-4, and QXS-6 Series storage ship with CNC ports configured for 
FC. When connecting CNC ports to iSCSI hosts, you must use the CLI (not the disk management utility) to 
specify which ports will use iSCSI. It is best to do this before inserting the iSCSI SFPs into the CNC ports.

Note: Refer to iSCSI Considerations on page 105 for additional information.
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The QXS-3, QXS-4, and QXS-6 Series storage support the optionally-licensed replication feature. Whereas 
linear storage supports FC and iSCSI host interface protocols for replication, virtual storage supports iSCSI 
host interface protocol for replication. Both linear and virtual storage support all qualified CNC options for 
host connection.

FC Protocol
FC protocol is suported on the following systems: 

 l QXS-312 and QXS-324

 l QXS-412, QXS-424, QXS-448, and QXS-456

 l QXS-648 and QXS-656

 l QXS-1200, QXS-2400, and QXS-5600

The  RAID chassis use FC interface protocol for host port connection, featuring two controller I/O modules. 
Each controller I/O module provides host ports configured with an FC SFP transceiver connector, 
supporting data rates up to 16 Gbit/s. When configured with FC SFPs, these RAID chassis can also be 
cabled to support the optionally-licensed replication feature (linear storage only) via the FC ports.

 The controller supports Fibre Channel Arbitrated Loop (public or private) or point-to-point topologies. Loop 
protocol can be used in a physical loop or in a direct connection between two devices. Point-to-point protocol 
is used to connect to a fabric switch. 

 Point-to-point protocol can also be used for direct connection, and it is the only option supporting direct 
connection at 16 Gbit/s. See the set host-parameters command within the QX and QXS CLI 
Reference Guide (Doc #: 6-68385-01) for command syntax and details about parameter settings relative to 
supported link speeds.

Fibre Channel ports are used in either of two capacities:

 l To connect two storage systems through a Fibre Channel switch for use of replication (linear storage 
only).

 l For attachment to FC hosts directly, or through a switch used for the FC traffic.

The first usage option requires valid licensing for the AssuredRemote replication feature, whereas the 
second option requires that the host computer supports FC and optionally, multipath I/O.

Note: Use the Disk Storage Management Utility‘s Configuration Wizard to set FC port options. Use the 
set host-parameters CLI command to set FC port options, and use the show ports CLI command 
to view information about host ports.

10GbE iSCSI protocol
The QXS-3, QXS-4, and QXS-6 Series storage RAID chassis support two controller I/O modules using the 
Internet SCSI interface protocol for host connection. Each controller I/O  module provides four host ports 
designed for use with a 10GbE iSCSI SFP supporting data rates up to 10 Gbit/s, using either one-way or 
mutual CHAP (Challenge-Handshake Authentication Protocol).
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See the topics about Configuring CHAP, and CHAP and replication in the disk management utility (V3).

Note: Use the disk management utility to set iSCSI port options. Within the disk management utility 
(V3), see “Configuring host ports.” Use the set host-parameters CLI command to set iSCSI port 
options, and use the show ports CLI command to view information about host ports.

The 10GbE iSCSI ports are used in either of two capacities:

 l To connect two storage systems through a switch for use of replication.

 l For attachment to 10GbE iSCSI hosts directly, or through a switch used for the 10GbE iSCSI traffic.

The first usage option requires valid licensing for the replication feature, whereas the second option requires 
that the host computer supports Ethernet, iSCSI, and optionally, multipath I/O.

1 Gb iSCSI protocol
The QXS-3, QXS-4, and QXS-6 Series storage RAID chassis support two controller modules using the 
Internet SCSI interface protocol for host port connection. Each controller module provides four iSCSI host 
ports configured with an RJ-45 SFP supporting data rates up to 1 Gbit/s, using either one-way or mutual 
CHAP.

See the topics about Configuring CHAP, and CHAP and replication in the disk management utility (V3).

Note: Use the disk management utility to set iSCSI port options. Within the disk management utility 
(V3), see “Configuring host ports.” Use the set host-parameters CLI command to set iSCSI port 
options, and use the show ports CLI command to view information about host ports.

The 1GbE iSCSI ports are used in either of two capacities:

 l To connect two storage systems through a switch for use of replication.

 l For attachment to 1GbE iSCSI hosts directly, or through a switch used for the 1GbE iSCSI traffic.

The first usage option requires valid licensing for the replication feature, whereas the second option requires 
that the host computer supports Ethernet, iSCSI, and optionally, multipath I/O.

HD mini-SAS technology
The QXS-3, QXS-4, and QXS-6 Series storage RAID chassis use high-density mini-SAS (Serial Attached 
SCSI) interface protocol for host connection.

12 Gb HD mini-SAS ports
Each controller I/O module provides four SFF-8644 HD mini-SAS host ports supporting data rates up to 12 
Gbit/s. HD mini-SAS host ports connect to hosts or switches; they are not used for replication. Use a 
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qualified SFF-8644 to SFF-8644 cable option when connecting to a 12 Gbit/s host. Use a qualified SFF-
8644 to SFF-8088 option when connecting to a supported 6 Gbit/s host.

Connecting Direct Attach Configurations
Table 8 below provides the available Hybrid QXS Supported Configurations. 

Product Chassis Max Chassis Max Drives

QXS-312 2U12 4 48

QXS-324 2U24 4 96

QXS-412 2U12 8 96

QXS-424 2U24 8 192

QXS-448 2U48 4 192

QXS-456 4U56 (4) & 2U12 (2) 6 248

QXS-648 2U48 4 192

QXS-656 4U56 (4) & 2U12 (2) 8 248

Note 1: Always consider the max drive number when mixing different chassis combinations.

Note 2: It is impossible to identify all possible chassis combinations within the hybrid QXS supported 
configurations.

Table 8: Available QXS Systems 

Connect appropriate cables from the server’s HBAs to the controller module’s host ports as described 
below, and shown in the following illustrations.

Fibre Chanel Host Connection
To connect to the QXS-3, QXS-4, and QXS-6 Series storage RAID chassis supporting (4/8/16 Gb) FC host 
interface ports to a server HBA or switch—using the controller’s CNC ports—select a qualified FC SFP 
option.

Qualified options support cable lengths of 1 m (3.28'), 2 m (6.56'), 5 m (16.40'), 15 m (49.21'), 30 m (98.43'), 
and 50 m (164.04') for OM4 multimode optical cables and OM3 multimode FC cables, respectively. A 0.5 m 
(1.64') cable length is also supported for OM3. In addition to providing host connection, these cables are 
used for connecting a local storage system to a remote storage system via a switch, to facilitate use of the 
optional replication feature.
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10GbE iSCSI Host Connection
To connect to the QXS-3, QXS-4, and QXS-6 Series storage RAID chassis supporting 10GbE iSCSI host 
interface ports to a server HBA or switch—using the controller’s CNC ports—select a qualified 10GbE SFP 
option.

Qualified options support cable lengths of 0.5 m (1.64'), 1 m (3.28'), 3 m (9.84'), 5 m (16.40'), and 7 m 
(22.97') for copper cables; and cable lengths of 0.65 m (2.13'), 1 m (3.28'), 1.2 m (3.94'), 3 m (9.84'), 5 m 
(16.40'), and 7 m (22.97') for direct attach copper (DAC) cables. In addition to providing host connection, 
these cables are used for connecting a local storage system to a remote storage system via a switch, to 
facilitate use of the optional replication feature.

1GbE iSCSI Host Connection
To connect to the QXS-3, QXS-4, and QXS-6 Series storage RAID chassis supporting 1Gb iSCSI host 
interface ports to a server HBA or switch—using the controller’s CNC ports—select a qualified 1 Gb RJ-45 
copper SFP option supporting (CAT5-E minimum) Ethernet cables of the same lengths specified for 10GbE 
iSCSI above. 

In addition to providing host connection, these cables are used for connecting a local storage system to a 
remote storage system via a switch, to facilitate use of the optional AssuredRemote replication feature.

HD mini-SAS Host Connection
To connect to the QXS-3, QXS-4, and QXS-6 Series storage RAID chassis supporting HD mini-SAS host 
interface ports to a server HBA or switch—using the controller’s SFF-8644 dual HD mini-SAS host ports—
select a qualified HD mini-SAS cable option. 

A qualified SFF-8644 to SFF-8644 cable option is used for connecting to a 12 Gbit/s enabled host; whereas 
a qualified SFF-8644 to SFF-8088 cable option is used for connecting to a 6 Gbit/s host. Qualified SFF-8644 
to SFF-8644 options support cable lengths of 0.5 m (1.64'), 1 m (3.28'), 2 m (6.56'), and 4 m (13.12'). 
Qualified SFF-8644 to SFF-8088 options support cable lengths of 1 m (3.28'), 2 m (6.56'), 3 m (9.84'), and 4 
m (13.12').

Note: Supported qualified cable options for host connection are subject to change.

Dual-controller Configurations
Caution: All QXS Storage configurations are dual-controller. Single-controller support is provided only 
when a controller fails over to its partner controller. A controller module must be installed in each IOM 
slot to ensure sufficient airflow through the chassis during operation.

Dual-controller configurations improve application availability because, in the event of a controller failure, the 
affected controller fails over to the partner controller with little interruption to data flow. 
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A failed controller can be replaced without the need to shut down the storage system.

In a dual-controller system, hosts use LUN-identifying information from both controllers to determine that up 
to four paths are available to a given storage volume. Assuming MPIO software is installed, a host can use 
any available data path to access a volume owned by either controller. 

The path providing the best performance is through host ports on the volume’s owning controller. Both 
controllers share one set of 1,024 LUNs (0-1,023) for use in mapping volumes to hosts (see “ULP” in the 
StorNext QXS Storage Disk Storage Management Utility Users Guide).

Dual-controller Connections to Hosts
This section provides representative illustrations of connections to hosts. 
 l The 12-, 24-, and 48-drive systems are all similar when viewing the systems from the rear.
 l The QXS-312 and QXS-324 systems have only two host ports on each controller I/O module.
 l The QXS-412, QXS-424, QXS-448, QXS-456, QXS-648, and QXS-656 systems have only four host 

ports on each controller I/O module.

12-, 24-, and 48-Drive Systems
This section provides representative illustrations of 12-, 24-, and 48-drive systems connections to hosts.

Figure 90: Connecting hosts: One server and one HBA, dual path
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Figure 91: Connecting hosts: Two servers and one HBA per server, dual path
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Figure 92: Connecting hosts: Four servers and one HBA per server, dual path
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56-Drive System
This section provides representative illustrations connections to hosts.

Figure 93: Connecting hosts: direct attach—one server/one HBA/dual path
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Figure 94: Connecting hosts: direct attach—two servers/one HBA per server/dual path
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Figure 95: Connecting hosts: direct attach—four servers/one HBA per server/dual path

 

Connecting Switch Attach Configurations
A SAN places a switch between the servers and the RAID chassis (controllers). Using switches, a SAN 
shares a storage system among multiple servers, reducing the number of storage systems required for a 
particular environment. Using switches increases the number of servers that can be connected to the 
storage system. A QXS Storage RAID chassis supports 64 hosts.

Multiple Servers/Multiple Switches
Model-specific dual-controller illustrations in Figure 98 on page 104 and Figure 96 on the next page show 
switch-connect configurations for QXS Storage RAID chassis supporting pertinent host interface protocols. 

Connect appropriate cables from controller host ports to switch ports, and from switch ports to hosts. It is 
important to have a least one port connected from each switch to each controller module to provide 
redundancy.
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12-, 24-, and 48-Drive Systems
Figure 96 below provides a representative illustration of the12-, 24-, and 48-Drive Systems with multiple 
servers/switches.

Figure 96: Connecting hosts: Switch attach: multiple servers/switches
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Figure 96 above provides a representative illustration of the12-, 24-, and 48-Drive Systems with four 
servers/multiple switches/SAN fabric.

Figure 97: Connecting hosts: four servers/multiple switches/SAN fabric
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56-Drive System
Figure 98 below provides a representative illustration of the 56-drive system with multiple servers/switches.

Figure 98: Connecting hosts: Switch attach: multiple servers/switches

Figure 99 on the next page provides a representative illustration of the QXS-5600 system with four 
servers/multiple switches/SAN fabric.
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Figure 99: Connecting hosts: Switch attach: four servers/multiple switches/SAN fabric

iSCSI Considerations
This section provides information as follows:

 l QXS-312 and QXS-324 iSCSI Considerations below

 l QXS-412, QXS-424, QXS-448, QXS-456, QXS-648, and QXS-656 iSCSI Considerations on the next 
page

QXS-312 and QXS-324 iSCSI Considerations
When installing a QXS-312 or QXS-324 iSCSI RAID chassis, use at least three ports per server—two for 
the storage LAN, and one of more for the public LAN(s)—to ensure that the storage network is isolated from 
the other networks. The storage LAN is the network connecting the servers—via switch attach—to the 
RAID chassis.

IP address scheme for the controller pair — two iSCSI ports per controller
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The RAID chassis can use port 0 of each controller as one failover pair, and port 1 of each controller as a 
second failover pair. Port 0 of each controller must be in the same subnet, and port 1 of each controller must 
be in second subnet.

For example (with a netmask of 255.255.255.0):

 l Controller A port 0: 10.10.10.100

 l Controller A port 1: 10.11.10.120

 l Controller B port 0: 10.10.10.110

 l Controller B port 1: 10.11.10.130

In addition to setting the port-specific options described above, you can view settings using the GUI.

 l If using the V3 disk management utility, in the System topic, select Action > Set Up Host Ports.

 o The Host Ports Settings panel opens, allowing you to access host connection settings.

 l If using V2 disk management utility, in the Configuration View panel, right-click the system and select 
Configuration > System Settings > Host Interfaces.

 o The Configure Host Interface panel opens, allowing you to access host connection settings.

QXS-412, QXS-424, QXS-448, QXS-456, QXS-648, and QXS-656 
iSCSI Considerations
When installing a QXS-4 or QXS-6 Series RAID chassis, use at least three ports per server—two for the 
storage LAN, and one of more for the public LAN(s)—to ensure that the storage network is isolated from the 
other networks. The storage LAN is the network connecting the servers—via switch attach—to the RAID 
chassis.

IP address scheme for the controller pair — two iSCSI ports per controller

The RAID chassis can use port 2 of each controller as one failover pair, and port 3 of each controller as a 
second failover pair for the iSCSI traffic. Port 2 of each controller must be in the same subnet, and port 3 of 
each controller must be in second subnet.

For example (with a netmask of 255.255.255.0):

 l Controller A port 2: 10.10.10.100

 l Controller A port 3: 10.11.10.120

 l Controller B port 2: 10.10.10.110

 l Controller B port 3: 10.11.10.130

The RAID chassis can use port 0 of each controller as one failover pair, and port 1 of each controller as a 
second failover pair. Port 0 of each controller must be in the same subnet, and port 1 of each controller must 
be in second subnet.

For example (with a netmask of 255.255.255.0):
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 l Controller A port 0: 10.10.10.100

 l Controller A port 1: 10.11.10.120

 l Controller B port 0: 10.10.10.110

 l Controller B port 1: 10.11.10.130

IP address scheme for the controller pair — four iSCSI ports per controller

When all CNC ports are configured for iSCSI, the scheme is similar to the one described for two-ports 
above. 

For example (with a netmask of 255.255.255.0):

 l Controller A port 0: 10.10.10.100

 l Controller A port 1: 10.11.10.120

 l Controller A port 2: 10.10.10.110

 l Controller A port 3: 10.11.10.130

 l Controller B port 0: 10.10.10.140

 l Controller B port 1: 10.11.10.150

 l Controller B port 2: 10.10.10.160

 l Controller B port 3: 10.11.10.170

In addition to setting the port-specific options described above, you can view settings using the GUI.

 l If using the V3 disk management utility, in the System topic, select Action > Set Up Host Ports.

 o The Host Ports Settings panel opens, allowing you to access host connection settings.

 l If using V2 disk management utility, in the Configuration View panel, right-click the system and select 
Configuration > System Settings > Host Interfaces.

 o The Configure Host Interface panel opens, allowing you to access host connection settings.

Change the CNC port mode
This subsection applies to QXS-3, QXS-4, and QXS-6 Series models only. While the USB cable is still 
connected and the terminal emulator session remains active, perform the following steps to change the 
CNC port mode from the default setting (FC), to either iSCSI or FC-and-iSCSI used in combination.

When using FC SFPs and iSCSI SFPs in combination, host ports 0 and 1 are set to FC (either both 16 
Gbits/s or both 8 Gbit/s), and host ports 2 and 3 must be set to iSCSI (either both 10GbE or both 1 Gbit/s).

Set CNC port mode to iSCSI
To set the CNC port mode for use with iSCSI SFPs, run the following command at the command prompt:
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set host-port-mode iSCSI

The command notifies you that it will change host port configuration, stop I/O, and restart both controllers. 
When asked if you want to continue, enter y to change the host port mode to use iSCSI SFPs. 

Once the set host-port-mode command completes, it will notify you that the specified system host port 
mode was set, and that the command completed successfully.

When you are done using the CLI, exit the emulator.

Set CNC port mode to FC and iSCSI
To set the CNC port mode for use with FC SFPs and iSCSI SFPs in combination, run the following 
command at the command prompt:

set host-port-mode FC-and-iSCSI

The command notifies you that it will change host port configuration, stop I/O, and restart both controllers. 
When asked if you want to continue, enter y to change the host port mode to use FC and iSCSI SFPs.

Once the set host-port-mode command completes, it will notify you that the specified system host port 
mode was set, and that the command completed successfully.

When you are done using the CLI, exit the emulator.

Configure the system
After using either of the CLI command sequences shown above, you may see events stating that the SFPs 
installed are not compatible with the protocol set for the host ports. The new host port mode setting will be 
synchronized with the qualified SFP option once the controller modules restart.

See Appendix E—SFP option for CNC ports for instructions about locating and installing your qualified SFP 
transceivers within the CNC ports.

After changing the CNC port mode, you can invoke the disk management utility (V3 or V2), and use the 
Configuration Wizard to initially configure the system, or change system configuration settings.

 

Connect a Management Host on the Network
The management host directly manages storage systems out-of-band over an Ethernet network. 

1. Connect an RJ-45 Ethernet cable to the network port on each controller.

2. Connect the other end of each Ethernet cable to a network that your management host can access 
(preferably on the same subnet).

3. Do not interconnect iSCSI and management Ethernet on the same network.



Chapter 3: Connecting Hosts
Connect Two Storage Systems to Replicate Volumes

QX and QXS Setup Guide 109

Note: Connections to this device must be made with shielded cables grounded at both ends with 
metallic RFI/EMI connector hoods in order to maintain compliance with NEBS and FCC Rules and 
Regulations, see the Quantum Product Regulatory Compliance and Safety document.

Connect Two Storage Systems to Replicate 
Volumes
Replication is a licensed feature for disaster recovery, providing access to either of the following software 
product versions:

 l V3 disk management utility supports replication for virtual storage environments.

 l V2 disk management utility supports replication for linear storage environments.

Note: These two replication models are mutually exclusive to one another. Choose the method that 
applies to your storage system. For more information, see replication topics in the disk management 
utility.

The replication feature performs asynchronous replication of block-level data from a volume in a primary 
system to a volume in a secondary system by creating an internal snapshot of the primary volume, and 
copying the snapshot data to the secondary system via FC (linear storage only) or iSCSI links.

The two associated standard volumes form a replication set, and only the primary volume (source of data) 
can be mapped for access by a server. Both systems must be licensed to use the replication feature, and 
must be connected through switches to the same fabric or network (i.e., no direct attach). The server 
accessing the replication set need only be connected to the primary system. If the primary system goes 
offline, a connected server can access the replicated data from the secondary system.

Replication configuration possibilities are many, and can be cabled—in switch attach fashion—to support 
the CNC-based systems on the same network, or on physically-split networks (SAS systems do not support 
replication). As you consider the physical connections of your system—specifically connections for 
replication—keep several important points in mind:

 l Ensure that controllers have connectivity between systems, whether local or remote.

 l Whereas linear storage supports FC and iSCSI host interface ports for replication, virtual storage 
supports iSCSI host interface ports for replication. Both linear and virtual storage support all qualified 
CNC options for host connection.

 l If using the RAIDar (v2) user interface, be sure of the desired link type before creating the linear 
replication set, because you cannot change the replication link type after creating the replication set.

 l Assign specific ports for replication whenever possible. By specifically assigning ports available for 
replication, you free the controller from scanning and assigning the ports at the time replication is 
performed.

 l Ensure that all ports assigned for replication are able to communicate appropriately with the replication 
system (see the CLI Reference Guide for more information):
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 l For linear replication, use the verify remote-link command.

 l For virtual replication, use the query peer-connection command.

 l Allow two ports to perform replication. This permits the system to balance the load across those ports as 
I/O demands rise and fall. On dual-controller RAID chassis, if some of the volumes replicated are owned 
by controller A and others are owned by controller B, then allow at least one port for replication on each 
controller module—and possibly more than one port per controller module—depending on replication 
traffic load.

 l For the sake of system security, do not unnecessarily expose the controller module network port to an 
external network connection.

Conceptual cabling examples are provided addressing cabling on the same network and cabling relative to 
physically-split networks. Both single and dual-controller CNC environments support replication. The 
cabling examples provided apply to linear replication and virtual replication.

Note: Controller module firmware must be compatible on all systems used for replication. For license 
information, see the disk management utility.

Cabling for Replication
This section shows example replication configurations for CNC-based RAID chassis. The following 
illustrations provide conceptual examples of cabling supporting linear replication and virtual replication. Blue 
cables show I/O traffic and green cables show replication traffic.

Note: Simplified versions of RAID chassis are used in cabling illustrations to show either FC or iSCSI 
host interface protocol, given that only the external connectors used in the host interface ports differ.

 l Cabling for replication diagrams pertain to linear replication and virtual replication.

 o Linear replication supports FC and iSCSI host interface protocols.

 o Virtual replication supports iSCSI host interface protocol.

 l The 2U chassis rear panel view represents 24- and 48-drive models.

 o The rear panel layouts for the two chassis are nearly identical.

 o PSUs may or may not be equipped with a power switches.

 l The 4U chassis rear panel view represents 56-drive models.

Once the CNC systems are physically cabled, see the V3 disk management utility or online help for 
information about configuring, provisioning, and using the optional replication feature. Refer to the 
replication feature topic pertaining to your environment (linear replication or virtual replication).

QXS-3 Series CNC Ports and Replication
CNC controller modules can use qualified SFP options of the same type, or they can use a combination of 
qualified SFP options supporting different host interface protocols. If you use a combination of different 
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protocols, then CNC ports 0 and 1 must be set to FC (either both 16 Gbit/s or both 8 Gbit/s), and CNC ports 
2 and 3 must be set to iSCSI (either both 10GbE or both 1 Gbit/s).

In linear storage environments  (V2 disk management utility), each CNC port can perform I/O or replication. 
In combination environments, one interface—for example FC—might be used for I/O, and the other 
interface type—10GbE or 1 Gb iSCSI—might be used for replication. In virtual storage environments  (V3 
disk management utility), each CNC port can perform I/O, but replication traffic is supported by iSCSI host 
interface ports (either both 10GbE or both 1 Gbit/s).

Multiple Servers/One Switch/One Location
This section provides information on the rear panel of two RAID chassis with both I/O and replication 
occurring on the same physical network.

Figure 100: Multiple Servers/One Switch/One Location
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Multiple Servers/Two Switches/One Location
This section provides information on the CNC host interface connections and CNC-based replication, with 
I/O and replication occurring on different networks. For optimal protection, use two switches. Connect one 
port from each controller module to the first switch to facilitate I/O traffic, and connect one port from each 
controller module to the second switch to facilitate replication. Using two switches in tandem avoids the 
potential single point of failure inherent to using a single switch; however, if one switch fails, either I/O or 
replication will fail, depending on which of the switches fails.

Figure 101: Multiple Servers/Two Switches/One Location
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Multiple Servers/Multiple Switches/Two Locations
Virtual Local Area Network (VLAN) and zoning can be employed to provide separate networks for iSCSI 
and FC, respectively. Whether using a single switch or multiple switches for a particular interface, you can 
create a VLAN or zone for I/O and a VLAN or zone for replication to isolate I/O traffic from replication traffic. 
Since each switch would include both VLANs or zones, the configuration would function as multiple 
networks.

Figure 102: Multiple Servers/Multiple Switches/Two Locations
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Note: Although not shown in the preceding cabling examples, you can cable replication-enabled QXS-
3 Series systems and compatible QXS-4 Series systems—via switch attach—for performing replication 
tasks.

QXS-4 and QXS-6 Series CNC Ports and Replication
CNC controller modules can use qualified SFP options of the same type, or they can use a combination of 
qualified SFP options supporting different host interface protocols. If you use a combination of different 
protocols, then CNC ports 0 and 1 must be set to FC (either both16 Gbit/s or both 8 Gbit/s), and CNC ports 
2 and 3 must be set to iSCSI (either both 10GbE or both 1 Gbit/s).

In linear storage environments (V2 disk management utility), each CNC port can perform I/O or replication. 
In combination environments, one interface—for example FC—might be used for I/O, and the other 
interface type—10GbE or 1 Gb iSCSI—might be used for replication. In virtual storage environments (V3 
disk management utility), each CNC port can perform I/O, but replication traffic is supported by iSCSI host 
interface ports (either both 10GbE or both 1 Gbit/s).

Each of the following diagrams show the rear panel of two RAID chassis equipped with dual-controller I/O 
modules.

Note: Whereas linear storage supports FC and iSCSI host interface protocols for replication, virtual 
storage supports iSCSI host interface protocol for replication. Both linear and virtual storage support all 
qualified CNC options for host connection.
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Multiple Servers/One Switch/One Location
This section provides information on the rear panel of two RAID chassis with both I/O and replication 
occurring on the same physical network.

Figure 103: Multiple Servers/One Switch/One Location (2U) 
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Figure 104: Multiple Servers/One Switch/One Location (4U) 
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Multiple Servers/Two Switches/One Location
This section provides information on the CNC host interface connections and CNC-based replication, with 
I/O and replication occurring on different networks. For optimal protection, use two switches. Connect two 
ports from each controller module to the first switch to facilitate I/O traffic, and connect two ports from each 
controller module to the second switch to facilitate replication. Using two switches in tandem avoids the 
potential single point of failure inherent to using a single switch; however, of one switch fails, either I/O or 
replication will fail, depending on which of the switches fails.
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Figure 105: Multiple Servers/Two Switches/One Location (2U) 
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Figure 106: Multiple Servers/Two Switches/One Location (4U) 
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Multiple Servers/Two Switches/Two Locations
Virtual Local Area Network (VLAN) and zoning can be employed to provide separate networks for iSCSI 
and FC, respectively. Whether using a single switch or multiple switches for a particular interface, you can 
create a VLAN or zone for I/O and a VLAN or zone for replication to isolate I/O traffic from replication traffic. 
Since each switch would include both VLANs or zones, the configuration would function as multiple 
networks.

This section provides information on the rear panel of two RAID chassis with I/O and replication occurring on 
different networks.
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Figure 107: Multiple Servers/Two Switches/Two Locations (2U) 
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Figure 108: Multiple Servers/Two Switches/Two Locations (4U) 
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Multiple Servers/SAN Fabric/Two Locations
This section provides information on the rear-panel of two RAID chassisr with both I/O and replication 
occurring on different networks. 

This diagram represents two branch offices cabled to enable disaster recovery and backup. In case of failure 
at either the local site or the remote site, you can fail over the application to the available site.
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Figure 109: Multiple Servers/SAN Fabric/Two Locationss (4U) 

6Gb/s

6Gb/s

S

S
A

S

S
A 6Gb/s

6Gb/s

S

S
A

S

S
A

Peer sites with failover

Key — Server Codes:

= "A" File servers

Data Restore Modes:

- Replicate back over WAN

- Replicate via physical media transfer

Failover Modes

- VMware

- Hyper V failover to servers

A1

A2

B2

A1

B1

A2

B2

A1

B1

A1

A2

B1

B2

= "A" Application serversA2

= "B" File serversB1

= "B" Application serversB2

Remote site “B”Remote site “A”

Corporate
end-users

Corporate
end-users

LAN LAN

WAN

Ethernet

S AN

FC

S AN

FC

data

F S  “A”

data

App “A”

replica

App “B”
replica

F S  “B”

replica

F S  “A”
replica

App “A”

data

F S  “B”
data

App “B”

4824/4834/4844 storage
system (typ. 2 places)

Although not shown in the preceding cabling examples, you can cable replication-enabled QXS-4 Series 
systems and compatible QXS-3 Series systems—via switch attach—for performing replication tasks.

QXS-6 Series systems can only support cable replication-enabled QXS-6 Series systems.
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Update Firmware
Caution: Upgrades from a system running Gx105 firmware to the latest firmware requires two steps. 
1. Upgrade from Gx105 to Gx210. 
2. Upgrade from Gx210 to latest release.

Important Firmware Notes 
Always update controller firmware when: 

 l Installing a new system 

 l Adding drive expansion(s) 

 l Replacing a controller I/O module(s) or expansion I/O module(s) 

Note: Updating controller firmware with expansion I/O modules active ensures that the controller 
firmware and expansion I/O modules firmware are at a compatible level. 

Verifying Firmware 
After installing the hardware and powering on the storage system components for the first time, verify that 
the controller modules, expansion modules, and drives are using the current firmware release. 

 l If using Disk Storage Management Utility (V3), in the System topic, select Action > Update Firmware.

The Update Firmware panel opens. The Update Controller Module tab shows versions of firmware 
components currently installed in each controller.

Note: The Disk Management Utility (V3) does not provide a check-box for enabling or disabling 
Partner Firmware Update for the partner controller. To enable or disable the setting, use the set 
advanced-settings command, and set the partner-firmware-upgrade parameter. See the CLI 
Reference Guide for more information about command parameter syntax.

 l If using the Disk Storage Management Utility (V2), right-click the system in the Configuration View 
panel, and select Tools > Update Firmware. 

The Update Firmware panel displays the currently installed firmware versions and allows you to update 
them. 

Optionally, you can update firmware using FTP as described in the QXS Storage CLI Reference Guide or 
QXS Storage Disk Storage Management Utility Users Guide (V2 or V3).
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Obtaining IP Values
You can configure addressing parameters for each controller module’s network port. You can set static IP 
values or use DHCP.

Note: See the “Configuring network ports” topic in the QXS Storage Disk Storage Management Utility 
Users Guide (V2 or V3).

Setting Network Port IP Addresses Using DHCP
In DHCP mode, network port IP address, subnet mask, and gateway values are obtained from a DHCP 
server if one is available. If a DHCP server is unavailable, current addressing is unchanged. You must have 
a means of determining what addresses have been assigned, such as the list of bindings on the DHCP 
server.

Because DHCP is disabled by default in QXS Storage systems, you must either use the CLI to change 
controller IP address settings or use Disk Storage Management Utility’s Configuration Wizard as described 
in the Using the Configuration Wizard topic in the QXS Storage Disk Storage Management Utility Users 
Guide (V2 or V3).

Setting Network Port IP Addresses Using the CLI
If you did not use DHCP to set network port IP values, set them manually (default method) as described 
below. If you are using the USB CLI port and cable, you will need to enable the port for communication. 

Network ports on controller module A and controller module B are configured with the following default 
values:

 l Network port IP address: 10.0.0.2 (controller A), 10.0.0.3 (controller B)

 l IP subnet mask: 255.255.255.0

 l Gateway IP address: 10.0.0.1

If the default IP addresses are not compatible with your network, you must set an IP address for each 
network port using the CLI embedded in each controller module. The CLI enables you to access the system 
using the USB communication interface and terminal emulation software. 

Note: If you are using the mini-USB CLI port and cable, see USB device connection: CLI port on 
page 199. 
-Windows customers should download and install the device driver as described in Microsoft Windows 
on page 200. 
-Linux customers should prepare the USB port as described in Setting Parameters for the Device 
Driver on page 201.

Use the CLI commands described in the steps below to set the IP address for the network port on each 
controller module.
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Once new IP addresses are set, you can change them as needed using the Disk Storage Management 
Utility. Be sure to change the IP address via the Disk Storage Management Utility before changing the 
network configuration. See Disk Storage Management Utility on page 123 for more information concerning 
the Disk Storage Management Utility.

 1. From your network administrator, obtain an IP address, subnet mask, and gateway address for 
controller A and another for controller B.

Record these IP addresses so you can specify them whenever you manage the controllers using the 
Disk Storage Management Utility or the CLI.

 2. Use the provided USB cable to connect controller A to a USB port on a host computer. The USB mini 5 
male connector plugs into the CLI port as shown in Figure 110 below (generic QXS Storage controller 
module shown). 

Figure 110: Connecting a USB cable to the CLI port
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1. Connect USB cable to CLI port on controller face plate

 3. Enable the CLI port for subsequent communication:

 l Linux customers should enter the command syntax provided in Setting Parameters for the Device 
Driver on page 201.

 l Windows customers should locate the downloaded device driver described in Microsoft Windows on 
page 200.

 4. Start and configure a terminal emulator, such as HyperTerminal or VT-100, using the display settings in 
Table 9 below and the connection settings in Table 10 on the next page.

For more information, see the note on Using HyperTerminal with the CLI on a Microsoft Windows host.

Parameter Value

Terminal emulation mode VT-100 or ANSI (for color support)

Font Terminal

Table 9: Terminal emulator display settings
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Parameter Value

Translations None

Columns 80

Parameter Value

Connector COM3 (for example)1,2

Baud rate 115,200

Data bits 8

Parity None

Stop bits 1

Flow control None

Table 10: Terminal emulator connection settings

1Your server or laptop configuration determines which COM port is used for Drive Array USB Port.
2Verify the appropriate COM port for use with the CLI.

 5. In the terminal emulator, connect to controller A.

 6. Press Enter to display the CLI prompt (#). 

The CLI displays the system version, MC version, and login prompt:

a. At the login prompt, enter the default user manage and press Enter.

b. At the password prompt, enter the default password !manage and press Enter.

If the default user name, password, or both have been changed for security reasons, enter the secure 
login credentials instead of the defaults.

 7. At the prompt, enter the following command to set the values you obtained in Step  for each Network 
port, first for controller A, and then for controller B:
set network-parameters ip address netmask netmask gateway gateway controller a|b

where:

 l address  is the IP address of the controller

 l netmask  is the subnet mask

 l gateway  is the IP address of the subnet router

 l a|b specifies the controller whose network parameters you are setting

For example:
# set network-parameters ip 192.168.0.10 netmask 255.255.255.0 gateway 192.168.0.1 
controller a
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# set network-parameters ip 192.168.0.11 netmask 255.255.255.0 gateway 192.168.0.1 
controller b

 8. Enter the following command to verify the new IP addresses:
show network-parameters

Network parameters, including the IP address, subnet mask, and gateway address, are displayed for 
each controller.

 9. Use the ping command to verify connectivity to the gateway address.

For example:
# ping 192.168.0.1
Info: Pinging 192.168.0.1 with 4 packets.

Success: Command completed successfully. - The remote computer responded with 4 
packets.(2011-12-19 10:20:37)

 10. In the host computer's command window, type the following command to verify connectivity, first for 
controller A and then for controller B:

ping controller-IP-address

If you cannot access your system for at least three minutes after changing the IP address, you might 
need to restart the MC(s) using the serial CLI. 

When you restart an MC, communication with it is temporarily lost until it successfully restarts.

Enter the following command to restart the MC in both controllers:

 11. When you are done using the CLI, exit the emulator.

 12. Retain the IP addresses (recorded in step 1) for accessing and managing the controllers using either 
the Disk Storage Management Utility or the CLI.

Note: Using HyperTerminal with the CLI on a Microsoft Windows host:
On a host computer connected to a controller module’s mini-USB CLI port, incorrect command 
syntax in a HyperTerminal session can cause the CLI to hang. To avoid this problem, use correct 
syntax, use a different terminal emulator, or connect to the CLI using Telnet rather than the mini-
USB cable.
Be sure to close the HyperTerminal session before shutting down the controller or restarting its 
MC. Otherwise, the host’s CPU cycles may rise unacceptably.

If communication with the CLI is disrupted when using an out-of-band cable connection, communication can 
sometimes be restored by disconnecting and reattaching the mini-USB CLI cable as shown in Figure 110 on 
page 119.
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Basic Operation Overview
Verify that you have successfully completed the sequential “Installation Checklist” instructions in Table 2 on 
page 51. Once you have successfully completed steps 1 through 8, you can access the management 
interfaces to complete the system setup.

This provides a brief introduction to the CLI and the Disk Storage Management Utility. For more information, 
see the QXS Storage CLI Reference Guide and QXS Storage Disk Storage Management Utility Users 
Guide (V2) or QXS Storage Disk Storage Management Utility Users Guide (V3).

QX and QXS Setup Guide 122
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CLI
The CLI software embedded in the controller modules enables you to manage and monitor storage-system 
operation.

Signing In to the CLI
1. Access the CLI using one of the following options:

 l Use HTTP, HTTPS, Telnet, an SSH application, or a terminal emulator on a management host that 
is remotely connected through a LAN to a controller module’s network port. See the QXS Storage 
Setup Guide for information about setting management port IP addresses using the CLI.

 l By using a terminal emulator on a management host that is directly connected to a controller 
module’s serial CLI port.

2. When prompted with login, enter the user name and press Enter. The default user name is manage.

3. When prompted with password, enter the password and press Enter. The default password is
 !manage.

If you are logging in to the CLI for the first time, the Language field displays user setting or English, 
either of which results in English.

Disk Storage Management Utility
The Disk Storage Management Utility (V2 or V3) is a web-based application for configuring, monitoring, and 
managing the storage system. 

Each controller module in the storage system contains a web server, which is accessed when you sign in to 
this utility. In a dual-controller system, you can access all functions from either controller. If one controller 
becomes unavailable, you can continue to manage the storage system from the partner controller.

The Disk Storage Management Utility is also referred to as the WBI.

Browser setup
 l Use Mozilla Firefox 3 or later, or Microsoft Internet Explorer 8 or later.

 l To see the help window, you must enable pop-up windows.

 l To optimize the display, use a color monitor and set its color quality to the highest setting.

 l To navigate beyond the Sign In page (with a valid user account):
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 l Set the browser’s local-intranet security option to medium or medium-low. For Internet Explorer 8, 
adding each controller’s network IP address as a trusted site can avoid access issues.

 l Verify that the browser is set to allow cookies at least for the IP addresses of the storage-system 
network ports.

Signing In to the Disk Storage Management Utility
1. In the web browser’s address field, type the IP address of a controller network port and press Enter. 

The Disk Storage Management Utility Sign In page is displayed. If the Sign In page does not display, 
verify that you have entered the correct IP address.

2. On the Sign In page, enter the name and password of a configured user. The default user name and 
password are manage and !manage. If you are logging in to the Disk Storage Management Utility for the 
first time, the Language field displays user setting or English, either of which results in English.

3. Click Sign In. If the system is available, the System Overview page is displayed; otherwise, a message 
indicates that the system is unavailable.

Tips for signing in and signing out

 l Do not include a leading zero in an IP address. For example, enter 10.1.4.6 not 10.1.4.06.

 l Multiple users can be signed in to each controller simultaneously.

 l For each active Disk Storage Management Utility session, an identifier is stored in the browser. 
Depending on how your browser treats this session identifier, you might be able to run multiple 
independent sessions simultaneously. Internet Explorer can run separate Disk Storage Management 
Utility sessions if you select New Session in the File menu. If you do not select this then all instances 
of Internet Explorer share the same session, as does Firefox.

You can end a Disk Storage Management Utility session by clicking the Sign Out link near the top of the 
Disk Storage Management Utility window. Do not simply close the browser window.

Configuring and Provisioning the Storage System
Once you have familiarized yourself with the Disk Storage Management Utility, use it to configure and 
provision the storage system. Refer to the following chapters within the QXS Storage Disk Storage 
Management Utility Users Guide:

 l Getting started

 l Configuring the system

 l Provisioning the system

Note: If you need to install a license, see the “Installing a license” topic within the Disk Storage 
Management Utility for instructions about creating a temporary license, or installing a permanent 
license.
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Caution: If the system is used in a VMware environment, set the system’s Missing LUN Response 
option to use its Illegal Request setting. To do so, see either the configuration topic “Changing the 
missing LUN response” in the QXS Storage Disk Storage Management Utility Users Guide or the 
command topic “set-advanced-settings” in the QXS Storage CLI Reference Guide..

Best Practices for Optimal Performance
Table 11 below lists features that can negatively impact performance on your system and recommendations 
for minimizing the impact.

For more information on an item, see either the QXS Storage CLI Reference Guideor the QXS Storage Disk 
Storage Management Utility Users Guide..

Feature Impact Recommendations for 
minimizing impact

Managed logs The managed logs function collects information at least once 
every 12 hours. While collecting information, the system 
might experience increased I/O response time and/or I/O 
time-outs.

Disable managed logs 
through Disk Storage 
Management Utility or the 
CLI.

Active Disk 
Storage 
Management 
Utility, CLI, SMI-
S, and SNMP 
sessions

Active Disk Storage Management Utility, CLI, SMI-S, and 
SNMP sessions collect information up to 4 times per hour. 
While collecting information, the system might experience 
increased I/O response time and/or I/O time-outs.

Note: Use of SMI-S and SNMP traps does not 
affect performance.

Use the Disk Storage 
Management Utility, the 
CLI, SMI-S, and SNMP 
during non-peak hours.

Table 11: Solutions to degraded performance
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Feature Impact Recommendations for 
minimizing impact

Background and 
manual scrubs

 l A background scrub affects performance up to 5%.
 l A manual scrub affects performance 

25 - 60%.

 l Disable background 
scrubs through the 
Disk Storage 
Management Utility or 
the CLI. 

Caution: If you 
disable background 
scrubs, run a manual 
scrub at least once 
per month.

 l Run a manual scrub 
during non-peak 
hours.

 l Set the Utility priority 
for manual scrubs to 
low through the Disk 
Storage Management 
Utility or the CLI.

Reconstruction 
and copyback

 l Reconstruction affects performance 
5 - 50%.

 l Copyback affects performance up to 15%.

 l Set the Utility priority 
for reconstruction to 
low through the Disk 
Storage Management 
Utility or the CLI.

 l Replace failed drives 
during non-peak hours

Caution: It is 
recommended that 
you replace failed 
drives immediately.
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Troubleshooting Overview
These procedures are intended to be used only during initial configuration, for the purpose of verifying that 
hardware setup is successful. They are not intended to be used as troubleshooting procedures for 
configured systems using production data and I/O.
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Note: For further troubleshooting help, after initial setup and when user data is present, contact 
Quantum technical support.

USB CLI Port Connection
Quantum QXS Storage controllers feature a CLI port employing a mini-USB Type B form factor. If you 
encounter problems communicating with the port after cabling your computer to the USB device, you may 
need to either download a device driver (Windows), or set appropriate parameters via an operating system 
command (Linux). See  on page 198 for more information.

Fault Isolation Methodology
Quantum QXS Storage storage systems provide many ways to isolate faults. This section presents the basic 
methodology used to locate faults within a storage system, and to identify the pertinent FRUs affected. 

As noted in Basic Operation Overview on page 122, configure and provision the system upon completing the 
hardware installation. As part of this process, configure and enable event notification so the system will 
notify you when a problem occurs that is at or above the configured severity (see “Using the Configuration 
Wizard > Configuring event notification” in the QXS Storage Disk Storage Management Utility Users 
Guide). With event notification configured and enabled, you can follow the recommended actions in the 
notification message to resolve the problem, as further discussed in the options presented below. 

Basic Steps
The basic fault isolation steps are listed below:

 l Gather fault information, including using system LEDs. See Gather Fault Information on page 130.

 l Determine where in the system the fault is occurring. See Determine Where the Fault is Occurring on 
page 130.

 l Review event logs. See Review the Event Logs on page 130.

 l If required, isolate the fault to a data path component or configuration. See Isolate the Fault on 
page 131.



Chapter 5: Troubleshooting
Fault Isolation Methodology

QX and QXS Setup Guide 129

Options Available For Performing Basic Steps
When performing fault isolation and troubleshooting steps, select the option or options that best suit your site 
environment. Four option are described below. Use of any option is not mutually-exclusive to the use of 
another option. You can use the Disk Storage Management Utility to check the health icons/values for the 
system and its components to ensure that everything is okay, or to view a problem component. If you 
discover a problem, both the Disk Storage Management Utility and the CLI provide recommended-action 
text. Options for performing basic steps are listed according to frequency of use:

 l Use the Disk Storage Management Utility (V2 or V3) below

 l Use the CLI below

 l Monitor Event Notification below

 l View the Chassis LEDs below

Use the Disk Storage Management Utility (V2 or V3)
The Disk Storage Management Utility uses health icons to show OK, Degraded, Fault, or Unknown status 
for the system and its components. The Disk Storage Management Utility enables you to monitor the health 
of the system and its components. If any component has a problem, the system health will be Degraded, 
Fault, or Unknown. Use the Disk Storage Management Utility’s GUI to find each component that has a 
problem, and follow actions in the component Health Recommendations field to resolve the problem.

Use the CLI
As an alternative to using the Disk Storage Management Utility, you can run the show system command in 
the CLI to view the health of the system and its components. If any component has a problem, the system 
health will be Degraded, Fault, or Unknown, and those components will be listed as Unhealthy 
Components. Follow the recommended actions in the component Health Recommendation field to resolve 
the problem.

Monitor Event Notification
With event notification configured and enabled, you can view event logs to monitor the health of the system 
and its components. If a message tells you to check whether an event has been logged, or to view 
information about an event in the log, you can do so using either the Disk Storage Management Utility or the 
CLI. Using the Disk Storage Management Utility, you view the event log and then click on the event 
message to see detail about that event. Using the CLI, you run the show events detail command (with 
additional parameters to filter the output) to see the detail for an event. The events will be listed in reverse 
chronological order (most recent messages are at the top of the list). The Disk Storage Management Utility 
will only display the last 100 events.

View the Chassis LEDs
You can view the LEDs on the hardware (while referring to LEDs for 56-Drive RAID Chassis (4U56) on 
page 175 for your chassis model) to identify component status. If a problem prevents access to either the 
Disk Storage Management Utility or the CLI, this is the only option available. However, 
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monitoring/management is often done at a management console using storage management interfaces 
rather than relying on line-of-sight to LEDs of racked hardware components.

Performing Basic Steps
You can use any of the available options described above in performing the basic steps comprising the fault 
isolation methodology.

Gather Fault Information
When a fault occurs, it is important to gather as much information as possible. Doing so will help you 
determine the correct action needed to remedy the fault.

Begin by reviewing the reported fault:

 l Is the fault related to an internal data path or an external data path? 

 l Is the fault related to a hardware component such as a drive module, controller module, or power 
supply?  

By isolating the fault to one of the components within the storage system, you will be able to determine the 
necessary corrective action more quickly. 

Determine Where the Fault is Occurring
Once you have an understanding of the reported fault, review the chassis LEDs. The chassis LEDs are 
designed to immediately alert users of any system faults, and might be what alerted the user to a fault in the 
first place.

When a fault occurs, the Fault ID Status LED on an chassis  right ear illuminates (see the diagram pertaining 
to your product’s front panel components. Check the LEDs on the rear of the chassis to narrow the fault to a 
FRU, connection, or both. The LEDs also help you identify the location of a FRU reporting a fault.

Use the Disk Storage Management Utility to verify any faults found while viewing the LEDs. The Disk 
Storage Management Utility is also useful in determining where the fault is occurring if the LEDs cannot be 
viewed due to the location of the system. It provides you with a visual representation of the system and 
where the fault is occurring. It can also provide more detailed information about FRUs, data, and faults.

Review the Event Logs
The event logs record all system events. Each event has a numeric code that identifies the type of event that 
occurred, and has one of the following severities:

 l Critical. A failure occurred that may cause a controller to shut down. Correct the problem immediately.

 l Error. A failure occurred that may affect data integrity or system stability. Correct the problem as soon as 
possible.

 l Warning. A problem occurred that may affect system stability, but not data integrity. Evaluate the 
problem and correct it if necessary.
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 l Informational. A configuration or state change occurred, or a problem occurred that the system 
corrected. No immediate action is required.

See the QXS Storage Service Guide, which is available at www.quantum.com, for information about 
specific events. 

It is very important to review the logs, not only to identify the fault, but also to search for events that might 
have caused the fault to occur. For example, a host could lose connectivity to a vdisk if a user changes 
channel settings without taking the storage resources assigned to it into consideration. In addition, the type 
of fault can help you isolate the problem to either hardware or software. 

Isolate the Fault
Occasionally, it might become necessary to isolate a fault. This is particularly true with data paths, due to the 
number of components comprising the data path. For example, if a host-side data error occurs, it could be 
caused by any of the components in the data path: controller module, cable, or data host.

If the Chassis Does Not Initialize
It may take up to two minutes for all chassis to initialize. If an chassis does not initialize:

 l Perform a rescan.

 l Power cycle the system.

 l Make sure the power cord is properly connected, and check the power source to which it is connected.

 l Check all cable connections from RAID chassis and expansion chassis.

 l Check the event log for errors.

Correcting Chassis IDs 
When installing a system with expansion chassis  attached, the chassis IDs might not agree with the physical 
cabling order. This is because the controller might have been previously attached to chassis in a different 
configuration, and it attempts to preserve the previous chassis IDs if possible. To correct this condition, 
make sure that both controllers are up, and perform a rescan using the Disk Storage Management Utility or 
the CLI. This will reorder the chassis IDs, but can take up to two minutes for the chassis IDs to be corrected.

Rescan Using CLI
To perform a rescan using the CLI, type the following command:
rescan

Rescan Using Disk Storage Management Utility (V2)
To rescan using the Disk Storage Management Utility (V2):

http://www.quantum.com/
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1. Verify that both controllers are operating normally

2. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels

3. Click Rescan.

Rescan Using Disk Storage Management Utility (V3)
To rescan using the Disk Storage Management Utility (V3):

1. Verify that both controllers are operating normally

2. Do one of the following:

 l Point to the System tab and select Rescan Disk Channels.

 l In the System topic, select Action > Rescan Disk Channels.

3. Click Rescan.

Stopping I/O
When troubleshooting drive and connectivity faults, ensure you have a current full backup. As an additional 
data protection precaution, stop all I/O to the affected vdisks.

Caution: Stopping I/O to a vdisk is a host-side task, and falls outside the scope of this document.

When on-site, you can verify that there is no I/O activity by briefly monitoring the system LEDs; however, 
when accessing the storage system remotely, this is not possible. Remotely, you can use the show vdisk-
statistics command to determine if I/O has stopped. Perform the steps below:

1. Using the CLI, run the show vdisk-statistics  command.

The Number of Reads and Number of Writes outputs show the number of these operations that 
have occurred since the statistic was last requested. Record the numbers displayed.

2. Run the show vdisk-statistics command a second time.

This provides you a specific window of time (the interval between requesting the statistics) to determine 
if data is being written to or read from the drive. Record the numbers displayed.

3. To determine if any reads or writes occur during this interval, subtract the set of numbers you recorded in 
Step 1 from the numbers you recorded in Step 2. 

 l If the resulting difference is zero, I/O has stopped. 

 l If the resulting difference is not zero, a host is still reading from or writing to this vdisk. Continue to 
stop I/O from hosts, and repeat Step 1 and Step 2 until the difference in Step 3 is zero.

Note: See the QXS Storage CLI Reference Guide for additional information.
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Diagnostic Steps
This section describes possible reasons and actions to take when an LED indicates a fault condition during 
initial system setup. Refer to the descriptions of LED statuses. 

In addition to monitoring LEDs via line-of-sight observation of the racked hardware components when 
performing diagnostic steps, you can also monitor the health of the system and its components using the 
management interfaces previously discussed. Bear this in mind when reviewing the Actions column in the 
following diagnostics tables, and when reviewing the step procedures provided later in this chapter.

Is the Chassis Front Panel “Fault/Service Required” LED Amber?

Answer Possible reasons  Actions

No System functioning properly. No action required.

Yes A fault condition exists/occurred.
If installing an IOM FRU, the 
module has gone online and likely 
failed its self-test.

 l Check the LEDs on the rear of the controller to narrow the 
fault to a FRU, connection, or both. 

 l Check the event log for specific information regarding the 
fault; follow any Recommended Actions.

 l If installing an IOM FRU, try removing and reinstalling the 
new IOM, and check the event log for errors.

 l If the above actions do not resolve the fault, isolate the fault 
and contact an authorized service provider for assistance. 
Replacement may be necessary.

Table 12: Diagnostics LED status: Front panel “Fault/Service Required”

Is the Controller Rear Panel “FRU OK” LED Off?

Answer Possible reasons  Actions

No
(blinking)

System functioning 
properly.
System is booting.

No action required.
Wait for system to boot.

Yes The controller module is 
not powered on.
The controller module has 
failed.

 l Check that the controller module is fully inserted and latched in 
place, and that the chassis is powered on.

 l Check the event log for specific information regarding the failure.

Table 13: Diagnostics LED status: Rear panel “FRU OK”
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Is the Controller Rear Panel “Fault/Service Required” LED Amber? 

Answer Possible 
reasons 

Actions

No System 
functioning 
properly.

No action required.

Yes 
(blinking)

One of the 
following errors
occurred:
 l Hardware-

controlled 
power-up 
error

 l Cache flush 
error

 l Cache self-
refresh error

 l Restart this controller from the other controller using the Disk Storage 
Management Utilityor the CLI.

 l If the above action does not resolve the fault, remove the controller and 
reinsert it.

 l If the above action does not resolve the fault, contact an authorized service 
provider for assistance. It may be necessary to replace the controller.

Table 14: Diagnostics LED status: Rear panel “Fault/Service Required”

Is the Drawer Panel Fault/Service Required LED Amber? 

Answer Possible reasons  Actions

No System functioning properly. No action required.

Yes 
(solid)

A drawer-level fault is detected or a 
service action is required.

 l Check the event log for specific information regarding 
the fault; follow any Recommended Actions.

 l If the above action does not resolve the fault, contact an 
authorized service provider for assistance.

Yes 
(blinking)

Hardware-controlled power-up error  l Check the event log for specific information regarding 
the fault; follow any Recommended Actions.

 l If the above action does not resolve the fault, contact an 
authorized service provider for assistance.

Table 15: Diagnostics LED status: Drawer panel “Fault/Service Required”
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Are Both Drive Module LEDs Off? 

Answer Possible reasons  Actions

Yes  l There is no 
power

 l The drive is 
offline

 l The drive is not 
configured.

Check that the drive is fully inserted and latched in place, and that the 
chassis is powered on.

Table 16: Diagnostic LED status: Drive module

Is the Drive Module “Fault” LED Amber? 

Answer Possible reasons  Actions

Yes, and the 
online/activity LED is 
off.

The drive is offline. An event message may 
have been received for this device.

 l Check the event log for 
specific information regarding 
the fault.

 l Isolate the fault.
 l Contact an authorized service 

provider for assistance.

Yes, and the 
online/activity LED is 
blinking.

The drive is active, but an event message may 
have been received for this device.

 l Check the event log for 
specific information regarding 
the fault.

 l Isolate the fault.
 l Contact an authorized service 

provider for assistance.

Table 17: Diagnostics LED status: Drive “Fault” LED (LFF and SFF modules)

Is a Connected Host Port’s “Host Link Status” LED Off? 

Answer Possible 
reasons 

Actions

No System 
functioning 
properly.

No action required (see Link LED note: Once a Link Status LED is lit, it remains so, 
even if the controller is shut down via the Disk Storage Management Utility or CLI. on 
page 172).

Table 18: Diagnostics LED status: Rear panel “Host Link Status”
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Answer Possible 
reasons 

Actions

Yes The link is 
down.

 l Check cable connections and reseat if necessary.
 l Inspect cable for damage.
 l Swap cables to determine if fault is caused by a defective cable. Replace cable if 

necessary.
 l Verify that the switch, if any, is operating properly. If possible, test with another 

port.
 l Verify that the HBA is fully seated, and that the PCI slot is powered on and 

operational.
 l Review event logs for indicators of a specific fault in a host data path component.
 l Contact an authorized service provider for assistance.
 l See also Isolate a Host-side CNC Connection Fault  on page 138.

Is a Connected Port’s “Expansion Port Status” LED Off? 

Answer Possible reasons  Actions

No System functioning 
properly.

No action required.

Yes The link is down.  l Check cable connections and reseat if necessary.
 l Inspect cable for damage.
 l Swap cables to determine if fault is caused by a defective cable. 

Replace cable if necessary.
 l Review event logs for indicators of a specific fault in a host data path 

component.
 l Contact an authorized service provider for assistance.
 l See also Isolate a Controller Module Expansion Port Connection Fault  

on page 141.

Table 19: Diagnostics LED status: Rear panel “Expansion Port Status”

Is a Connected Port’s “Network Port Link Status” LED Off? 

Answer Possible reasons  Actions

No System functioning 
properly.

No action required.

Yes The link is down. Use standard networking troubleshooting procedures to isolate faults on 
the network.

Table 20: Diagnostics LED status: Rear panel “Network Port Link Status”
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Is the Fan Control Module “Fault/Service Required” LED Amber?

Answer Possible reasons  Actions

No System functioning properly. No action required.

Yes The power supply unit or a fan 
is operating at an 
unacceptable voltage/RPM 
level, or has failed.

When isolating faults in the power supply, remember that the fans in 
both modules receive power through a common bus on the 
midplane, so if a power supply unit fails, the fans continue to operate 
normally.
 l Verify that the FCM FRU is firmly locked into position.
 l Verify that the power cable is connected to a power source.
 l Verify that the power cable is connected to the chassis  power 

supply unit.

Table 21: Diagnostics LED status: Rear panel fan control module “Fault/Service Required”

Is the Power Supply’s “Input Power Source” LED Off?

Answer Possible reasons  Actions

No System functioning 
properly.

No action required.

Yes The power supply is not 
receiving adequate power.

 l Verify that the power cord is properly connected, and check the 
power source to which it connects.

 l Check that the power supply FRU is firmly locked into position.
 l Check the event log for specific information regarding the fault.
 l If the above action does not resolve the fault, isolate the fault and 

contact an authorized service provider for assistance.

Table 22: Diagnostics LED status: Rear panel Power Supply “Input Power Source”

Is the “Voltage/Fan Fault/Service Required” LED Amber? 

Answer Possible reasons  Actions

No System functioning properly. No action required.

Table 23: Diagnostics LED status: Rear panel Power Supply “Voltage/Fan Fault/Service Required”
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Answer Possible reasons  Actions

Yes The power supply or a fan is 
operating at an unacceptable 
voltage or r/min level, or has 
failed.

When isolating faults in the power supply, remember that the fans in 
both modules receive power through a common bus on the 
midplane, so if a power supply fails, the fans continue to operate 
normally.
 l Verify that the power suply FRU is firmly locked into position.
 l If the above action does not resolve the fault, verify that the 

power cable is connected to a power source.
 l If the above action does not resolve the fault, verify that the 

power cable is connected to the chassis  power supply unit.
 l If the above action does not resolve the fault, FRU replacement 

may be necessary; see the QXS Storage CRU Installation and 
Replacement Guide.

Transporting Cache
To preserve the existing data stored in the CompactFlash, you must transport the CompactFlash from the 
failed controller to a replacement controller using the procedure outlined in the CRU Installation and 
Replacement Guide. Failure to use this procedure will result in the loss of data stored in the cache module.

Caution: Remove the controller I/O module only after the copy process is complete, which is indicated 
by the Cache Status LED being off, or blinking at 1:10 rate.

 

 

Isolate a Host-side CNC Connection Fault 
During normal operation, when a controller I/O module host port is connected to a data host, the port’s host 
link status LED and host link activity LED are green. If there is I/O activity, the host activity LED blinks green. 
If data hosts are having trouble accessing the storage system, and you cannot locate a specific fault or 
cannot access the event logs, use the following procedure. 

This procedure requires scheduled downtime.

Caution: Do not perform more than one step at a time. Changing more than one variable at a time can 
complicate the troubleshooting process.



Chapter 5: Troubleshooting
Isolate a Host-side CNC Connection Fault

QX and QXS Setup Guide 139

Host-side Connection Troubleshooting Featuring CNC 
Ports
The procedure below pertains to the controller I/O modules (in the RAID chassis) employing SFP 
transceiver connectors in 4/8/16 Gbit FC, 10GbE iSCSI, or 1 Gb iSCSI host interface ports. In the following 
procedure, “SFP and host cable” is used to refer to any of the qualified SFP options supporting CNC ports 
used for I/O or replication.

1. Halt all I/O to the storage system (see Stopping I/O on page 132).

2. Check the host activity LED.

If there is activity, halt all applications that access the storage system.

3. Check the Cache Status LED to verify that the controller’s cached data is flushed to the drives.

 l Solid – Cache is dirty (contains unwritten data) and is not writing to drive.

 l Blinking – Cache data is being written to CompactFlash.

 l Flashing at 1/10 second on and 9/10 second off – Cache is being refreshed by the supercapacitor.

 l Off – Cache is clean (no unwritten data).

4. Remove the SFP and host cable and inspect for damage.

5. Reseat the SFP and host cable.

Is the host link status LED on? 

 l Yes – Monitor the status to ensure that there is no intermittent error present. If the fault occurs again, 
clean the connections to ensure that a dirty connector is not interfering with the data path.

 l No – Proceed to the next step.

6. Move the SFP and host cable to a port with a known good link status.

This step isolates the problem to the external data path (SFP, host cable, and host-side devices) or to 
the controller module port. 

Is the host link status LED on? 

 l Yes – You now know that the SFP, host cable, and host-side devices are functioning properly. 
Return the SFP and cable to the original port. If the link status LED remains off, you have isolated 
the fault to the controller module’s port. Replace the controller module.

 l No – Proceed to the next step.

7. Swap the SFP with a known good one.

Is the host link status LED on?

 l Yes – You have isolated the fault to the SFP. Replace the SFP.

 l No – Proceed to the next step.

8. Re-insert the original SFP and swap the cable with a known good one.

Is the host link status LED on?

 l Yes – You have isolated the fault to the cable. Replace the cable.
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 l No – Proceed to the next step.

9. Verify that the switch, if any, is operating properly. If possible, test with another port.

10.Verify that the HBA is fully seated, and that the PCI slot is powered on and operational.

11.Replace the HBA with a known good HBA, or move the host side cable and SFP to a known good HBA.

Is the host link status LED on?

 l Yes – You have isolated the fault to the HBA. Replace the HBA.

 l No – It is likely that the controller module needs to be replaced.

12.Move the cable and SFP back to its original port.

Is the host link status LED on?

 l No – The controller module’s port has failed. Replace the controller module.

 l Yes – Monitor the connection for a period of time. It may be an intermittent problem, which can occur 
with SFPs, damaged cables, and HBAs.

Isolate a Host-side SAS Connection Fault 
This procedure applies to following systems that use SAS host ports: 

 l QXS-312 and QXS-324

 l QXS-412, QXS-324, QXS-448, and QXS-456

 l QXS-648 and QXS-656

This procedure requires scheduled downtime.

Host-side Connection Troubleshooting Featuring SAS 
Host Ports
The procedure below applies to RAID chassis employing 12 Gb SFF-8644 connectors in the HD mini-SAS 
host ports used for I/O. These models do not support replication.

1. Halt all I/O to the storage system (see Stopping I/O on page 132).

2. Check the host activity LED.

If there is activity, halt all applications that access the storage system.

3. Check the Cache Status LED to verify that the controller’s cached data is flushed to the drives.

 l Solid – Cache is dirty (contains unwritten data) and is not writing to drive.

 l Blinking – Cache data is being written to CompactFlash.
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 l Flashing at 1/10 second on and 9/10 second off – Cache is being refreshed by the supercapacitor.

 l Off – Cache is clean (no unwritten data).

4. Reseat the  host cable and inspect for damage.

Is the host link status LED on? 

 l Yes – Monitor the status to ensure that there is no intermittent error present. If the fault occurs again, 
clean the connections to ensure that a dirty connector is not interfering with the data path.

 l No – Proceed to the next step.

5. Move the  host cable to a port with a known good link status.

This step isolates the problem to the external data path (host cable and host-side devices) or to the 
controller module port. 

Is the host link status LED on? 

 l Yes – You now know that the  host cable and host-side devices are functioning properly. Return the  
cable to the original port. If the link status LED remains off, you have isolated the fault to the 
controller module’s port. Replace the controller module.

 l No – Proceed to the next step.

6. Verify that the switch, if any, is operating properly. If possible, test with another port.

7. Verify that the HBA is fully seated, and that the PCI slot is powered on and operational.

8. Replace the HBA with a known good HBA, or move the host side cable to a known good HBA.

Is the host link status LED on?

 l Yes – You have isolated the fault to the HBA. Replace the HBA.

 l No – It is likely that the controller module needs to be replaced.

9. Move the host cable back to its original port.

Is the host link status LED on?

 l Yes – You have isolated the fault to the HBA. Replace the HBA.

 l No – It is likely that the controller module needs to be replaced.

Isolate a Controller Module Expansion Port 
Connection Fault 
During normal operation, when a controller module’s expansion port is connected to an expansion chassis, 
the expansion port status LED is green. If the connected port’s expansion port LED is off, the link is down. 
Use the following procedure to isolate the fault.

This procedure requires scheduled downtime.



Chapter 5: Troubleshooting
Isolate a Controller Module Expansion Port Connection Fault

QX and QXS Setup Guide 142

Note: Do not perform more than one step at a time. Changing more than one variable at a time can 
complicate the troubleshooting process.

1. Halt all I/O to the storage system (see Stopping I/O on page 132).

2. Check the host activity LED.

If there is activity, halt all applications that access the storage system.

3. Check the Cache Status LED to verify that the controller’s cached data is flushed to the drives.

 l Solid – Cache is dirty (contains unwritten data) and is not writing to drive.

 l Blinking – Data is still being written to drive.

 l Off – Cache is clean (no unwritten data).

4. Reseat the expansion cable, and inspect it for damage.

Is the expansion port status LED on?

 l Yes – Monitor the status to ensure there is no intermittent error present. If the fault occurs again, 
clean the connections to ensure that a dirty connector is not interfering with the data path.

 l No – Proceed to the next step.

5. Move the expansion cable to a port on the controller module with a known good link status.

This step isolates the problem to the expansion cable or to the controller module’s expansion port. 

Is the expansion port status LED on? 

 l Yes – You now know that the expansion cable is good. Return the cable to the original port. If the 
expansion port status LED remains off, you have isolated the fault to the controller module’s 
expansion port. Replace the controller module.

 l No – Proceed to the next step.

6. Move the expansion cable back to the original port on the controller module.

7. Move the expansion cable on the expansion chassis to a known good expansion port on the  expansion 
chassis. 

Is the expansion port status LED on?

 l Yes – You have isolated the problem to the  expansion chassis port. Replace the expansion I/O 
module. 

 l No – Proceed to the next step.

8. Replace the cable with a known good cable, ensuring the cable is attached to the original ports used by 
the previous cable.

Is the host link status LED on?

 l Yes – Replace the original cable. The fault has been isolated.

 l No – It is likely that the controller module must be replaced.
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Isolate Replication Faults 
This procedure applies to following systems: 

 l QXS-312 and QXS-324

 l QXS-412, QXS-324, QXS-448, and QXS-456

 l QXS-648 and QXS-656

This procedure requires scheduled downtime.

Cabling for Replication
The replication feature is a licensed option for disaster recovery, providing access to either of the following 
software product versions:

• V3 disk management utility supports replication for virtual storage environments.

• V2 disk management utility supports replication for linear storage environments.

These two replication models are mutually exclusive to one another. Choose the method that applies to your 
storage system. For more information, see replication topics in the QXS Disk Management Utility User 
Guide V3.

Replication setup and verification
After storage systems are cabled for replication, you can use the V3 or V2 disk management utility to 
prepare to use the replication feature. Alternatively, you can use telnet to access the IP address of the 
controller module and access the replication feature using the CLI.

Note: You can use the CLI to perform replication in linear or virtual storage environments.

 l Set Management mode to v2 for linear replication (use Manage role).

 l Set Management mode to v3 for virtual replication (use Manage role).

Basic information for enabling the RAID chassis for replication supplements the troubleshooting procedures 
that follow.

 l Familiarize yourself with replication by reviewing the “Getting started”, “Working in the Replications 
topic”, and “the process to replicate volumes” chapters in the QXS Disk Management Utility User Guide 
V3.

 l For virtual replication, in order to replicate an existing volume to a pool on the peer in the primary system 
or secondary system, follow these steps:

 l Find the port address.

Using the CLI, run the query peer-connection command.

 l Create a peer connection.
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To create a peer connection, use the CLI command create peer-connection or in the SMC Replications 
topic, select Action > Create Peer Connection.

 l Create a virtual replication set.

To create a replication set, use the CLI command create replication-set or in the SMC Replications topic, 
select Action > Create Replication Set.

 l Replicate.

To initiate replication, use the CLI command replicate or in the SMC Replications topic, select Action > 
Initiate Replication.

 l For linear replication, in order to replicate an existing volume to another disk group in the primary or 
secondary system, follow these steps:

Use RAIDar‘s Wizards > Replication Setup Wizard to prepare to replicate an existing volume to another 
disk group in the primary system or secondary system.

Follow the wizard to select the primary volume, replication mode, and secondary volume, and to confirm 
your replication settings. 

The wizard verifies the communication links between the primary and secondary systems. Once setup is 
successfully completed, you can initiate replication from RAIDar or the CLI.

 l For descriptions and replication-related events, see the Event Descriptions Reference Guide.

These steps are a general outline of the replication setup. Refer to the following manuals for more 
information about replication setup:

 l See the QXS Disk Management Utility User Guide V3 for procedures to setup and manage replications.

 l See the CLI Reference Guide for replication commands and syntax.

 l See the Event Descriptions Reference Guide for replication event reporting.

Caution: Controller module firmware must be compatible on all systems used for replication. For 
license information, see the Storage Management Guide.

Diagnostic Steps for Replication Setup
The tables in the following subsections show menu navigation using the V3 and V2 disk management utility. 
The shorthand v3 and v2 prefixes are used to distinguish between the V3 and V2 disk management utility, 
respectively.

Virtual Replication Using the V3 Disk Management Utility
Can you successfully use the replication feature?
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Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No The replication 
feature is not 
licensed on each 
controller module 
used for 
replication.

Verify licensing of the optional feature per system:
 l In the Home topic in the V3 disk management utility, select Action > 

Install License.

The License Settings panel opens and displays information about each 
licensed feature.

 l If the Replication feature is not enabled, obtain and install a valid license 
for this feature.

See the Storage Management Guide for license information.

 l Virtual replication is only supported by QXS-3, -4 and -6 Series iSCSI 
RAID chassis.

No Compatible 
firmware revision 
supporting the 
replication feature 
is not running on 
each system used 
for replication.

Perform the following actions on each system used for virtual replication: 

 l In the System topic, select Action > Update Firmware. The Update 
Firmware panel opens. 

The Update Controller Modules tab shows firmware versions installed 
in each controller.

 l If necessary, update the controller module firmware to ensure 
compatibility with the other systems.

 l For more information on compatible firmware, see the topic about 
updating firmware in the Storage Management Guide.

No Invalid cabling 
connection. (If 
multiple RAID 
chassis are used, 
check the cabling 
for each system.)

Verify RAID chassis cabling: 

 l Verify use of proper cables. 

 l Verify proper cabling paths for host connections. 

 l Verify cabling paths between replication ports and switches are visible 
to one another. 

 l Verify that cable connections are securely fastened. 

 l Inspect cables for damage and replace if necessary.

Table 24: Virtual Replication Using the V3

 

Can you view information about remote links?
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Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No Communication 
link is down

 l Verify RAID chassis cabling.

 l Review event logs for indicators of a specific fault in a host or replication 
data path component.

In the footer, click the events panel and select Show Event List. This will 
open the Event Log Viewer panel.

 l Verify valid IP address of the network port on the remote system.

 l Click in the Volumes topic, then click on a volume name in the volumes 
list. Click the Replication Sets tab to display replications and associated 
metadata.

 l Alternatively, click in the Replications topic to display replications and 
associated metadata.

Table 25: Replication Image

 

Can you create a replication set?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No On RAID chassis 
with iSCSI host 
interface ports, 
replication set 
creation fails due 
to use of CHAP.

If using CHAP (Challenge-Handshake Authentication Protocol), see 
the topics about configuring CHAP and working in replications within 
the V3 disk management guide.

Table 26: Replication Set
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Answer Possible reasons  Actions

No *Unable to create 
the secondary 
volume (the 
destination volume 
in the virtual disk 
group to which you 
will replicate data 
from the primary 
volume)?

 l Review event logs (in the footer, click the events panel and 
select Show Event List) for indicators of a specific fault in a 
replication data path component. Follow any Recommended 
Actions. 

 l Verify valid specification of the secondary volume according to 
either of the following criteria:

A conflicting volume does not already exist 

Creation of the new volume in the disk group

No Communication 
link is down.

See actions described in Can you view information about remote 
links?

*After ensuring valid licensing, valid cabling connections, and network availability, create the replication set using 
the Replications topic, select Action > Create Replication Set.

 

Can you replicate a volume?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No The replication 
feature is not 
licensed on each 
RAID chassis 
used for 
replication.

See actions described in Can you successfully use the replication feature?

No Nonexistent 
replication set.

 l Determine existence of primary or secondary volumes. 

 l If a replication set has not been successfully created, use the 
Replications topic, select Action > Create Replication Set to create 
one. 

 l Review event logs (in the footer, click the events panel and select Show 
Event List) for indicators of a specific fault in a replication data path 
component. Follow any Recommended Actions.

Table 27: Replicate a Volume
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Answer Possible reasons  Actions

No Network error 
occurred during in-
progress 
replication.

 l Review event logs for indicators of a specific fault in a replication data path 
component. Follow any Recommended Actions. 

 l Click in the Volumes topic, then click on a volume name in the volumes 
list. Click the Replication Sets tab to display replications and associated 
metadata. 

 l Replications that enter the suspended state can be resumed manually.

No Communication 
link is down.

See actions described in Can you view information about remote links?

 

Has a replication run successfully?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No Last Successful 
Run shows N/A.

 l In the Volumes topic, click on the volume that is a member of the 
replication set. 

Select the Replication Sets table. 

Check the Last Successful Run information. 

 l If a replication has not run successfully, use the disk management utility to
 replicate as described in the “Working in the Replications topic” in the V3 
disk management utility.

No Communication 
link is down.

See actions described in Can you view information about remote links?

Table 28: Replication Run Successfully

 

Virtual Replication Using the V2 Disk Management Utility
 

Can you successfully use the replication feature?
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Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No The replication 
feature is not 
licensed on each 
RAID chassis 
used for 
replication.

Verify licensing of the optional feature per system:

 l In the Configuration View panel in V2 disk management utility, right-click 
on the system, and select View > Overview. Within the System Overview 
table, select the Licensed Features component to display the status of 
licensed features.

 l If the Replication feature is not enabled, obtain and install a valid license 
for this feature.

 l Linear replication is only supported by QXS-3, -4 and -6 Series iSCSI RAID 
chassis.

No Compatible 
firmware revision 
supporting the 
replication feature 
is not running on 
each system used 
for replication.

Perform the following actions on each system used for virtual replication: 

 l In the Configuration View panel in V2 disk management utility, right-click 
the system, and select Tools > Update Firmware.

The Update Controller Modules tab shows firmware versions installed in 
each controller.

 l If necessary, update the controller module firmware to ensure compatibility 
with the other systems.

No Invalid cabling 
connection. (If 
multiple RAID 
chassis are used, 
check the cabling 
for each system.)

Verify RAID chassis cabling: 

 l Verify use of proper cables. 

 l Verify proper cabling paths for host connections. 

 l Verify cabling paths between replication ports and switches are visible to 
one another. 

 l Verify that cable connections are securely fastened. 

 l Inspect cables for damage and replace if necessary.

Table 29: Virtual Replication Using the V2 

 

Can you view information about remote links?
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Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No Communication 
link is down

 l Verify RAID chassis cabling.

 l Review event logs (in the Configuration View panel, right-click the system, 
and select View > Event Log) for indicators of a specific fault in a host or 
replication data path component.

 l Verify valid IP address of the network port on the remote system.

 l In the Configuration View panel, right-click the remote system, and select 
Tools > Check Remote System Link. Click Check Links.

Table 30: Replication Image

 

Can you create a replication set?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No Selected link type 
or port-to-link 
connections are 
incorrect.

 l Remote Replication mode: In the Configuration View panel, right-click 
the remote system, and select Tools > Check Remote System 
Link. Click Check Links to verify correct link type and remote host 
port-to-link connections. 

 l Local Replication mode: In the Configuration View panel, right-click 
the local system, and select Tools > Check Local System Link. 
Click Check Links to verify correct link type and local host port-to-link 
connections.

No On RAID chassis 
with iSCSI host 
interface ports, 
replication set 
creation fails due 
to use of CHAP.

If using CHAP (Challenge-Handshake Authentication Protocol), see the 
topics about configuring CHAP and working in replications within the V2 
disk management guide.

Table 31: Replication Set
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Answer Possible reasons  Actions

No *Unable to select 
the replication 
mode (Local or 
Remote)?

 l Review event logs (in the Configuration View panel, right-click the 
system, and select View > Event Log) for indicators of a specific fault 
in a host or replication data path component. Follow any 
Recommended Actions. 

 l Local Replication mode replicates to a secondary volume residing in 
the local storage system. 

 o Verify valid links. 

 o On dual-controller systems, verify that A ports can access B ports 
on the partner controller, and vice versa. 

 o Verify existence of either a replication-prepared volume of the 
same size as the master volume, or a disk group with sufficient 
unused capacity. 

 l Remote Replication mode replicates to a secondary volume residing 
in an independent storage system: 

 o Verify selection of a valid remote disk group. 

 o Verify selection of valid remote volume on disk group. 

 o Verify valid IP address of remote system network port. 

 o Verify user name with Manage role on remote system. 

 o Verify user password on remote system. 

Note: If the remote system has not been added, it cannot be 
selected.

No *Unable to select 
the secondary 
volume (the 
destination volume 
on the disk group 
to which you will 
replicate data from 
the primary 
volume)?1

 l Review event logs for indicators of a specific fault in a replication data 
path component. Follow any Recommended Actions. 

 l Verify valid specification of the secondary volume according to either 
of the following criteria: 

 o Creation of the new volume on the disk group 

 o Selection of replication-prepared volume

No Communication 
link is down.

See actions described in Can you view information about remote links?

*After ensuring valid licensing, valid cabling connections, and network availability, create the replication set using 
the Wizards > Replication Setup Wizard.

 

Can you replicate a volume?
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Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No The replication 
feature is not 
licensed on each 
RAID chassis 
used for 
replication.

See actions described in Can you successfully use the replication feature?

No Nonexistent 
replication set.

 l Determine existence of primary or secondary volumes. 

 l If a replication set has not been successfully created, use the Replication 
Setup Wizard to create one. 

 l Review event logs (in the Configuration View panel, right-click the system, 
and select View > Event Log) for indicators of a specific fault in a 
replication data path component. Follow any Recommended Actions.

No Network error 
occurred during in-
progress 
replication.

 l Review event logs for indicators of a specific fault in a replication data path 
component. Follow any Recommended Actions. 

 l In the Configuration View panel, right-click the secondary volume, and 
select View > Overview to display the Replication Volume Overview table:

 o Check for replication interruption (suspended) status.

 o Check for inconsistent status.

 o Check for offline status.

 l Replications that enter the suspended state can be resumed manually.

No Communication 
link is down.

See actions described in Can you view information about remote links?

Table 32: Replicate a Volume

 

Can you view a replication image?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

Table 33: Replication Image
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Answer Possible reasons  Actions

No Nonexistent 
replication image.

 l In the Configuration View panel, expand disk groups and subordinate 
volumes to reveal the existence of a replication image or images.

 l If a replication image has not been successfully created, use V2 disk 
management utility to create one as described in the “Using 
AssuredRemote to replicate volumes” topic within the disk management 
utility .

No Communication 
link is down.

See actions described in Can you view information about remote links?

 

Can you view remote systems?

Answer Possible reasons  Actions

Yes System 
functioning 
properly.

No action required.

No Communication 
link is down.

See actions described in Can you view information about remote links?

Table 34: View Remote Systems 

 

Resolve Voltage and Temperature Warnings
1. Check that all of the fans are working by making sure the Voltage/Fan Fault/Service Required LED on 

each power supply is off, or by using the V3 or V2 disk management utility to view the health status of the 
chassis and its components.

V3: In the lower corner of the footer, overall health status of the chassis is indicated by a health status 
icon. For more information, point to the System tab and select View System to see the System panel. 
You can select Front, Rear, and Table views on the System panel. If you hover over a component, its 
associated metadata and health status displays onscreen.

V2: In the Configuration View panel, right click the chassis and click View > Overview to view the health 
status of the chassis and its components. The Enclosure Overview page enables you to see information 
about each chassis and its physical components in front, rear, and tabular views—using graphical or 
tabular presentation—allowing you to view the health status of the chassis and its components.

See Options Available For Performing Basic Steps on page 129 for a description of health status icons 
and alternatives for monitoring chassis health.
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2. Make sure that all modules are fully seated in their slots and that their latches are locked.

3. Make sure that no slots are left open for more than two minutes. 

If you need to replace a module, leave the old module in place until you have the replacement or use a 
blank module to fill the slot. Leaving a slot open negatively affects the airflow and can cause the chassis 
to overheat.

4. Replace each power supply one at a time.

5. Replace the controller modules one at a time. 

Sensor Locations
The storage system monitors conditions at different points within each chassis to alert you to problems. 
Power, cooling fan, temperature, and voltage sensors are located at key points in the chassis. In each 
controller module and expansion module, the EMP monitors the status of these sensors to perform SES 
functions. 

The following sections describe each element and its sensors.

Power Supply Sensors
Each chassis has two fully redundant power supplies with load-sharing capabilities. The power supply 
sensors described in Table 35 below monitor the voltage, current, temperature, and fans in each power 
supply. If the power supply sensors report a voltage that is under or over the threshold, check the input 
voltage.

Description Event/Fault ID LED condition

Power Supply 1 Voltage, current, temperature, or fan fault

Power Supply 2 Voltage, current, temperature, or fan fault

Table 35: Power supply sensor descriptions

Cooling Fan Sensors
Each power supply includes two fans. The normal range for fan speed is 4,000 to 6,000 r/min. When a fan 
speed drops below 4,000 r/min, the EMP considers it a failure and posts an alarm in the storage system’s 
event log. Table 36 on the next page lists the description, location, and alarm condition for each fan. If the fan 
speed remains under the 4,000 r/min threshold, the internal chassis temperature may continue to rise. 
Replace the power supply reporting the fault.
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Description Location Event/Fault ID LED condition

Fan 1 Power Supply 1 < 4,000 r/min

Fan 2 Power Supply 1 < 4,000 r/min

Fan 3 Power Supply 2 < 4,000 r/min

Fan 4 Power Supply 2 < 4,000 r/min

Table 36: Cooling fan sensor descriptions

During a shutdown, the cooling fans do not shut off. This allows the chassis to continue cooling.

Temperature Sensors
Extreme high and low temperatures can cause significant damage if they go unnoticed. Each controller 
module has six temperature sensors. Of these, if the CPU or FPGA temperature reaches a shutdown value, 
the controller module is automatically shut down. Each power supply has one temperature sensor.

When a temperature fault is reported, it must be remedied as quickly as possible to avoid system damage. 
This can be done by warming or cooling the installation location.

Description Normal operating 
range

Warning operating 
range

Critical operating 
range

Shutdown 
values

CPU temperature 3°C – 88°C 0°C – 3°C, 
88°C – 90°C

> 90°C 0°C 
100°C

FPGA temperature 3°C – 97°C 0°C – 3°C, 
97°C – 100°C

None 0°C
105°C

Onboard 
temperature 1                         

0°C – 70°C                         None                         None None                         

Onboard 
temperature 2                         

0°C – 70°C                         None                         None None

Onboard 
temperature 3
(Capacitor 
temperature)

0°C – 70°C None None None

CM temperature 5°C – 50°C ≤ 5°C,
≥ 50°C

≤ 0°C,
≥ 55°C

None

Table 37: Controller module temperature sensor descriptions

When a power supply sensor goes out of range, the Fault/ID LED illuminates amber and an event is posted 
to the event log.
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Description Normal operating range

Power Supply 1 temperature –10°C – 80°C

Power Supply 2 temperature –10°C – 80°C                         

Table 38: Power supply temperature sensor descriptions

Power Supply Voltage Sensors
Power supply voltage sensors ensure that an chassis power supply voltage is within normal ranges. There 
are three voltage sensors per power supply.

Sensor Event/Fault LED condition

Power Supply 1 voltage, 12V < 11.00V
> 13.00V

Power Supply 1 voltage, 5V < 4.00V
> 6.00V

Power Supply 1 voltage, 3.3V < 3.00V
> 3.80V

Table 39: Voltage sensor descriptions
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This chapter contains the following topics:

QX/QXS Cache Status LED details 157

LEDs for 12-, 24-, 48-Drive Systems 158

12-, 24-, 48-Drive Expansion Chassis Rear Panel LEDs 174

LEDs for 56-Drive RAID Chassis (4U56) 175

LEDs for 56-Drive Expansion Chassis 183

QX/QXS Cache Status LED details
If the LED is blinking evenly, a cache flush is in progress. When a controller module loses power and write 
cache is dirty (contains data that has not been written to drive), the supercapacitor pack provides backup 
power to flush (copy) data from write cache to CompactFlash memory. When cache flush is complete, the 
cache transitions into self-refresh mode.

If the LED is blinking momentarily slowly, the cache is in a self-refresh mode. In self-refresh mode, if primary 
power is restored before the backup power is depleted (3–30 minutes, depending on various factors), the 
system boots, finds data preserved in cache, and writes it to drive. This means the system can be 
operational within 30 seconds, and before the typical host I/O time-out of 60 seconds, at which point system 
failure would cause host-application failure. If primary power is restored after the backup power is depleted, 
the system boots and restores data to cache from CompactFlash, which can take about 90 seconds.

QX and QXS Setup Guide 157
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The cache flush and self-refresh mechanism is an important data protection feature; essentially four copies 
of user data are preserved: one in controller cache and one in CompactFlash of each controller.

The LED becomes solid green during the boot-up process. This indicates the cache is logging all POSTs, 
which will be flushed to the CompactFlash the next time the controller shuts down.

Caution: If the Cache Status LED is solid green, the controller should be shut-down from the user 
interface so unwritten data can be flushed to the CompactFlash.

LEDs for 12-, 24-, 48-Drive Systems
This section contains the following information:

 l LEDs for 12-Drive RAID Chassis (2U12) on the next page

 l LEDs for 24-Drive RAID Chassis (2U24) on page 161

 l LEDs for 48-Drive RAID Chassis (2U48) on page 163

 l Drive LEDs on page 165

 l Components for 12-, 24-, 48-Drive RAID Chassis (Rear View) on page 168

 l Controller I/O Module for 12-, 24-, 48-Drive RAID Chassis LEDs (Rear View) on page 169

 l Controller I/O Module (Older) for 12-, 24-, 48-Drive RAID Chassis LEDs (Rear View) on page 171

 l Power Supply LEDs for 12-, 24-, 48-Drive Systems on page 172
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LEDs for 12-Drive RAID Chassis (2U12)
Figure 111: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

LED Description Definition

1 Chassis ID 
LED 

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis  begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Unit Locator White blink — Chassis is identified
Off — Normal operation

3 Fault/Service 
Required 

Amber — On
Chassis-level fault condition exists. The event has been acknowledged but the 
problem needs attention.
Off — No fault condition exists.

4 FRU OK Green — On
The chassis is powered on with at least one power supply operating normally.
Off — Both power supplies are off; the system is powered off.

Table 40: LEDs for 12-Drive RAID Chassis front panel (bezel installed)
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LED Description Definition

5 Temperature 
Fault

Green — On
The chassis temperature is normal.
Amber — On
The chassis temperature is above threshold.

Figure 112: LEDs for 12-Drive System with bezel removed
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LED Description Definition

1 Chassis/
Enclosure 
ID

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis  begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Drive — 
Upper LED

See LEDs for 12-, 24-, 48-Drive Systems on page 158.

3 Drive — 
Lower LED

See LEDs for 12-, 24-, 48-Drive Systems on page 158.

4 Drive(s) 12 drives (numbered 0-11)

Table 41: LEDs for 12-Drive RAID Chassis front panel (bezel removed)
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LEDs for 24-Drive RAID Chassis (2U24)
Figure 113: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

LED Description Definition

1 Chassis ID 
LED 

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis  begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Unit Locator White blink — Chassis is identified
Off — Normal operation

3 Fault/Service 
Required 

Amber — On
Chassis-level fault condition exists. The event has been acknowledged but the 
problem needs attention.
Off — No fault condition exists.

4 FRU OK Green — On
The chassis is powered on with at least one power supply operating normally.
Off — Both power supplies are off; the system is powered off.

5 Temperature 
Fault

Green — On
The chassis temperature is normal.
Amber — On
The chassis temperature is above threshold.

Table 42: LEDs for 12-Drive RAID Chassis front panel (bezel installed)
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Figure 114: LEDs for 24-Drive With Bezel Removed

Left Ear Right Ear

LED Description Definition

1 Chassis/
Enclosure 
ID 

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of the RAID chassis begins with the integer 
0. The chassis ID for an attached expansion chassis is nonzero.

2 Drive — Left 
LED

See LEDs for 12-, 24-, 48-Drive Systems on page 158.

3 Drive — 
Right LED

See LEDs for 12-, 24-, 48-Drive Systems on page 158.

4 Drive(s) 24 drives (numbered 0-23)

Table 43: LEDs for 24-Drive With Bezel Removed
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LEDs for 48-Drive RAID Chassis (2U48)
Figure 115: 2U Drive Chassis (Bezel Installed)
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1. Chassis ID LED

2. Chassis  Status LED: Unit Locator

3. Chassis  Status LED: Fault/Service Required 

4. Chassis  Status LED: FRU OK

5. Chassis  Status LED: Temperature Fault

LED Description Definition

1 Chassis ID 
LED 

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis  begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Unit Locator White blink — Chassis is identified
Off — Normal operation

3 Fault/Service 
Required 

Amber — On
Chassis-level fault condition exists. The event has been acknowledged but the 
problem needs attention.
Off — No fault condition exists.

4 FRU OK Green — On
The chassis is powered on with at least one power supply operating normally.
Off — Both power supplies are off; the system is powered off.

Table 44: LEDs for 12-Drive RAID Chassis front panel (bezel installed)
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LED Description Definition

5 Temperature 
Fault

Green — On
The chassis temperature is normal.
Amber — On
The chassis temperature is above threshold.

Figure 116: LEDs for 48-Drive RAID Chassis with bezel removed
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LED Description Definition

1 Chassis/
Enclosure ID

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis  begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 FRU OK Green — On
The chassis is powered on with at least one power supply operating normally.
Off — Both power supplies are off; the system is powered off.

3 Fault/Service 
Required 

Amber — On
Chassis-level fault condition exists. The event has been acknowledged but the problem 
needs attention.
Off — No fault condition exists.

4 OK to 
Remove

Blue — On

The drawer is prepared for removal.

Off — The drawer is not prepared for removal.

5 Unit Locator White blink — Chassis is identified
Off — Normal operation

Table 45: LEDs for 48-Drive System front panel (bezel removed)
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Drive LEDs
Figure 117: 3.5" LFF drive
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Figure 118: 2.5" SFF drive
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LED 
No./Description

Color State Definition

1— 
Power/Activity

Green On
Blink

Off

The drive module is operating normally.
The drive module is initializing; active and processing I/O; performing a 
media scan; or the vdisk is initializing or reconstructing.
If not illuminated and Fault is not illuminated, the drive is not powered on.

  2— Fault Unlit Off When this LED is not lit, and the Power/Activity LED is green, this 
indicates the normal operating state of the drive, and there are currently 
no failures conditions for the drive.

Amber On

Blink
Off

The drive has failed; experienced a fault; is a leftover; or the vdisk that it 
is associated with is down or critical.
Physically identifies the drive; or locates a leftover (also see Blue).
If not illuminated and Power/Activity is not illuminated, the drive is not 
powered on.

Blue Blink Leftover drive from vdisk is located (alternates blinking amber).

Table 46: LEDs: Drive

Note: If a user interface shows the drive LED is Fault (amber), while the chassis shows it is green, the 
fault might be in the midplane or the drive’s midplane connector.

Drive module LED behavior LFF — 12-drive SFF — 24-drive

Description State Color Action Color Action

Drive OK, FTOL Off None None None None

On (operating normally) Green On Green On

OK to remove Green Blink Green On

Blue On Blue On

Identifying self — offline/online Amber Blink Green1 On

Amber Blink

Drive I/O Initializing Green Blink Green Blink

Active and processing I/O Green Blink Green Blink

Performing a media scan Green Blink Green Blink

Table 47: LEDs: Drives in LFF and SFF chassis 
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Drive module LED behavior LFF — 12-drive SFF — 24-drive

Description State Color Action Color Action

Drive leftover Drive is a leftover Amber On Amber On

Identifying a leftover Amber Blink Amber Blink

Blue1 On Blue1 Blink

Drive failed Fault or failure Amber On Green1 On

Amber On

Fault and remove drive Amber On Green On

Blue On Amber On

Fault and identify drive Amber Blink Green On

Amber On

Fault, identify, and remove drive Amber Blink Green On

Blue On Amber Blink

Blue On

1This color may or may not illuminate.

Note: If a user interface shows the drive LED is Fault (amber), while the chassis shows it is green, the 
fault might be in the midplane or the drive’s midplane connector.

Vdisk LED behavior LFF — 12-drive1 SFF — 24-drive

Description State Color Action Color Action

FTOL On (operating normally) Green Blink Green On

Vdisk activity Vdisk is reconstructing Green Blink Green Blink

Vdisk is initializing Green Blink Green Blink

Vdisk degraded Vdisk is critical/down See note 1 below See note 1 below

Table 48: LEDs: Vdisks in LFF and SFF chassis 

1Individual drives will display fault LEDs
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Components for 12-, 24-, 48-Drive RAID Chassis (Rear 
View)
The diagram and table below display and identify important component items that comprise the rear panel 
layout of a QXS Storage RAID Chassis . The image shown is a representative example of a RAID Chassis  
included in the product series.

Figure 119: Example RAID Chassis: Rear panel layout

1. AC power supplies 

2. Controller module A

3. Controller module B

4. FC ports: host interface

5. CLI port (USB - Type B) 

6. Reserved for future use

7. Network port

8. Service port (used by service personnel only)

9. Disabled button (used by engineering/test only)

10. Expansion port

11. DC Power supply (2) — (DC model only)

12. DC Power switch

A RAID Chassis  accommodates two power supply FRUs of the same type (either both AC or both DC) 
within the two power supply slots. The RAID Chassis  accommodates up to two controller I/O modules of the 
same type within the IOM slots.

This section provides descriptions for the different controller I/O modules and power supplies that can be 
installed into the rear panel of a QXS Storage RAID Chassis . Showing controller I/O modules and power 
supplies separately from the chassis enables improved clarity in identifying the component items called out 
in the diagrams and described in the tables.

LED descriptions are also provided for optional expansion chassis supported by the QXS Storage RAID 
chassis .
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Controller I/O Module for 12-, 24-, 48-Drive RAID Chassis 
LEDs (Rear View)
Figure 120 below provides a representative example of the controller I/O module. It lists the location and 
description of the controller I/O module LEDs.

Note: QXS-3, QXS-4, and QXS-6 Series systems offer a SAS and a CNC controller I/O module (FC 
and iSCSI). The QXS-1200, QXS-2400, and QXS-5600 use only a FC controller I/O module.

Figure 120: LEDs: controller I/O module (FC and 10GbE SFPs)
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LED Description Definition

1 Host 4/8/16 
Gb FC1

Link Status/
Link Activity

Off — No link detected.
Green — The port is connected and the link is up.
Blinking green — The link has I/O or replication activity.

2 Host 10GbE 
iSCSI2,3 
Link Status/
Link Activity

Off — No link detected.
Green — The port is connected and the link is up.
Blinking green — The link has I/O or replication activity.

3 Network Port 
Link 
Active 
Status4

Off — The Ethernet link is not established, or the link is down.
Green — The Ethernet link is up (applies to all negotiated link speeds).

4 Network Port 
Link Speed4

Off — Link is up at 10/100base-T negotiated speeds.

Amber — Link is up and negotiated at 1000base-T.

5 OK to 
Remove

Off — The controller I/O module is not prepared for removal.

Blue — The controller I/O module is prepared for removal.

Table 49: Controller I/O module LEDs
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LED Description Definition

6 Unit Locator Off — Normal operation.
Blinking white — Physically identifies the controller module.

7 FRU OK Off — Controller I/O module is not OK.
Blinking green — System is booting.

Green — Controller I/O module is operating normally.

8 Fault/Service 
Required

Amber — A fault has been detected or a service action is required.
Blinking amber — Hardware-controlled power-up or a cache flush or restore error.

9 Cache 
Status

Green — Cache is dirty (contains unwritten data) and operation is normal. The unwritten 
information can be log or debug data that remains in the cache, so a Green cache status 
LED does not, by itself, indicate that any user data is at risk or that any action is 
necessary.
Off — In a working controller, cache is clean (contains no unwritten data).
This is an occasional condition that occurs while the system is booting.
Blinking green — A CompactFlash flush or cache self-refresh is in progress, indicating 
cache activity. 

10 Expansion 
Port Status

Off — The port is empty or the link is down.
On — The port is connected and the link is up.

Note: Once a Link Status LED is lit, it remains so, even if the controller is shut down via the disk 
management utility or the CLI.

When a controller is shut down or otherwise rendered inactive—its Link Status LED remains illuminated— 
falsely indicating that the controller can communicate with the host. Though a link exists between the host 
and the chip on the controller, the controller is not communicating with the chip. To reset the LED, the 
controller must be power-cycled.



Chapter 6: LED Descriptions
LEDs for 12-, 24-, 48-Drive Systems

QX and QXS Setup Guide 171

Controller I/O Module (Older) for 12-, 24-, 48-Drive RAID 
Chassis LEDs (Rear View)
Figure 121: Controller I/O Module LEDs

LED No./Description Color State Definition

1 — Host 2/4/8 Gbit FC
Link Status/
Link Activity

Green On

Off
Blink

Port is connected and the link is up.
2,4 G LED illuminates — link speed is 2 or 4 Gbit/s
8 G LED illuminates — link speed is 8 Gbit/s
Both LEDs off — link speed is 1 Gbit/s1

1Hz — no link detected

2 — Network Port 
Activity

Green Off
Blink

Ethernet link has no I/O activity.
Ethernet link has I/O activity.

3 — Network Port Link 
Status

Green On
Off

The Ethernet link is up.
Ethernet port is not connected or the link is down.

4 — OK to Remove Blue On
Off

The controller I/O module can be removed.
The controller I/O module is not prepared for removal.

5 — Unit Locator White Off
Blink

Normal operation.
Physically identifies the controller module.

6 — FRU OK Green On
Off
Blink

Controller I/O module is operating normally.
Controller I/O module is not OK.
System is booting.

Table 50: Rear panel LEDs
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LED No./Description Color State Definition

7 — Fault/Service 
Required

Amber On
Blink

A fault is detected or a service action is required.
Hardware-controlled power-up, or a cache flush or restore error.

8 — Cache Status Green On

Off
Blink

Cache is dirty (contains unwritten data) and operation is normal.
Cache is clean (contains no unwritten data).

CompactFlash flush or cache self-refresh is in progress, 
indicating cache activity.
(See QX/QXS Cache Status LED details on page 157)

9 — Expansion Port 
Status

Green On
Off

Port is connected and the link is up.
Port is empty or link is down.

1The 8 Gbit SFP modules do not support 1 Gbit link speeds.

Once a Link Status LED is lit, it remains so, even if the controller is shut down via the Disk Storage 
Management Utility or CLI.

When a controller is shut down or otherwise rendered inactive, its Link Status LED remains illuminated, 
falsely indicating that the controller can communicate with the host. Though a link exists between the host 
and the chip on the controller, the controller is not communicating with the chip. To reset the LED, the 
controller must be power-cycled (see Power On/Power Off on page 85).

Power Supply LEDs for 12-, 24-, 48-Drive Systems
Power redundancy is achieved through two independent load-sharing power supplies. In the event of a 
power supply failure, or the failure of the power source, the storage system can operate continuously on a 
single power supply. Greater redundancy can be achieved by connecting the power supplies to separate 
circuits. DC power supplies are equipped with a power switch. AC power supplies may or may not have a 
power switch (the newer model in Figure 122 on the next page has no power switch). Whether a power 
supply has a power switch is significant to powering on/off.
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Figure 122: Power supply for AC model
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Figure 123: Power supply for DC model
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LED No./Description Color State Definition

1 — Input Source Power 
Good

Green On Power is on and input voltage is normal.

Off Power is off, or input voltage is below the minimum 
threshold.

2 — Voltage/Fan 
Fault/Service Required

Amber On Output voltage is out of range, or a fan is operating below the 
minimum required r/min.

Off Output voltage is normal.

Table 51: Power supply LEDs

Note: See Power On/Power Off on page 85 for information on power-cycling chassis.
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12-, 24-, 48-Drive Expansion Chassis Rear 
Panel LEDs

Note: The QXS-2400 SSD ships as a RAID chassis (RBOD) only. The QXS-2400 SSD does not 
support any additional drive expansions (JBODs).

The rear panel layouts of the 12-, 24-, 48-Drive Expansion Chassis are basically identical. All models 
support 6-Gbit/s. Accordingly, the expansion chassis feature a “6 Gb/s” label above each SAS 
(ingress/egress) expansion port.

Newer models of these drive expansion chassis feature AC power supplies without power switches, as per 
the system shown below. See Power On/Power Off on page 85 for more information.

Figure 124: 12-, 24-, 48-Drive Expansion Chassis
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LED No./Description Color State Definition

1 — Power Supply — — See Power Supply LEDs on page 185.

2 — Unit Locator White Off
Blink

Normal operation.
Physically identifies the expansion module.

3 — OK to Remove Blue Off Not implemented.

4 — Fault/Service Required Amber On
Blink

A fault is detected or a service action is required.
Hardware-controlled power-up.

5 — FRU OK Green On
Off
Blink

Expansion I/O module is operating normally.
Expansion I/O module is not OK.
System is booting.

Table 52: Expansion chassis  rear panel LEDs
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LED No./Description Color State Definition

6 — SAS In Port Status Green On
Off

Port is connected and the link is up.
Port is empty or link is down.

7 — SAS Out Port Status Green On
Off

Port is connected and the link is up.
Port is empty or link is down.

LEDs for 56-Drive RAID Chassis (4U56)
This section contains the following information:

 l LEDs Visible with Chassis Bezel Installed below

 l LEDs Visible with Chassis Bezel Removed on the next page

 l Drive LEDs on page 178

 l Controller I/O Module LEDs on page 181

 l Power Supply LEDs on page 185

 l Fan Control Module LEDs on page 186

LEDs Visible with Chassis Bezel Installed
The LEDs located on the chassis ears are described in Figure 125 below and are visible with the chassis 
bezel installed.

Figure 125: LEDs: 4U56 chassis front panel
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LED Description Definition

1 Chassis/
Enclosure ID

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Unit Locator White blink — Chassisis identified
Off — Normal operation

3 Fault/Service 
Required 

Amber — On
Chassis-level fault condition exists. The event has been acknowledged but the problem 
needs attention.
Off — No fault condition exists.

4 FRU OK Green — On
The chassis is powered on with at least one power supply operating normally.
Off — Both power supplies are off; the system is powered off.

5 Temperature 
Fault

Green — On
The chassis temperature is normal.
Amber — On
The chassis temperature is above threshold.

Table 53: Chassis Front Panel LEDs (bezel installed)

Note: The chassis front panel illustrations that follow assume that you have removed the chassis bezel 
to reveal underlying components.

LEDs Visible with Chassis Bezel Removed
The chassis bezel is removed to reveal the underlying 4U56 chassis front panel LEDs. The front panel 
LEDs—including ear LEDs and drawer panel LEDs—are described in the table below the illustration 
(Figure 126 on the next page).
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Figure 126: LEDs: 4U56 chassis front panel
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LED Description Definition

1 Chassis/
Enclosure ID

Green — On
Enables you to correlate the chassis with logical views presented by management 
software. Sequential chassis ID numbering of RAID Chassis begins with the integer 0. 
The chassis ID for an attached expansion chassis is nonzero.

2 Unit Locator White blink — Chassis is identified
Off — Normal operation

3 OK to 
Remove

Blue — On (The drawer is prepared for removal.)
Off — The drawer is not prepared for removal.

4 Fault/Service 
Required 

Amber — On
Drawer-level fault condition exists. The event has been acknowledged but the problem 
needs attention.
Amber — Blink (Hardware-controlled power-up.)
Off — No fault condition exists.

5 FRU OK Green — On (The drawer is powered on with at least one power supply operating 
normally.)
Green — Blink (The drawer is initializing.)
Off — The drawer is not OK.

Table 54: RAID Chassis Front Panel LEDs (bezel removed)

The chassis bezel for this model provides the EMI protection for the LFF drive modules. The bezel should be 
securely attached to the chassis during operation.
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Caution: To ensure adequate EMI protection for the LFF drives, the chassis bezel should be properly 
installed while the chassis is in operation.

Drive LEDs
You must remove the chassis bezel to facilitate visual observation of the drawers containing drive modules. 
To view drives in a drawer, you must open the drawer. Alternatively, you can use management interfaces to 
monitor drive LED behavior. See Figure 127 below for the drive LEDs.

Figure 127: LEDs: Drive modules
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LED mode 
description

Color State Definition

1—
Power/Activity

Green On

Blink

 

Off

The drive is operating normally.
The drive module is initializing; active and processing I/O; performing a 
media scan; or the vdisk or drive group is initializing or reconstructing.
No identify or remove requests are active. If not illuminated and Fault is not 
illuminated, the drive is not powered on.

Table 55: Drive LEDs



Chapter 6: LED Descriptions
LEDs for 56-Drive RAID Chassis (4U56)

QX and QXS Setup Guide 179

LED mode 
description

Color State Definition

2—Fault Amber On

Blink
Off

The drive has failed; experienced a fault; is a leftover; or the drive group that 
it is associated with is down or critical.
Physically identifies the drive; or locates a leftover (also see Blue).
If not illuminated and Power/Activity is not illuminated, the drive is not 
powered on.

Blue Blink Leftover drive from drive group is located (alternates blinking amber).

Table 56 below provides additional information on the QXS-456 LFF drive LEDs.

Drive module LED behavior LFF drives

Description State Color Action

Drive OK, FTOL Off None None

On (operating normally) Green On

OK to remove Green Blink

Blue On

Identifying self - offline/online Green1 On

Amber Blink

Drive I/O Initializing Green Blink

Active and processing I/O Green Blink

Performing a media scan Green Blink

Drive leftover Drive is a leftover Amber On

Identifying a leftover Amber Blink

Blue1 On

Table 56: LEDs: Drives in LFF chassis 



Chapter 6: LED Descriptions
LEDs for 56-Drive RAID Chassis (4U56)

QX and QXS Setup Guide 180

Drive module LED behavior LFF drives

Description State Color Action

Drive failed Fault or failure Green1 On

Amber On

Fault and remove drive Green On

Amber On

Fault and identify drive Green On

Amber On

Fault, identify, and remove drive Green On

Amber Blink

Blue On

1This color may or may not illuminate.

Drive group LED behavior LFF drives

Description State Color Action

FTOL On (operating normally) Green On

Drive group activity Drive group is reconstructing Green Blink

Drive group is initializing Green Blink

Drive group degraded Drive group is critical/down See note 1 below

1Individual drives will display fault LEDs.

Table 57: LEDs: Drive groups in LFF chassis 

RAID Chassis LEDs Rear Panel Layout
The diagram and table below display and identify important component items that comprise the rear panel 
layout of the 56-drive RAID Chassis. Diagrams and tables on the following pages describe rear panel LED 
behavior.
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Figure 128: QXS-5600 rear panel
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1. Controller I/O module A

2. Controller I/O module B

3. AC power supply switch

4. AC power supply

5. Fan control module

6. CNC ports: used for host connection or replication

7. Network port

8. Disabled button (used by engineering/test only)
(Stickers shown covering the openings)

9. SAS expansion port

10. CLI port (USB - Type B)

11. Service port 2 (used by service personnel only)

12. Reserved for future use

13. Service port 1 (used by service personnel only)

The RAID Chassis accommodates two controller I/O modules of the same type within the I/O module (IOM) 
slots (see callouts No.1 and No.2 above). The RAID Chassis accommodates two AC power supplies within 
the two power supply slots (see two instances of callout No.4 above). Beneath each power supply is a 
power supply switch (see two instances of callout No.3 above). The RAID Chassis accommodates two fan 
control modules (see two instances of callout No.5 above).

Caution: The 56-drive RAID Chassis supports dual-controller configuration only. Single-controller 
support is provided only when a controller fails over to its partner controller. A controller module must 
be installed in each IOM slot to ensure sufficient airflow through the chassis during operation.

Controller I/O Module LEDs
The following figure provides a representative example of the controller I/O module. It lists the location and 
description of the controller I/O module LEDs.
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Note: QXS-3, QXS-4, and QXS-6 Series systems offer a SAS and a CNC controller I/O module (FC 
and iSCSI). The QXS-1200, QXS-2400, and QXS-5600 use only a FC controller I/O module.

Figure 129: LEDs: controller module (FC and 10GbE SFPs)
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LED Description Definition

1 Host 4/8/16 
Gb FC1

Link Status/
Link Activity

Off — No link detected.
Green — The port is connected and the link is up.
Blinking green — The link has I/O or replication activity.

2 Host 10GbE 
iSCSI2,3 
Link Status/
Link Activity

Off — No link detected.
Green — The port is connected and the link is up.
Blinking green — The link has I/O or replication activity.

3 Network Port 
Link 
Active 
Status4

Off — The Ethernet link is not established, or the link is down.
Green — The Ethernet link is up (applies to all negotiated link speeds).

4 Network Port 
Link Speed4

Off — Link is up at 10/100base-T negotiated speeds.
Amber — Link is up and negotiated at 1000base-T.

5 OK to 
Remove

Off — The controller module is not prepared for removal.
Blue — The controller module is prepared for removal.

6 Unit Locator Off — Normal operation.
Blinking white — Physically identifies the controller module.

7 FRU OK Off — Controller module is not OK.
Blinking green — System is booting.
Green — Controller module is operating normally.

Table 58: Controller module LEDs
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LED Description Definition

8 Fault/Service 
Required

Amber — A fault has been detected or a service action is required.
Blinking amber — Hardware-controlled power-up or a cache flush or restore error.

9 Cache 
Status

Green — Cache is dirty (contains unwritten data) and operation is normal. The unwritten 
information can be log or debug data that remains in the cache, so a Green cache status 
LED does not, by itself, indicate that any user data is at risk or that any action is 
necessary.
Off — In a working controller, cache is clean (contains no unwritten data).
This is an occasional condition that occurs while the system is booting.
Blinking green — A CompactFlash flush or cache self-refresh is in progress, indicating 
cache activity. 

10 Expansion 
Port Status

Off — The port is empty or the link is down.
On — The port is connected and the link is up.

Note: Once a Link Status LED is lit, it remains so, even if the controller is shut down via the disk 
management utility or the CLI.

When a controller is shut down or otherwise rendered inactive—its Link Status LED remains illuminated— 
falsely indicating that the controller can communicate with the host. Though a link exists between the host 
and the chip on the controller, the controller is not communicating with the chip. To reset the LED, the 
controller must be power-cycled.

LEDs for 56-Drive Expansion Chassis
The RAID Chassis support LFF 56-drive expansion chassis for increased storage capacity. These drive 
expansion chassis use mini-SAS (SFF-8088) connectors to facilitate backend SAS expansion. 
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Figure 130: 56-Drive Expansion Chassis
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LED No./Description Color State Definition

1 — Power Supply — — See Power Supply LEDs on the next page.

2 — Fan Control Module — — See Fan Control Module LEDs on page 186.

3 — Unit Locator White Off
Blink

Normal operation.
Physically identifies the expansion module.

4 — OK to Remove Blue Off Not implemented. 

5 — FRU OK Green On
Off
Blink

Expansion I/O module is operating normally.
Expansion I/O module is not OK.
System is booting.

6 — Fault/Service Required Amber On
Blink

A fault is detected or a service action is required.
Hardware-controlled power-up.

7 — SAS In Port Status Green On
Off

Port is connected and the link is up.
Port is empty or link is down.

8 — SAS Out Port Status Green On
Off

Port is connected and the link is up.
Port is empty or link is down.

Table 59: 56-Drive Expansion Chassis 
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Power Supply LEDs
Power redundancy is achieved through two independent load-sharing power supplies. In the event of a 
power supply failure, or the failure of the power source, the storage system can operate continuously on a 
single power supply. Greater redundancy can be achieved by connecting the power supplies to separate 
circuits. See Figure 131 below for power supply LEDs and description.

Figure 131: LEDs: Power supply units — rear panel

1

2

3

4

LED No./Description Color State Definition

1 — AC Input Source Green On Power is on and input voltage is normal.

Off No AC input to power supply.

2 — Voltage/Fan 
Fault/Service Required

Amber On
Blinking

Output voltage is out of range, or a fan is operating below 
the minimum required RPM.

Off Fault not detected.

3 — DC Power Green On Main output power on.

Off Power is off; main output is off; or a fault is detected.

4 — Power supply switch NA NA NA

Table 60: Power supply LEDs
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Fan Control Module LEDs
See Figure 132 below for the fan control module LEDs.

Figure 132: LEDs: Fan control modules — rear panel

1

2

3

LED No./Description Color State Definition

1 — FRU OK Green On Power is on with at least one fan operating normally.

Off Both fans are off; the system is powered off.

2 — Fault/Service 
Required

Amber On Fault detected; event has been acknowledged but the problem 
needs attention.

Off No fault condition exists.

3 — Unit locator White On FRU is identified.

Off Normal operation.

Table 61: Fan control module LEDs
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Site Requirements and Guidelines
The following sections provide requirements and guidelines that you must address when preparing your site 
for the installation.

When selecting an installation site for the system, choose a location not subject to excessive heat, direct 
sunlight, dust, or chemical exposure. These conditions greatly reduce the system’s longevity and might void 
your warranty.

Site Wiring and AC Power Requirements
The following are required for all installations using AC power supplies:
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Measurement Rating for 2U12/2U24 Rating for 2U48 Rating for 4U56

Input power 
requirements

100 to 240VAC, 50/60Hz, 
7.2A

100 to 240VAC, 50/60Hz 200 to 240VAC, 50/60Hz

Maximum input power 475W maximum continuous 640W maximum 
continuous

958W maximum 
continuous

Heat dissipation 1,622 BTUs/hour 2,245 BTUs/hour 3,271 BTUs/hour

Table 62: Power requirements - AC Input

 l All AC mains and supply conductors to power distribution boxes for the rack-mounted system must be 
enclosed in a metal conduit or raceway when specified by local, national, or other applicable government 
codes and regulations. 

 l Ensure that the voltage and frequency of your power source match the voltage and frequency inscribed 
on the equipment’s electrical rating label.

 l To ensure redundancy, provide two separate power sources for the chassis . These power sources 
must be independent of each other, and each must be controlled by a separate circuit breaker at the 
power distribution point.

 l The system requires voltages within minimum fluctuation. The customer-supplied facilities’ voltage must 
maintain a voltage with not more than  ± 5 percent fluctuation. The customer facilities must also provide 
suitable surge protection.

 l Site wiring must include an earth ground connection to the AC power source. The supply conductors 
and power distribution boxes (or equivalent metal chassis) must be grounded at both ends.

 l Power circuits and associated circuit breakers must provide sufficient power and overload protection. To 
prevent possible damage to the AC power distribution boxes and other components in the rack, use an 
external, independent power source that is isolated from large switching loads (such as air conditioning 
motors, elevator motors, and factory loads).

Site Wiring and DC Power Requirements
The following are required for all installations using DC power supplies:

Measurement Rating for 2U12/2U24 Rating for 4U56

Input power requirements -40 to -72VDC, -48/-60V nominal -40 to -72VDC, -48/-60V nominal

Maximum input power 475W maximum continuous 1,027W maximum continuous

Heat dissipation 1,622 BTUs/hour 3,507 BTUs/hour

Table 63: Power requirements - DC Input

The QXS Storage system is suitable for installation as part of the Common Bonding Network (CBN). The 
system’s Battery Return (BR) Input Terminals are considered to be an Isolated DC Return (DC-I).
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The following criteria are required for all installations:

 l All DC mains and supply conductors to power distribution boxes for the rack-mounted system must 
comply with local, national, or other applicable government codes and regulations. 

 l Ensure that the voltage of your power source matches the voltage inscribed on the equipment’s 
electrical label.

 l To ensure redundancy, provide two separate power sources for the chassis . These power sources 
must be independent of each other, and each must be controlled by a separate circuit breaker at the 
power distribution point.

 l The system requires voltages within minimum fluctuation. The customer-supplied facilities’ voltage must 
maintain a voltage within the range specified on the equipment’s electrical rating label. The customer 
facilities must also provide suitable surge protection.

 l Site wiring must include an earth ground connection to the DC power source. Grounding must comply 
with local, national, or other applicable government codes and regulations.

 l Power circuits and associated circuit breakers must provide sufficient power and overload protection.

Weight and Placement Guidelines
Refer to Physical Requirements on page 191 for detailed size and weight specifications.

 l Refer to the rackmount bracket kit installation sheet pertaining to your product for guidelines about 
installing chassis into the rack.

 l When installing chassis into the rack, populate from the bottom position and move upwards for optimal 
rack stability.

 l The weight of an chassis depends on the number and type of modules installed.

 l Ideally, use two people to lift a chassis . However, one person can safely lift an chassis if its weight is 
reduced by removing the power supplies and drive modules.

 l Do not place chassis in a vertical position. Always install and operate the chassis in a horizontal 
orientation.

 l When installing chassis in a rack, make sure that any surfaces over which you might move the rack can 
support the weight. To prevent accidents when moving equipment, especially on sloped loading docks 
and up ramps to raised floors, ensure you have a sufficient number of helpers. Remove obstacles such 
as cables and other objects from the floor.

 l To prevent the rack from tipping, and to minimize personnel injury in the event of a seismic occurrence, 
securely anchor the rack to a wall or other rigid structure that is attached to both the floor and to the 
ceiling of the room.

Electrical Guidelines
 l These chassis work with single-phase power systems having an earth ground connection. To reduce 

the risk of electric shock, do not plug an chassis into any other type of power system. Contact your 
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facilities manager or a qualified electrician if you are not sure what type of power is supplied to your 
building.

 l Chassis are shipped with a grounding-type (three-wire) power cord. To reduce the risk of electric shock, 
always plug the cord into a grounded power outlet.

 l Do not use household extension cords with the chassis. Not all power cords have the same current 
ratings. Household extension cords do not have overload protection and are not meant for use with 
computer systems. 

Ventilation Requirements
Refer to Environmental Requirements on page 194 for detailed environmental requirements.

 l Do not block or cover ventilation openings at the front and rear of an chassis. Never place an chassis 
near a radiator or heating vent. Failure to follow these guidelines can cause overheating and affect the 
reliability and warranty of your chassis.

 l Leave a minimum of 15.2 cm (6 inches) at the front and rear of each chassis to ensure adequate airflow 
for cooling. No cooling clearance is required on the sides, top, or bottom of chassis .

 l Leave enough space in the front and rear of an chassis to allow access to chassis components for 
servicing. Removing a component requires a clearance of at least 38.1 cm (15 inches) in front of and 
behind the chassis.

Cabling Requirements
 l Keep power and interface cables clear of foot traffic. Route cables in locations that protect the cables 

from damage.

 l Route interface cables away from motors and other sources of magnetic or radio frequency 
interference.

 l Stay within the cable length limitations.

 l QXS Storage RAID chassis and expansion chassis are suitable for connection to intra-building or non-
exposed wiring or cabling only.

 l QXS Storage RAID chassis and expansion chassis are suitable for installation in Network 
Telecommunication Facilities and locations where the NEC applies. QXS Storage RAID chassis and 
expansion chassis are not suitable for Outside Plant (OSP) installations.

Management Host Requirements
A local management host with at least one mini-USB connection is recommended for the initial installation 
and configuration of a RAID chassis. After you configure one or both of the controller modules with an IP 
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address, you then use a remote management host on an Ethernet network to manage and monitor.

Note: Connections to this device must be made with shielded cables – grounded at both ends – with 
metallic RFI/EMI connector hoods, in order to maintain compliance with NEBS and FCC Rules and 
Regulations.

Physical Requirements
The floor space at the installation site must be strong enough to support the combined weight of the rack, 
RAID chassis, expansion chassis, and any additional equipment. The site also requires sufficient space for 
installation, operation, and servicing of the chassis, together with sufficient ventilation to allow a free flow of 
air to all chassis. 

The RAID chassis and expansion chassis is comprised of sheet steel that is bonded together using rivets, 
welding, and other forced contact methods. The metal surfaces are free from non-conductive coatings and 
paint.

Table 64 on the next page and  above show chassis dimensions and weights. Chassis designators are 
described below. Chassis weights assume the following configuration characteristics:

 l 2U12 chassis (LFF):

 l “2U12” denotes the 3.5" QXS-412 chassis (with controller or expansion modules)

 l The 2U12 chassis is equipped with a drive in each drive slot

 l 2U24 chassis (SFF):

 l “2U24” denotes the 2.5" QXS-424chassis (with controller or expansion modules)

 l The 2U24 chassis is equipped with a drive in each drive slot

 l 2U48 chassis (SFF):

 l “2U48” denotes the 2.5" 48-drive chassis (with controller or expansion modules)

 l The 2U48 chassis includes three installed drawers that must be populated with disks and possibly 
AMS inserts if applicable, after the chassis is installed into the rack. The table in this section assumes 
each drive slot contains a disk drive module.

 l 4U56 chassis (high-capacity with LFF drives) 

 l “4U56” denotes the 3.5" 56-drive chassis (with controller or expansion modules) 

 l The 4U56 chassis includes two installed drawer slots that must be populated with drives after the 
chassis is installed into the rack. 

 l Two controller modules or two expansion modules per chassis

 l Two power supplies per chassis
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Specifications Rackmount

2U Height (y-axis): 8.9 cm (3.5 inches)

Width (x-axis):
 l Chassis-only
 l Chassis with ear caps or chassis bezel

 
 l 44.7 cm (17.6 inches)
 l 47.9 cm (18.9 inches)

LFF (2U12):
 l Rear of chassis ear to controller latch
 l Front of chassis ear to rear of cable bend

 
 l 54.9 cm (21.6 inches) 
 l 59.9 cm (23.6 inches)

SFF (2U24):
 l Rear of chassis ear to controller latch
 l Front of chassis ear to rear of cable bend

 
 l 51.8 cm (20.4 inches)
 l 57.9 cm (22.8 inches)

SFF (2U48):
 l Rear of chassis ear to controller latch
 l Front of chassis ear to rear of cable bend

 
 l 74.4 cm (29.3 inches) 
 l 81.5 cm (32.1 inches)

Table 64: 2U Rackmount chassis dimensions

 

Specifications Rackmount

4U Height (y-axis): 17.8 cm (7 inches)

Width (x-axis):
 l Chassis-only
 l Chassis with ear caps or chassis bezel 
 l Rear of chassis ear to controller latch 
 l Front of chassis ear to rear of cable bend 

 
 l 45.1 cm (17.8 inches)
 l 47.9 cm (18.9 inches)
 l 51.8 cm (20.4 inches)
 l 57.9 cm (22.8 inches)

Table 65: 4U56 Rackmount RAID chassis dimensions

Specifications Rackmount

LFF (2U12)
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

9.3 kg (20.6 lb) [chassis]
 l 18.1 kg (40.0 lb)
 l 27.7 kg (61.0 lb)

SFF (2U24):
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

8.6 kg (19.0 lb) [chassis]
 l 17.4 kg (38.4 lb)
 l 23.4 kg (51.6 lb) 

Table 66:  Rackmount RAID chassis weights
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Specifications Rackmount

SFF (2U48):
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

12.7 kg (28.0 lb) [chassis]
 l 23.1 kg (50.9 lb)
 l 34.0 kg (74.9 lb) 

High-capacity controller chassis (4U56)
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

14.9 kg (32.8 lb) [chassis]
 l 46.3 kg (102.1 lb)
 l 87.0 kg (191.7 lb) 

1Weights shown are nominal, and subject to variances.
2Rail kits add between 2.8 kg (6.2 lb) and 3.4 kg (7.4 lb) to the aggregate chassis weight.
3Weights may vary due to different power supplies, IOMs, and differing calibrations between scales.

    4Weights may vary due to actual number and type of drives (SAS SSD, enterprise SAS, or midline SAS) and air management 
modules installed.

Table 67 below provides information about optional drive chassis that are compatible with QXS Storage 
controller chassis.

Specifications Rackmount

2U12  (LFF 3.5" 56-drive chassis)
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

8.6 kg (19.0 lb) [chassis]
 l 16.2 kg (35.8 lb)
 l 22.2 kg (49.0 lb) 

2U24 (SFF 2.5" 24-drive chassis)
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

8.6 kg (19.0 lb) [chassis]
 l 16.1 kg (35.6 lb)
 l 25.6 kg (56.6 lb) 

2U48 (SFF 2.5" 48-drive chassis):
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

12.7 kg (28.0 lb) [chassis]
 l 20.3 kg (44.8 lb)
 l 31.2 kg (68.8 lb) 

High-capacity controller chassis 4U56 (LFF 3.5" 56-drive chassis)
 l Chassis with FRUs (no drives)1-3

 l Chassis with FRUs (including drives)1-4

14.9 kg (32.8 lb) [chassis]
 l 45.0 kg (99.1 lb)
 l 85.6 kg (188.7 lb) 

Table 67: 2U Rackmount compatible drive expansion chassis weights (ordered separately)

1Weights shown are nominal, and subject to variances.
2Rail kits add between 2.8 kg (6.2 lb) and 3.4 kg (7.4 lb) to the aggregate chassis weight.
3Weights may vary due to different power supplies and differing calibrations between scales.

    4Weights may vary due to actual number and type of drives (SAS SSD, enterprise SAS, or midline SAS) and air management 
modules installed.
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Environmental Requirements

Specification Range

Altitude To 3,000 meters (9,843 feet) [2U12/2U24/2U48]

To 1,829 meters (6,000 feet) [4U56]

Temperature* 5ºC to 40ºC (41ºF to 104ºF) 

Humidity 10% to 90% RH up to 40ºC (104ºF) non-condensing

Shock 3.0 g, 11 ms, ½ sine pulses, X, Y, Z

Vibration (Shaped-spectrum) 
5 Hz to 500 Hz, 0.14 Grms total X, Y, Z

Table 68: Operating environmental specifications

*Temperature is de-rated by 2ºC (3.6ºF) for every 1 km (3,281) feet above sea level.

Specification Range

Altitude To 12,000 meters (39,370 feet) 

Temperature -40ºC to 70ºC (-40ºF to 158ºF)

Humidity Up to 93% RH @ 104ºF (40ºC) non-condensing

Shock 15.0 g, 11 ms, ½ sine pulses, X, Y, Z [2U12/2U24/2U48]

1” drop to hard unyielding surface per NEBS GR-63-CORE

Unpackaged Equipment Shock Criteria (§4.3.2) [4U56]

Vibration (Shaped-spectrum)
2.8 Hz to 365.4 Hz, 0.852 Grms total (horizontal)
2.8 Hz to 365.4 Hz, 1.222 Grms total (vertical)

Table 69: Non-operating environmental specifications

Note: For additional information about Telco and ruggedized products, see Quantum’s web site: 
http://www.quantum.com.

http://www.quantum.com/
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Electrical Requirements

Site Wiring and Power Requirements
Each chassis has two power supplies for redundancy. If full redundancy is required, use a separate power 
source for each module. 

The AC power in each power supply is auto-ranging and is automatically configured to an input voltage 
range from 88 – 264 VAC with an input frequency of 47 – 63 Hz. The power supplies meet standard voltage 
requirements for both U.S. and international operation. The power supplies use standard industrial wiring 
with line-to-neutral or line-to-line power connections.

The 2U24/2U12 chassis and the high-density 4U56 chassis support DC power supplies as an alternative to 
using AC power supplies.

Power Cable Requirements
Each power cable connects one of the power supply modules to an independent, external power source. To 
ensure power redundancy, connect the two power cables to two separate circuits; for example, to one 
commercial circuit and one uninterruptible power source (UPS).
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About Electrostatic Discharge
To prevent ESD from damaging the system, be aware of the precautions to consider when setting up the 
system or handling parts. A discharge of static electricity from a finger or other conductor may damage 
system boards or other static-sensitive devices. This type of damage may reduce the life expectancy of the 
device.

Caution: Parts can be damaged by ESD. Follow these precautions:

 l Avoid hand contact by transporting and storing products in static-safe containers.

 l Keep electrostatic-sensitive parts in their containers until they arrive at static-protected workstations.

 l Place parts in a static-protected area before removing them from their containers.

 l Avoid touching pins, leads, or circuitry.

 l Always be properly grounded when touching a static-sensitive component or assembly.

 l Remove clutter (plastic, vinyl, foam) from the static-protected workstation.
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Grounding Methods to Prevent ESD
Several methods are used for grounding. Adhere to the following precautions when handling or installing 
electrostatic-sensitive parts.

Caution: Parts can be damaged by ESD. Use proper anti-static protection:

 l Keep the replacement FRU in the ESD bag until needed; and when removing a FRU from the chassis, 
immediately place it in the ESD bag and anti-static packaging.

 l Wear an ESD wrist strap connected by a ground cord to a grounded workstation or unpainted surface of 
the computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm (± 10 percent) 
resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.

 l If an ESD wrist strap is unavailable, touch an unpainted surface of the chassis before handling the 
component.

 l Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when 
standing on conductive floors or dissipating floor mats.

 l Use conductive field service tools.

 l Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, have an authorized reseller install 
the part. For more information on static electricity or assistance with product installation, contact an 
authorized reseller.
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Rear Panel USB Ports
Quantum QXS Storage controllers contain a USB device management interface. This interface pertains to 
the MC and is accessed via its port on the controller module face plate. 

This section describes the port labeled CLI (USB Type B), which enables direct connection between a 
management computer and the controller, using the CLI and appropriate cable (see Figure 133 on the next 
page for USB port locations). 
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USB the CLI port
Figure 133: USB device connection: CLI port
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1. Connect USB cable to CLI port on controller face plate

Quantum QXS Storage controllers feature a USB CLI port used to cable directly to the controller and initially 
set IP addresses, or perform other configuration tasks. The USB CLI port employs a mini-USB Type B form 
factor, and requires a new cable and additional support, so that a server or other computer running a Linux 
or Windows operating system can recognize the RAID chassis as a connected device. Without this support, 
the computer might not recognize that a new device is connected, or might not be able to communicate with 
it.

For Linux computers, no new driver files are needed, but a Linux configuration file must be created or 
modified (see Linux on page 201). For Windows computers a special device driver file, gserial.inf, must be 
downloaded and installed on the computer that will be cabled directly to the controller’s CLI port (see 
Microsoft Windows on the next page).

Emulated Serial Port
Once attached to the controller module, the management computer should detect a new USB device. Using 
the Emulated Serial Port interface, the QXS Storage controller presents a single serial port using a 
customer vendor ID and product ID. Effective presentation of the emulated serial port assumes the 
management computer previously had terminal emulator installed (see Supported Host Applications 
below). Serial port configuration is unnecessary.

Caution: Certain operating systems require a device driver or special mode of operation to enable 
proper functioning of the USB CLI port (see Device Driver/Special Operation Mode on the next page).

Supported Host Applications
QXS Storage controllers support the following applications to facilitate connection. 
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Application  Operating system

HyperTerminal and TeraTerm Microsoft Windows (all versions)

Minicom Linux (all versions)

Solaris

HP-UX

Table 70: Supported terminal emulator applications

CLI
Once the management computer detects connection to the USB-capable device, the Management 
Controller awaits input of characters from the host computer via the command-line. To see the command-
line prompt, you must press Enter. The MC provides direct access to the CLI.

Note: Directly cabling to the CLI port is an out-of-band connection, because it communicates outside of 
the data paths used to transfer information from a computer or network to the RAID chassis.

Device Driver/Special Operation Mode
Certain operating systems require a device driver or special mode of operation. Product and vendor 
identification information required for such setup is provided in Table 71 below.

USB Identification code type Code

Quantum vendor ID code 0x210C

Quantum QXS Storage product ID code 0xa4a7

Table 71: USB vendor and product identification codes

Microsoft Windows
Microsoft Windows operating systems provide a USB serial port driver. However, the USB driver requires 
details for connecting to Quantum QXS Storage RAID chassis. Quantum provides a device driver for use in 
the Windows environment. Please contact Quantum for instructions about how to download this driver.
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Linux
Although Linux operating systems do not require installation of a device driver, certain parameters must be 
provided during driver loading to enable recognition of the Quantum QXS Storage RAID chassis.

Setting Parameters for the Device Driver
1. Enter the following command:
sudo modprobe usbserial vendor=0x210c product=0xa4a7 use_acm=1

2. Press Enter to execute the command.

The Linux device driver is loaded with the parameters required to recognize the controllers.

Note: Optionally, this information can be incorporated into the /etc./modules.conf file.
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SFP Option for CNC Ports

Locate SFP Transceivers
Locate the qualified SFP options for your CNC controller module within your product ship kit. The SFP 
transceiver (SFP) should look similar to the generic SFP shown in the figure below. Follow the guidelines 
provided in Electrostatic discharge when installing an SFP.
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Figure 134: Install a Qualified SFP Option
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Install an SFP transceiver
For each target CNC port, perform the following procedure to install an SFP. Refer to the figure above when 
performing the steps.

1. Orient the SFP as shown above, and align it for insertion into the target CNC port.

The SFP should be positioned such that the actuator pivot-hinge is on top.

2. If the SFP has a plug, remove it before installing the transceiver. Retain the plug.

3. Flip the actuator open as shown in the figure (near the left detail view).

The actuator on your SFP option may look slightly different than the one shown, and it may not open to a 
sweep greater than 90° (as shown in the figure).

4. Slide the SFP into the target CNC port until it locks into place.

5. Flip the actuator down, as indicated by the down-arrow next to the open actuator in the figure.

The installed SFP should look similar to the position shown in the right detail view.

6. When ready to attach to the host, obtain and connect a qualified fibre-optic interface cable into the 
duplex jack at the end of the SFP connector.

Note: To remove an SFP module, perform the above steps in reverse order.
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Verify Component Operation
View the CNC port Link Status/Link Activity LED on the controller module face plate. A green LED indicates 
that the port is connected and the link is up (see LED descriptions for information about controller module 
LEDs).
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array See storage system

chassis The sheetmetal housing of a drive enclosure (RAID chassis or a expansion chassis). 

controller A (or 
B)

A short way of referring to controller module A (or B).

controller 
enclosure

A drive enclosure known as a RAID chassis that contains two controller modules.

controller 
module

A FRU that contains the following subsystems and devices: an SC processor; an MC 
processor; a SAS expander and an EC processor; management interfaces; cache protected 
by a supercapacitor pack and nonvolatile memory (CompactFlash); host, expansion, network, 
and service ports; and midplane connectivity. In a 4U56 RAID chassis, the right controller 
module is designated A and the left one is designated B. 

DAS Direct Attach Storage. A dedicated storage device that connects directly to a host without the 
use of a switch.

DHCP Dynamic Host Configuration Protocol. A network configuration protocol for hosts on IP 
networks. 

Direct Attach 
Storage

See DAS. 
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drive enclosure A drive enclosure (expansion chassis) that contains two expansion I/O modules. The 
expansion chassis can be connected to a RAID expansion  to provide additional storage 
capacity. 

dual-port drive A drive that is connected to both controllers so its data path is fault-tolerant.

Dynamic Host 
Configuration 
Protocol

See DHCP. 

EC Expander Controller. A processor, located in the SAS expander in each controller module and 
expansion module, that controls the SAS expander and provides SES functionality. See also 
EMP, MC, and SC.

electromagnetic 
interface

See EMI.

EMI Electromagnetic interface.

EMP Enclosure management processor. An EC subsystem that provides SES data such as 
temperature, PSU and fan status, and the presence or absence of drives.

enclosure Called a RAID chassis (containing controllers) or an expansion chassis (containing I/O 
modules). A physical storage device that contains drives and other FRUs.

enclosure 
management 
processor

See EMP.

Expander 
Controller

See EC. 

expansion 
chassis

See drive enclosure.

expansion I/O 
module

A FRU that contains the following subsystems and devices: a SAS expander and EC 
processor; host, expansion, and service ports; and midplane connectivity. In a 2U12, 2U24, or 
2U48 expansion chassis, the upper expansion module is designated A and the lower one is 
designated B.

FC-AL Fibre Channel Arbitrated Loop. The FC topology in which devices are connected in a one-way 
loop.

Fibre Channel 
Arbitrated Loop

See FC-AL. 

field-
programmable 
gate array

See FPGA. 
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field-
replaceable unit

See FRU. 

FPGA Field-programmable gate array. An integrated circuit designed to be configured after 
manufacturing.

FRU Field-replaceable unit. A part that can be removed and replaced by the user or support 
technician without having to send the product to a repair facility.

HBA Host bus adapter. A device that facilitates I/O processing and physical connectivity between a 
host and the storage system. 

host An external port that the storage system is connected to. The external port may be a port in an 
I/O adapter in a server, or a port in a network switch. Product interfaces use the terms host 
and initiator interchangeably.

host port A port on a controller module that interfaces to a host computer, either directly or through a 
network switch. 

host bus 
adapter

See HBA.

I/O module See IOM. 

intrinsic 
methods

Methods inherited from CIM and present in all classes such as getclass, createinstance, 
enumerateinstances, and associatorNames in SMI-S. 

IOM I/O module. An IOM can be either a controller module or an expansion module. 

JBOD “Just a bunch of disks.” See also drive enclosure.

large form 
factor

See LFF. 

leftover The state of a drive that the system has excluded from a vdisk because the timestamp in the 
drive’s metadata is older than the timestamp of other drives in the vdisk, or because the drive 
was not detected during a rescan. A leftover drive cannot be used in another vdisk until the 
drive’s metadata is cleared; for information and cautions about doing so, see documentation 
topics about clearing drive metadata.

LFF Large form factor. A type of 3.5 inch drive.

Logical Unit 
Number

See LUN. 

loop FC-AL topology. 

LUN Logical Unit Number. A number that identifies a mapped Volume to a host.

Management 
Controller

See MC. 
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map/mapping Settings that specify whether a volume is presented as a storage device to a host, and how 
the host can access the volume. Mapping settings include an access type (read-write, read-
only, or no access), controller host ports through which initiators may access the volume, and 
a LUN that identifies the volume to the host. 

MC Management Controller. A processor located in a controller module that is responsible for 
human-computer interfaces and computer-computer interfaces, including the WBI, CLI, and 
FTP interfaces, and interacts with the SC. See also EC and SC.

metadata Data in the first sectors of a drive that stores all drive-, vdisk-, and volume-specific information 
including vdisk membership or spare ID, vdisk ownership, volumes in the vdisk, host mapping 
of volumes, and results of the last media scrub.

MMF Multimode fiber.

mount To enable access to a volume from a host OS.

multimode fiber See MMF. 

network port An Ethernet port on a controller module through which its MC is connected to the network. 

point-to-point The FC topology where two ports are directly connected.

POST Power-On Self Test. Tests that run immediately after a device is powered on.

Power-on Self 
Test

See POST.

Power Supply 
Unit

See PSU.

PSU Power Supply Unit. The power supply FRU. 

RAID chassis A drive enclosure known as a RAID chassis that contains two controller modules.

recovery In an active-active configuration, recovery is the act of returning ownership of controller 
resources to a controller (which was offline) from its partner controller. The resources include 
volumes, cache data, host ID information, and LUNs and WWNs.

SC Storage Controller. A processor located in a controller module that is responsible for RAID 
controller functions. The SC is also referred to as the RAID controller. See also EC and MC.

SCSI 
Enclosure 
Services

See SES. 

secure shell See SSH. 

SES SCSI Enclosure Services. The protocol that allows the initiator to communicate with the 
chassis using SCSI commands. 
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SFF Small form factor. A type of 2.5 inch drive.

shelf See enclosure.

small form 
factor

See SFF. 

SMI-S Storage Management Initiative - Specification. The SNIA standard that enables interoperable 
management of storage networks and storage devices. 
The interpretation of CIM for storage. It provides a consistent definition and structure of data, 
using object-oriented techniques. 

SNIA Storage Networking Industry Association. An association regarding storage networking 
technology and applications.

SSD Solid state drive

SSH Secure Shell. A network protocol for secure data communication.

Storage 
Controller

See SC. 

Storage 
Management 
Initiative - 
Specification

See SMI-S. 

Storage 
Networking 
Industry 
Association

See SNIA. 

storage system A RAID chassis with at least one connected expansion chassis. Product documentation and 
interfaces use the terms storage system and system interchangeably. 

ULP Unified LUN Presentation. A RAID controller feature that enables a host to access mapped 
volumes through either controller’s host ports. ULP incorporates ALUA extensions. 

Unified LUN 
Presentation

See ULP. 

Uninterruptible 
Power Source

See UPS. 

UPS Uninterruptible Power Source.

vdisk A virtual drive comprised of the capacity of one or more physical drives. The number of drives 
that a vdisk can contain is determined by its RAID level.

virtual disk See vdisk.
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volume A portion of the capacity of a vdisk that can be presented as a storage device to a host. 

web-based 
interface/web-
browser 
interface

See WBI.

WBI Web-based interface/web-browser interface. The primary interface for managing the system. 
A user can enable the use of HTTP, HTTPS for increased security, or both.
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